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April 1, 2026

Important:

The product lifecycle strategy for Current Releases (CR) and Long Term Service Releases (LTSR)
is described in Lifecycle Milestones.

Session Recording records, catalogs, and archives sessions for retrieval and playback.

Session Recording provides flexible policies to trigger recordings of application and desktop sessions
automatically. Session Recording also supports dynamic session recording. Session Recording en‑
ables IT personnel to monitor and examine user activity, and so supports internal controls for regula‑
tory compliance and security monitoring. Similarly, Session Recording also aids in technical support
by speeding problem identification and time‑to‑resolution.

Benefits

Enhanced security through logging and monitoring. Session Recording allows organizations to
record on‑screen user activity for applications that deal with sensitive information, monitoring and
preventing the leakage of sensitive information from virtual sessions. Prevention of sensitive infor‑
mation leakage is especially critical in regulated industries such as healthcare and finance.

Powerful activity monitoring. Session Recording captures and archives screen updates, including
mouse activity and visible output of keystrokes to provide a record of activity for specific users, appli‑
cations, and servers.

Session Recording isn’t designed for the evidence collection for legal proceedings. However, orga‑
nizations can use Session Recording together with other techniques for evidence collection, such as
conventional video records combined with traditional text‑based eDiscovery tools.

Faster problem resolution. When users call with a problem that is difficult to reproduce, help desk
support staff can enable recording of user sessions. If the issue recurs, Session Recording provides a
time‑stamped visual record of the error, which can then be used for faster troubleshooting.

What’s new

April 2, 2026
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What’s New in 2603

Important note about upgrading to version 2603:

To prevent session recording failures due to incomplete upgrades of Session Recording agents,
follow these steps when upgrading to 2603:

1. Upgrade each Session Recording server to version 2603.

2. Enable remote access using .NET Remoting with the following command:

<Session Recording server installation path>\Bin\SsRecUtils.
exe -EnableBrokerRemoting

3. Upgrade each Session Recording agent to version 2603.

4. After all Session Recording agents are upgraded, disable remote access using .NET Remot‑
ing with the following command:

<Session Recording server installation path>\Bin\SsRecUtils.
exe -DisableBrokerRemoting

Note on Upgrade Impact for the ICLFile Table

As part of the upgrade process, several indexes will be created on the ICLFile table. Depending
on the volume of data, this operation may take up to 15 minutes to complete and will require
approximately 60% additional storage relative to the current size of the table.

This change does not affect fresh installations.

AI‑powered insights for session recording

This new feature uses AI to analyze session recordings and provide actionable insights without man‑
ually reviewing hours of video.

Key capabilities:

• Insights dashboard for session activities

• Detailed reports for security and productivity analysis

• Customizable prompt templates for tailoring analysis to your business needs

• Analyze roll‑overed session files or daily report

For configuration details, see AI‑powered insights for session recording.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 6

https://docs.citrix.com/en-us/session-recording/current-release/ai-powered-insights-for-session-recording.html


Session Recording 2603

Playback scaling support in the web player

The Session Recording web player now supports playback scaling. This feature ensures that you can
clearly view all session recordings directly in the web player, regardless of resolution differences be‑
tween the recording source and your playback device.

Key capabilities:

• Fit to Window: Scales the recorded session to fit your current browser window. This provides a
complete overview of the session, allowing reviewers to quickly understand the overall opera‑
tional context. High‑quality resolution is provided by default.

• Original Size: Displays the recording at its native resolution. This mode is intended for detailed
forensic analysis that requires the highest level of clarity and pixel‑perfect detail.

For more information, see Open and play recordings.

Session recording now available in Citrix Virtual Desktop Assistant

Citrix Virtual Desktop Assistant now supports built‑in manual Session Recording. Users canmanually
start and stop recording their active virtual desktop sessions from the assistant, with recordings saved
as MP4 video clips locally or saved on the Session Recording server for troubleshooting and review.

For more information about manual session recording:

• In Basic Deployment Mode: to start or stop recording using Citrix Virtual Desktop Assistant, see
Citrix Virtual Desktop Assistant application.

• In Standard Deployment Mode: see End‑user triggered session recording.

What’s new in earlier releases

For new features included in the releases that shipped after the s1912 Long Term Service Releases
(LTSR) through the 2511 Releases, see What’s new history.

Fixed issues

April 2, 2026

Compared with: Session Recording 2511

Session Recording 2603 adds the following fixes:
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• Youmayexperience screendistortionduringSessionRecordingplayback inCVAD2511andCWA
2511 [SRT‑16409]

• Trigger response actions may not work if the event match has regex errors in event response
policies. [SRT‑16088]

• Session Recording Server can’t load all the recording storages automatically without restarting
the storage manager service after storage recovery. [SRT‑16177]

Known issues

April 3, 2026

The following issues have been identified in this release:

• Upgrading the Session Recording server fails when “Require SSL”is enabled in IIS for the Ses‑
sionRecordingBroker application and only TLS 1.2 is enabled for the server‑side protocol on
the SR server.

To work around this issue, complete the following steps:

1. Temporarily Disable SSL: On the Session Recording server, open IIS Manager. For the
SessionRecordingBroker application, go to SSL Settings and uncheck “Require SSL”.

2. Run Upgrade: Execute the upgrade installer for the Session Recording server.
3. Re‑enable SSL: After the upgrade completes, go back to the SSL Settings in IIS and re‑

check “Require SSL” for the SessionRecordingBroker application.

• A 400 Bad Request error might occur when a user attempts to replay recorded sessions using
the Session Recording player or web player. The issue can occur when the user is a member of
toomany Active Directory user groups. Towork around this issue, complete the following steps:

1. Go to the IIS server machine where the Session Recording server is installed and add the
MaxFieldLengthand theMaxRequestBytesDWORDvaluesunderHKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\HTTP\Parameters.

2. Set the DWORD values to 65534 in decimal.
3. Restart the IIS server machine.

[SRT‑13739]

• Attempts to record Microphone audio fail when HDX™ audio is transmitted in Real‑time Trans‑
port Protocol (RTP) mode on a Windows 10 or Windows 11 VDA. [CVADHELP‑26534]

• If you are using Citrix Web App Firewall (WAF) signatures tomitigate in part the CVE‑2021‑44228
vulnerability, Session Recording might not work as expected. To resolve the issue, exclude the
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IP addresses of your Session Recording servers from themitigate_cve_2021_44228 policy on
the NetScaler side. [CVADHELP‑24365]

• Attempts to close unresponsive or dormant live recordings automatically or manually by using
the ICLDBDORMANTcommandmight fail. The issueoccurswhenyouupdateSessionRecording
to 2308 instead of doing a fresh installation. To resolve the issue, run the following script in
PowerShell on the Session Recording server machine and ensure that you have administrative
access to the Session Recording database:

1 Add-Type -AssemblyName System.data
2 $registryKey = [Microsoft.Win32.Registry]::LocalMachine.

OpenSubKey("SOFTWARE\\Citrix\\SmartAuditor\\Server")
3 $dbName = $registryKey.GetValue("DatabaseName")
4 $dbInstance = $registryKey.GetValue("SmAudDatabaseInstance")
5 write-host "Connecting to $dbInstance\$dbName"
6 # Connect db
7 $conn = New-Object System.Data.SqlClient.SqlConnection
8 $conn.ConnectionString = "workstation id=.;packet size=4096;

integrated security=SSPI;data source=$dbInstance;persist
security info=True;initial catalog=$dbName"

9 $conn.Open()
10 $cmd = $conn.CreateCommand()
11 $cmd.CommandText = "use [$dbName];if not exists(select * from [

dbo].[EndReason] where ID=5) begin insert [dbo].[EndReason]
values (5, 'Dormant') end"

12 $cmd.ExecuteNonQuery()

[SRT‑11119]

• SessionRecording doesn’t capture file transfers between anative disk on the session host (VDA)
and a disk that’s mapped to the session from the client. [SRT‑10514]

• When you upgrade Session Recording to the latest version, your image resolution scaling set‑
tings for lossy screen recording are lost and the default value 1.0 is restored. [SRT‑10130]

• A domain user with local administrator privileges on the Session Recording policy console can
add local and domain users to which the action of a policy rule applies. However, a local user
with local administrator privileges can add only local users but not domain users. [SRT‑5769]

• The web player might not work properly if you upgrade it from Version 2009 or earlier. To work
around the issue, clear your browser cache. [SRT‑5624]

• Rules of custom policies might be lost after you update Session Recording from the version in‑
cluded in XenApp and XenDesktop 7.6 LTSR to the latest version. As a workaround, update the
software to the version included in the latest CU of XenApp and XenDesktop 7.15 LTSR and then
update it to the latest release. [SRT‑4546]

• WhenMachine Creation Services™ (MCS) or Citrix Provisioning (PVS) createsmultiple VDAswith
MicrosoftMessage Queuing (MSMQ) installed, those VDAs can have the same QMId. This condi‑
tion might cause various issues, for example:
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• Sessions might not be recorded even if the recording agreement is accepted.
• The SessionRecording servermight not be able to receive session‑logoff signals and there‑
fore, sessions might always be in a live state.

For information about a workaround, see Install, upgrade, and uninstall. [#528678]

• Session Recording Server upgrades may fail if IIS HTTPS bindings include a specific hostname.
[SRT‑16175]

• You may experience screen distortion during playback using Session Recording Web Player if
recordings use HDX super resolution feature. [SRT‑16423]

• Audio recordingmay fail if the VDAandSessionRecording Agent versions aremismatched. [SRT‑
16624]

Third party notices

September 23, 2025

Session Recording Version 2509 (PDF Download)

This release of Session Recording can include third party software licensed under the terms defined
in this document.

System requirements

December 26, 2025

Session Recording includes the Session Recording Administration components, the Session Record‑
ing agent, and the Session Recording player. You can install the Session Recording Administration
components (Session Recording database, Session Recording server, and Session Recording policy
console) on a single server or on different servers. The following section details the requirements for
each of the Session Recording components.

For information about using this Current Release (CR) in a Long Term Service Release (LTSR) environ‑
ment and other FAQs, see the Knowledge Center article.

Session Recording database

Supported operating systems:
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• Windows Server 2025
• Windows Server 2022
• Windows Server 2019

Supported Microsoft SQL Server versions:

• Microsoft SQL Server 2022 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2019 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2017 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2016 SP3 Enterprise, Express, and Standard editions

Supported Azure SQL database services:

• Azure SQL Managed Instance
• SQL Server on Azure Virtual Machines (VMs)
(Use supported versions of Microsoft SQL Server that are listed earlier.)

• Azure SQL Database

Supported AWS RDS database services:

• SQL Server

Supported database collations:

• Collations ending with _CI_AS

Requirement: .NET Framework 4.7.2

Note:

Ledger databases are not supported. Password cannot contain quotemarks (“) andminimumof
8 characters.

Session Recording server

Supported operating systems:

• Windows Server 2025
• Windows Server 2022
• Windows Server 2019

Other requirements:

• Internet Information Services (IIS) 10, 8.5, 8.0, or 7.5
• .NET Framework Version 4.7.2
• If the Session Recording server uses HTTPS as its communications protocol, add a valid certifi‑
cate. Session Recording uses HTTPS by default, which Citrix® recommends.
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• MicrosoftMessageQueuing (MSMQ),withActiveDirectory integrationdisabledandMSMQHTTP
support enabled.

• For Administrator Logging: Latest version of Chrome, Firefox, or Internet Explorer 11.

Session Recording policy console

Supported operating systems:

• Windows Server 2025
• Windows Server 2022
• Windows Server 2019

Requirement: .NET Framework 4.7.2

Session Recording agent

Install the Session Recording agent on everyWindows Virtual Delivery Agent (VDA) onwhich youwant
to record sessions.

Supported operating systems:

• Windows Server 2025
• Windows Server 2022
• Windows Server 2019
• Windows 11
• Windows 10, minimum version 1607
• Windows 10 Enterprise for Virtual Desktops

Requirements:

• Citrix Virtual Apps and Desktops™ 7 2503 with Premium license
• Citrix Virtual Apps™ and Desktops 7 2402 LTSR CU2 with Premium license
• Citrix Virtual Apps and Desktops 7 2203 LTSR CU6 with Premium license
• .NET Framework 4.7.2
• MicrosoftMessageQueuing (MSMQ),withActiveDirectory integrationdisabledandMSMQHTTP
support enabled or Session Recording message queue.

Note:

Session Recording currently supports Citrix DaaS™ (formerly Citrix Virtual Apps and Desktops
service) Advanced, Advanced Plus, Premium, and Premium Plus editions.
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Session Recording player

Supported operating systems:

• Windows Server 2025
• Windows Server 2022
• Windows Server 2019
• Windows 11
• 64‑bit Windows 10, minimum version 1607

Requirement: .NET Framework 4.7.2

Note:

On 32‑bit Windows 10, you can install the player only by using the SessionRecordingPlayer.msi
file. You can find the msi file on the Citrix Virtual Apps and Desktops ISO under \x86\Session
Recording.

For optimal results, install the Session Recording player on a workstation with:

• Screen resolution of 1024 x 768
• Color depth of at least 32‑bit
• 2GBRAMminimum;moreRAMandCPU/GPUresources can improveperformancewhenplaying
graphics‑intensive recordings, especially when recordings contain many animations

The seek response time depends on the size of the recording and yourmachine’s hardware specifica‑
tions.

Get started

December 26, 2025

Session Recording consists of five components:

Session Recording components

Session Recording consists of the following components:

• Session Recording Administration components:

• Session Recording policy console. A console used to configure policies such as session
recording policies that specify which sessions to record. For more information, see Poli‑
cies.
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• Session Recording server. A server that hosts:

• The Broker. An IIS 6.0+ hosted Web application that serves the following purposes:
• Handling search queries and file download requests from the Session Recording
player and web player.

• Handling policy administration requests from the Session Recording policy con‑
sole.

• Evaluating recording policies for each Citrix Virtual Apps and Desktops™ or Citrix
DaaS (formerly Citrix Virtual Apps and Desktops service) session.

• The Storage Manager. A Windows service that manages the recorded session files re‑
ceived from each Session Recording‑enabled VDA.

• Administrator logging. An optional subcomponent installed with the Session
Recording server to log the administration activities. All the logging data is stored in
a separate SQL Server database named CitrixSessionRecordingLogging by default.
You can customize the database name.

• Session Recording database. A component that manages the SQL Server database for
storing recorded session data. When this component is installed, it creates a database
named CitrixSessionRecording by default. You can customize the database name.

• Session Recording agent. A component installed on each VDA for multi‑session OS or single‑
session OS to enable recording. It is responsible for recording session data.

• Session Recording player / web player. A user interface that users access from a workstation
to play recorded session files.

To install Session Recording or upgrade an existing installation, go to each machine where you are
about to or have already installed the Session Recording components and then run the Citrix Virtual
Apps™ and Desktops ISO.

Tip:

Go to the Citrix Virtual Apps and Desktops download page to download the appropriate version
of Citrix Virtual Apps and Desktops.

For more information about installing Session Recording, see Install, upgrade, and uninstall. You can
also refer to the Citrix Tech Zone article POC Guide: Citrix Session Recording for information on how
to quickly set up and configure Citrix Session Recording and Citrix Session Recording service.

Example deployment

The following diagram shows an example deployment:
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• All the Session Recording components reside behind a security firewall.
• The Session Recording agent is installed on a VDA for multi‑session OS or single‑session OS.
• A second server hosts the Session Recording policy console, a third server acts as the Session
Recording server, and a fourth server hosts the database.

• The Session Recording player is installed on a workstation. Installing the Session Recording
server lets you install the Session Recording web player automatically.

• A client device outside the firewall communicates with the VDA where the Session Recording
agent is installed.

• Inside the firewall, the Session Recording agent, policy console, player, and database all com‑
municate with the Session Recording server.
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Plan your deployment

September 7, 2025

Limitations and caveats

SessionRecording doesn’t support DesktopCompositionRedirection (DCR) displaymode. By default,
Session Recording disables DCR in a session to be recorded. You can configure this behavior in Ses‑
sion Recording Agent properties.

When you browse URLs configured in the browser content redirection policy in Internet Explorer,
graphics activities are not recorded.

Session Recording does not support the Framehawk display mode. Sessions in Framehawk display
mode cannot be recorded and played back correctly. Sessions recorded in Framehawk display mode
might not contain the sessions’activities.

Session Recording can’t record the Lync webcam video when using the HDX™ RealTime Optimization
Pack.

Depending upon your environment, you can deploy the Session Recording components in different
scenarios.

A Session Recording deployment is not limited to a single site. Except the Session Recording agent,
all components are independent of the server site. For example, you can configure multiple sites to
use a single Session Recording server.

A single Session Recording server might experience a high performance demand. For example, you
might have a large site with many agents and plan to record many sessions or many graphically in‑
tense applications such as AutoCAD. To alleviate performance issues, you can install multiple Session
Recording servers and configure load balancing.

Ports
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Source Destination Type Port Details

Virtual Delivery
Agent

Session
Recording server

TCP 80, 443 Communication
between the
Session
Recording agent
installed on
Virtual Delivery
Agent and the
Session
Recording server.
Default
installation uses
HTTPS/SSL to
secure
communications.
If SSL is not
configured, use
HTTP.
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Source Destination Type Port Details

Virtual Delivery
Agent

Session
Recording server

TCP 1801 By default,
Session
Recording uses
TCP as the
communication
protocol and thus
MSMQ uses port
1801 for sending
messages over
TCP. Alternatively,
MSMQ can use
port 80 or 443 for
sending
messages over
HTTP or HTTPS
based on your
protocol setting
on the
Connections tab
of Session
Recording Agent
Properties.

Session
Recording policy
console

Session
Recording server

TCP 80, 443 Communication
between the
server where the
Session
Recording policy
console is
installed and the
Session
Recording server.
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Source Destination Type Port Details

Session
Recording player

Session
Recording server

TCP 80, 443 Communication
between the
workstation
where the
Session
Recording player
is installed and
the Session
Recording server.

Session
Recording server

Microsoft SQL
Server

TCP 1433 Connection to
the Session
Recording
database.

Suggested server site deployment

Use this type of deployment for recording sessions for one ormore sites. The SessionRecording agent
is installed on each VDA in a site. The site resides in a data center behind a security firewall. The Ses‑
sion Recording Administration components (Session Recording database, Session Recording server,
andSessionRecordingpolicy console) are installed onother servers and the SessionRecordingplayer
is installed on aworkstation, all behind the firewall. It is recommended to deploy the Session Record‑
ing server in a secure, intranet data center.
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Important deployment notes

• To enable Session Recording components to communicate with each other, install them in the
same domain or across trusted domains that have a transitive trust relationship. The system
cannot be installed on a workgroup or across domains that have an external trust relationship.

• Considering its intensegraphical natureandmemoryusagewhenplayingback large recordings,
we do not recommend installing the Session Recording Player as a published application.

• The Session Recording installation is configured for TLS/HTTPS communication. Install a certifi‑
cate on the Session Recording server. Make sure the root certificate authority (CA) is trusted on
the Session Recording components.

• For the Session Recording server on a standalone server running SQL Server, enable the TCP/IP
protocol and run the SQL Server Browser service. These settings are disabled by default, but
they must be enabled for the Session Recording server to communicate with the database. For
more information, see theMicrosoftarticles Enable TCP/IPNetworkProtocol for SQLServer and
SQL Server Browser service.

• Consider the effects of session sharingwhenplanning your SessionRecordingdeployment. Ses‑
sion sharing for published applications can conflict with Session Recording policy rules for pub‑
lished applications. Session Recording matches the active policy with the first published appli‑
cation that a user opens. After the user opens the first application, any subsequent applications
openedduring the same session continue to follow the policy that is in force for the first applica‑
tion. For example, if a policy states to record only Microsoft Outlook, the recording commences
when the user opens Outlook. If the user opens a published Microsoft Word second while Out‑
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look is running, Word also is recorded. Conversely, if the active policy doesn’t specify to record
Word and the user launches Word before Outlook, Outlook is not recorded.

• Though you can install the Session Recording server on a Delivery Controller™, we don’t recom‑
mend it because of performance issues.

• You can install the Session Recording Policy Console on a Delivery Controller.
• You can install both the Session Recording server and the Session Recording Policy Console on
the same system.

• Ensure that the NetBIOS name of the Session Recording server does not exceed the limit of 15
characters. Microsoft has a 15‑character limit on the host name length.

• PowerShell 5.1 or later is required for custom event logging. Upgrade PowerShell if you install
the Session Recording agent onWindows Server 2012 R2 that has PowerShell 4.0 installed. Fail‑
ure to comply can cause failed API calls.

• For step‑by‑step instructions on deploying and configuring the Citrix Session Recording and Cit‑
rix SessionRecording service, see this Citrix TechZonearticle: POCGuide: Citrix SessionRecord‑
ing.

Security recommendations

April 1, 2026

Session Recording is deployed within a secure network and accessed by administrators, and as such,
is secure. Out‑of‑the‑box deployment is simple and security features such as digital signing and en‑
cryption can be configured optionally.

Communication between Session Recording components is achieved through Internet Information
Services (IIS) and Microsoft Message Queuing (MSMQ). IIS provides the web services communication
link between Session Recording components. MSMQ provides a reliable data transport mechanism
to send recorded session data from the Session Recording agent to the Session Recording server.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix® cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Consider these security recommendations when planning your deployment:

• Configure Microsoft Internet Information Services (IIS).
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YoucanconfigureSessionRecordingwitha restricted IIS configuration. OneachSessionRecord‑
ing server, open the IIS Manager and set the following recycling limits for each IIS application
pool:

• Virtual Memory Limit: Set the value to 4,294,967,295.
• Private Memory Limit: Set the value to the physical memory of the Session Recording
server. For example, if the physical memory is 4 GB, set the value to 4,194,304.

• RequestLimit: We recommendyou leave this settingunspecified. Or youcanset thevalue
to 4,000,000,000.

Tip:

To access the preceding settings, highlight each application pool, select Advanced Set‑
tings in the Actions pane, and then scroll down to theRecycling section in the Advanced
Settings dialog box.

• Ensure that you properly isolate the different administrator roles in the corporate network, in
the Session Recording system, or on individual machines. By not doing so, security threats that
can impact the system functionality or abuse the systemmight occur. We recommend that you
assign different administrator roles to different persons or accounts. Do not allow general ses‑
sion users to have administrator privileges to the VDA system.

• Do not grant VDA local administrator role to any users of published apps or desktops. If
the local administrator role is a requirement, protect the Session Recording agent compo‑
nents by using Windowsmechanisms or third‑party solutions.

• Separately assign the Session Recording database administrator and Session Recording
policy administrator.

• Do not assign VDA administrator privileges to general session users, especially when using
Remote PC Access.

• The Session Recording server’s local administration account must be strictly protected.
• Control access tomachineswhere the Session Recording player is installed. If a user is not
authorized for the Player role, do not grant that user the local administrator role for any
player machine. Disable anonymous access.

• We recommend using a physical machine as a storage server for Session Recording.

• Session Recording records session graphics activities without regard to the sensitivity of the
data. Under certain circumstances, sensitive data (including but not limited to user credentials,
privacy information, and third‑party screens) might be recorded unintentionally. Take the fol‑
lowing measures to prevent risks:

• Disable core memory dump for VDAs unless for specific troubleshooting cases.
To disable core memory dump:
1. Right‑clickMy Computer, and then select Properties.
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2. Click the Advanced tab, and then under Startup and Recovery, click Settings.
3. UnderWrite Debugging Information, select (none).

See the Microsoft article at https://support.microsoft.com/en‑us/kb/307973.
• Session owners notify attendees that online meetings and remote assistance software
might be recorded if a desktop session is being recorded.

• Ensure that logon credentials or security information does not appear in all local andWeb
applications published or used inside the corporation. Otherwise, they are recorded by
Session Recording.

• Close any application that might expose sensitive information before switching to a re‑
mote ICA® session.

• We recommend only automatic authentication methods (for example, single sign‑on,
smartcard) for accessing published desktops or Software as a Service (SaaS) applications.

• Session Recording relies on certain hardware and hardware infrastructure (for example, corpo‑
rate network devices, operation system) to function properly and to meet security needs. Take
measures at the infrastructure levels to prevent damage or abuse to those infrastructures and
make the Session Recording function secure and reliable.

• Properly protect and keep network infrastructure supporting Session Recording available.
• We recommend using a third‑party security solution or Windows mechanism to protect
Session Recording components. Session Recording components include:

• On the Session Recording server
• Processes: SsRecStoragemanager.exe and SsRecAnalyticsService.exe
• Services: CitrixSsRecStorageManager and CitrixSsRecAnalyticsService
• All files in the Session Recording server installation folder
• Registry valueswithinHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server

• On the Session Recording agent
• Process: SsRecAgent.exe
• Service: CitrixSmAudAgent
• All files in the Session Recording agent installation folder
• Registry values under HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\
SmartAuditor\Agent

• As a security best practice, Citrix recommends using HTTPS on IIS.

• Set the access control list (ACL) for Message Queuing (MSMQ) on the Session Recording server
to restrict VDA or VDI machines that can send MSMQ data to the Session Recording server and
prevent unauthorized machines from sending data to the Session Recording server.

1. Install server featureDirectoryService IntegrationoneachSessionRecording server and
VDA or VDImachinewhere Session Recording is enabled. Then restart theMessageQueu‑
ing service.
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2. From the Windows Start menu on each Session Recording server, open Administrative
Tools > Computer Management.

3. Open Services and Applications >Message Queuing > Private Queues.

4. Click the private queue citrixsmauddata to open the Properties page and select the Se‑
curity tab.

5. Add the computers or security groups of the VDAs that send MSMQ data to this server and
grant them the SendMessage permission.
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• Properly protect the event log for the Session Record server and Session Recording agents. We
recommend using aWindows or third‑party remote logging solution to protect the event log or
redirect the event log to the remote server.

• Ensure that servers running the Session Recording components are physically secure. If possi‑
ble, lock these computers in a secure room to which only authorized personnel can gain direct
access.

• Isolate servers running the Session Recording components on a separate subnet or domain.

• Protect the recorded session data from users accessing other servers by installing a firewall be‑
tween the Session Recording server and other servers.

• Keep the Session Recording Administration Server and SQL database up‑to‑date with the latest
security updates fromMicrosoft.

• Restrict non‑administrators from logging on to the administration machine.

• Strictly limit who is authorized to make recording policy changes and view recorded sessions.

• Install digital certificates, use the Session Recording file signing feature, and set up TLS commu‑
nications in IIS.

• SetupMSMQtouseHTTPSas its transport. Theway is to set theMSMQprotocol listed inSession
Recording Agent Properties to HTTPS. For more information, see Troubleshoot MSMQ.
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• Use TLS 1.1 or TLS 1.2 (recommended) and disable SSLv2, SSLv3, TLS 1.0 on the Session Record‑
ing server and Session Recording Database.

• Disable RC4 cipher suites for TLS on the Session Recording server and Session Recording data‑
base:

1. Using the Microsoft Group Policy Editor, navigate to Computer Configuration > Admin‑
istrative Templates > Network > SSL Configuration Settings.

2. Set the SSL Cipher Suite Order policy to Enabled. By default, this policy is set to Not
Configured.

3. Remove any RC4 cipher suites.

• Use playback protection. Playback protection is a Session Recording feature that encrypts
recorded files before they are downloaded to the Session Recording player. By default, this
option is enabled and is in Session Recording Server Properties.

• Follow NSIT guidance for cryptographic key lengths and cryptographic algorithms.

• Configure TLS 1.2 support for Session Recording.

We recommend using TLS 1.2 as the communication protocol to ensure the end‑to‑end security
of the Session Recording components.

To configure TLS 1.2 support of Session Recording:

1. Log on to themachine hosting the Session Recording server. Install the proper SQL Server
client componentanddriver, andset strongcryptography for.NET Framework (version
4 or later).

a) Install the Microsoft ODBC Driver 11 (or a later version) for SQL Server.
b) Apply the latest hotfix rollup of .NET Framework.
c) Install ADO.NET - SqlClient based on your version of .NET Framework. For

more information, see https://support.microsoft.com/en‑us/kb/3135244.
d) AddaDWORDvalueSchUseStrongCrypto=1underHKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NetFramework\v4.0.30319

andHKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\.NetFramework\v4.0.30319.
e) Restart the machine.

2. Logon to themachinehosting theSessionRecordingpolicy console. Apply the latesthotfix
rollup of .NET Framework, and set strong cryptography for .NET Framework (version 4 or
later). The method for setting strong cryptography is the same as substeps 1–4 and 1–5.
You can omit these steps if you choose to install the Session Recording policy console on
the same computer as the Session Recording server.

To configure the TLS 1.2 support for SQL Server with versions earlier than 2016, see https://support.
microsoft.com/en‑us/kb/3135244. To use TLS 1.2, configure HTTPS as the communication protocol
for the Session Recording components.
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Enable enhancedmessage security for Session Recording

This feature introduces a message signature mechanism to validate the authenticity and integrity of
incoming messages before they enter the Message Queuing (MSMQ) system. It is particularly critical
for addressing security vulnerabilities in Azure Active Directory Joined (AADJ) Session Recording de‑
ployments.

To enable this feature, configure the registry keys on both the Session Recording server and the
agent.

1. On the Session Recording server:

Add the EnableMessageSignature DWORD value and set it to 1 under the following reg‑
istry key:

HKEY_LOCAL_MACHINE\Software\Citrix\SmartAuditor\Server

2. On the Session Recording agent:

Add the EnableMessageSignature DWORD value and set it to 1 under the following reg‑
istry key:

HKEY_LOCAL_MACHINE\Software\Citrix\SmartAuditor\Agent

3. Restart services:

For the changes to take effect, restart the Citrix Session Recording Storage Manager service on
the server and the Citrix Session Recording Agent service on the agent.

Note:

To disable this feature, set the EnableMessageSignature DWORD value to 0 or delete the
registry key on both the server and the agent, and then restart the respective services.

Scalability considerations

September 7, 2025

SessionRecording is a highly scalable system that handles thousandsor tens of thousandsof sessions.
Installingand runningSessionRecording requires fewextra resourcesbeyondwhat is necessary to run
Citrix Virtual Apps and Desktops™ or Citrix DaaS (formerly Citrix Virtual Apps and Desktops service).
However, we still recommendyou consider the performanceof your system if youplan to recordmany
sessions. Or, the sessionsyouplan to recordmight result in large session files (for example, graphically
intense applications).
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This article explains how Session Recording achieves high scalability and how you can get the most
out of your recording system at a lowest cost.

Why Session Recording scales well

There are two major reasons that Session Recording scales well compared with competitive prod‑
ucts:

• Small file size

A recorded session filemadewith SessionRecording is highly compact. It ismanyorders ofmag‑
nitude smaller than an equivalent video recordingmadewith solutions that screen‑scrape. The
network bandwidth, disk space, and disk IOPS required to transport/store a recorded session
file is typically at least 10 times less than an equivalent video file.

The small size of recorded session files means faster and smoother rendering of video frames.
Recordings are also lossless and have no pixelation that is common in most compact video for‑
mats. Text in recordings is easy to read during playback as it is in the original sessions. To
maintain small file sizes, Session Recording does not record key frames within the files. Ses‑
sion Recording can drop H.264 packages while recording sessions that have videos running
and thus reduce the recording file sizes. This feature is incompatible with the Compressed
recording feature. To use this feature, set HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\
SmartAuditor\Agent\DropH264Enabled to 1 on the Session Recording agent and set
the value of Use video codec for compression to For actively changing regions.
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• Low processing required to generate files

A recorded session file contains the ICA® protocol data for a session that is extracted virtually in
its native format. The file captures the ICA protocol data stream that is used to communicate
with Citrix Workspace™ app. There is no need to run expensive transcoding or encoding soft‑
ware components to change the format of data in real time. The low amount of processing is
also important for VDA scalability. It ensures the end‑user experience ismaintainedwhenmany
sessions are recorded from the same VDA.

Moreover, only those ICA virtual channels that can be played back are recorded, which results
in a further optimization. For example, the printer and client drive mapping channels aren’t
recorded. The channels can generate high volumes of data without any benefit in video play‑
back.

Estimate data input and processing rates

The Session Recording server is the central collection point for recorded session files. Each machine
that is running a multi‑session OS VDA with Session Recording enabled sends recorded session data
to the Session Recording server. Session Recording can handle high volumes of data and can tolerate
bursts and faults. But there are physical limits on howmuch data any one server can handle.

Consider howmuchdata you send toeachSessionRecording server. Estimatehowquickly the servers
can process and store the data. The rate atwhich your system can store incoming datamust be higher
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than the data input rate.

To estimate your data input rate, do the following calculation:

1. Multiply the number of recorded sessions by the average session size.
2. Divide the product by the time for which you are recording sessions.

For example, you might record 5,000 Microsoft Outlook sessions of 20 MB each over an 8‑hour work
day. In this case, the data input rate is approximately 28 Mbps (5,000 sessions multiplied by 20 MB,
divided by 8 hours, divided by 3,600 seconds per hour, and multiplied by 8 for conversion to Mbps).
A typical Session Recording server connected to a 100 Mbps LAN with sufficient disk space to store
the recorded data can process data at around 5.0 Mbps. This rate is the processing rate based on the
physical limits imposed by disk and network IOPS. In the example, the processing rate (5.0 Mbps) is
lower than the input rate (28 Mbps), so recording the 5,000 Outlook sessions is impossible.

The amount of data per session varies greatly depending on what is being recorded. Other factors
such as screen resolution, color depth, and graphics mode also have impacts. A session where CAD
is running likely generates a much larger recording than a session where the user sends and receives
emails in Outlook. Therefore, recording the same number of CAD sessions can generate a high input
rate and require the use of more Session Recording servers.

Bursts and faults

The previous example assumes a simple uniform throughput of data but doesn’t explain how the
systemdealswith short periods of higher activity, knownas bursts. A burstmight occurwhen all users
log on at the same time in the morning, known as the 9 o’clock rush. It can also occur when they
receive the same email in their Outlook inbox at once. The 5.0 Mbps processing rate of the Session
Recording server is highly inadequate at dealing with this sudden demand.

The Session Recording agent running on each VDA uses Microsoft Message Queuing (MSMQ) to send
recorded data to the Storage Manager running on the central Session Recording server. The data is
sent in a store‑and‑forward manner similar to how an email is delivered between the sender, mail
server, and receiver. If the Session Recording server or network can’t handle a high rate of data in
bursts, the recorded data is temporarily stored. The datamessagemight be temporarily stored in the
outgoing queue on the VDA if the network is congested. The other case is that the data has traversed
the network but the Storage Manager is busy processing other messages. In this case, the data mes‑
sage is stored on the Session Recording server’s receiving queue.

MSMQ also serves as a fault tolerance mechanism. If the Session Recording server goes down or the
link is broken, recorded data stays in the outgoing queue on each VDA. When the fault is rectified, all
queued data is sent together. MSMQ also allows you to take a server offline for upgrade or mainte‑
nance without interrupting session recording and losing data.
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The main limitation of MSMQ is that disk space for the temporary storage of data messages is finite.
This limitation limits how long a burst, fault, or maintenance event can last before data is eventually
lost. The overall system can continue after data loss, but in this situation, individual recordings have
chunks of data missing. A file with missing data is still playable but only up to the point where data
was first lost. Note the following:

• Adding more disk space to each server, especially the Session Recording server, and making it
available to MSMQ can increase the tolerance to bursts and faults.

• It is important to configure the Message Life setting for each Session Recording agent to an ap‑
propriate level (on the Connections tab in Session Recording agent Properties). The default
value is 7,200 seconds (two hours). It means that each recorded datamessage has two hours to
reach the Storage Manager before the Storage Manager discards it and damages the recording
file. With more disk space available (or fewer sessions to record), you can choose to increase
this value. The maximum value is 365 days.

The other limitation with MSMQ is that when data backlogs, there is extra disk IOPS in the queue to
read and write data messages. Normally, the Storage Manager receives and processes data from the
network directly, without datamessages ever being written to disk. Storing the data involves a single
write operation to disk that appends the recorded session file. Whendata is backlogged, the disk IOPS
is tripled: each message must be written to disk, read from disk, and written to file. As the Storage
Manager is heavily IOPS bound, the processing rate of the Session Recording server drops until the
backlog of messages is cleared. To mitigate the effects of this extra IOPS, adopt the following recom‑
mendations:

• Make sure that the disk on which MSMQ stores messages is different from the recording file
storage folders. Even though IOPS bus traffic is tripled, the drop in the true processing rate is
never as severe.

• Plan outages at off‑peak times only. Depending on budget constraints, follow recognized ap‑
proaches to building high availability servers. The approaches include the use of Uninterrupt‑
ible Power Supply (UPS), dual NICs, redundant switches, and hot swappablememory and disks.

Design for spare capacity

The data rate of recorded session data is unlikely to be uniform, bursts and faults might occur, and
the clearing ofmessage backlogs is expensive in IOPS. For this reason, design each Session Recording
server with plenty of spare capacity. Adding more servers or improving the specification of existing
servers, as described in later sections, always gains you extra capacity. The general rule of thumb is to
run each Session Recording server at a maximum of 50% of its total capacity. In the earlier example,
if the server can process 5.0 Mbps, target the system to run only at 2.5 Mbps.
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Backlogs and live playback

Live playback is when a reviewer opens a session recording for playback while the session is still ac‑
tive. During live playback, the responsible Session Recording agent switches to a streamingmode for
that session. Recording data is sent immediately to the Storage Manager without internal buffering.
Because the recording file is constantly updated, the player can continue to be fedwith the latest data
from the live session. However, data sent from the agent to the StorageManager is throughMSMQ, so
the queuing rules described earlier apply. A problem can occur in this scenario. When MSMQ is back‑
logged, the new recorded data available for live playback is queued like all other datamessages. The
reviewer can still play the file, but viewing the latest live recorded data is delayed. If live playback is
an important feature for reviewers, ensure a lowprobability of backlog. You candesign spare capacity
and fault tolerance into your deployment.

System scalability

Session Recording never reduces session performance and never stops sessions in response to
recorded data backlogs. Maintaining the end‑user experience and single‑server scalability is para‑
mount in the design of the Session Recording system. If the recording system becomes irreversibly
overloaded, recorded session data is discarded. Recording ICA sessions has a low impact on the
performance and scalability of VDAs. The size of the impact depends on the platform, the memory
available, and the graphical nature of the sessions being recorded. With the following configuration,
you can expect a single‑server scalability impact of between 1% and 5%. In other words, if a server
can host 100 users without Session Recording installed, it can host 95–99 users after installation:

• 64‑bit server with 8 GB RAM running a multi‑session OS VDA
• All sessions running Office productivity applications, such as Outlook and Excel
• The use of applications is active and sustained
• All sessions are recorded as configured by the Session Recording policies

With fewer sessions recorded or session activity less sustained and more sporadic, the impact is less.
Often times, the scalability impact is negligible and user density per server remains the same. As
mentioned earlier, the low impact results from the simple processing requirements of the Session
Recording components on each VDA. Recorded data is extracted from the ICA session stack and sent
as‑is to the Session Recording server through MSMQ. There is no expensive encoding of data.

There is a minor overhead of using Session Recording even when no sessions are recorded. If you are
not going to record any sessions fromaparticular server, you can disable recording on that server. Re‑
moving Session Recording is oneway. A less invasive approach is to clear the Enable session record‑
ing for thisVDAmachine checkboxon theSessionRecording tab inSessionRecordingAgentProp‑
erties. If session recording is required in future, reselect this check box.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 32



Session Recording 2603

Measuring throughput

You canmeasure the throughput of recorded session data from the sending VDA to the receiving Ses‑
sion Recording server. A simple and effective approach is to observe the size of recording files and the
rate at which disk space on the Session Recording server is being consumed. The volume of data writ‑
ten to disk closely reflects the volume of network traffic being generated. The Windows Performance
Monitor tool (perfmon.exe) has standard system counters that you can observe in addition to some
counters provided by Session Recording. Counters can be used to measure throughput, and identify
bottlenecks and systemproblems. The following table outlines some of themost useful performance
counters.

Performance Object Counter Name Description

Citrix Session Recording Agent Active Recording
Count

The number of sessions that
are currently being recorded on
a particular VDA.

Citrix Session Recording Agent Bytes read from the
Session Recording
Driver

The number of bytes read from
the kernel components
responsible for acquiring
session data. Useful for
determining howmuch data a
single VDA generates for all
sessions recorded on that
server.

Citrix Session Recording
Storage Manager

Active Recording
Count

Similar to the Citrix Session
Recording agent counter except
for the Session Recording
server. Indicates the total
number of sessions currently
being recorded for all servers.
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Performance Object Counter Name Description

Citrix Session Recording
Storage Manager

Message bytes/sec The throughput of all recorded
sessions. Can be used to
determine the rate at which the
Storage Manager is processing
data. If MSMQ is backlogged
with messages, the Storage
Manager runs at full speed.
This value can be used to
indicate the maximum
processing rate of the Storage
Manager.

LogicalDisk Disk Write Bytes/sec Can be used to measure disk
write‑through performance,
which is important in achieving
high scalability for the Session
Recording server. Performance
of individual drives can also be
observed.

MSMQ Queue Bytes in Queue Can be used to determine the
amount of data backlogged in
the CitrixSmAudData message
queue. If this value increases
over time, the rate of recorded
data received from the network
is greater than the rate at which
the Storage Manager can
process data. This counter is
useful for observing the effect
of data bursts and faults.

MSMQ Queue Message in Queue Similar to the Bytes in Queue
counter but measures the
number of messages.
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Performance Object Counter Name Description

Network Interface Bytes Total/sec Can be used to measure on
both sides of the link to
observe howmuch data is
generated when sessions are
recorded. Whenmeasured on
the Session Recording server,
this counter indicates the rate
at which incoming data is
received. Contrasts with the
Citrix Session Recording
Storage Manager
Message bytes/sec
counter that measures the
processing rate of data. If the
network rate is greater than
this value, messages build in
the message queue.

Processor % Processor Time Worth monitoring even though
CPU is unlikely to be a
bottleneck.

Session Recording server hardware

You can increase the capacity of your deployment by carefully selecting the Session Recording server
hardware. You have two choices: scaling up (by increasing the capacity of each server) or scaling out
(by addingmore servers). Inmaking either of the choices, your aim is to increase scalability at a lowest
cost.

Scaling up

When examining a single Session Recording server, consider the following best practices to ensure op‑
timal performance for availablebudgets. The systemdependson IOPS that canensure ahigh through‑
put of recorded data from the network onto the disk. So it is important to invest in appropriate net‑
work and disk hardware. For a high‑performance Session Recording server, a dual CPU or dual core
CPU is recommended but little is gained from any higher specification. 64‑bit processor architecture
is recommended but an x86 processor type is also suitable. 4 GB of RAM is recommended but again
there is little benefit from adding more.
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Scaling out

Even with the best scaling up practices, there are limits to performance and scalability that can be
reachedwith a single Session Recording server when recordingmany sessions. It might be necessary
to add extra servers to meet the load. You can install more Session Recording servers on different
machines to have the Session Recording servers work as a load balancing pool. In this type of deploy‑
ment, the Session Recording servers share the storage and the database. To distribute the load, point
the Session Recording agents to the load balancer that is responsible for the workload distribution.

Network capacity

A 100 Mbps network link is suitable for connecting a Session Recording server. A Gb Ethernet connec‑
tionmight improveperformance, but doesnot result in 10 times greater performance thana100Mbps
link. In practice, the gain in throughput is less.

Ensure that network switches used by Session Recording are not sharedwith third‑party applications
that might compete for available network bandwidth. Ideally, network switches are dedicated for
use with the Session Recording server. If network congestion proves to be the bottleneck, a network
upgrade is a relatively inexpensive way to increase the scalability of the system.

Storage

Investment in disk and storage hardware is the single most important factor in server scalability. The
faster that data can be written to disk, the higher the performance of the overall system. When select‑
ing a storage solution, take more note of the write performance than the read performance.

Store data on a RAID or a SAN.

Note:

Storing data on a NAS, based on file‑based protocols such as SMB and NFS, might have perfor‑
mance and security implications. Use the latest version of the protocol in place to avoid security
implications and perform scale testing to ensure proper performance.

For a local drive setup, aim for a disk controller with built‑in cache memory. Caching allows the con‑
troller to use elevator sorting during write‑back. It minimizes disk head movement and ensures that
write operations are completedwithoutwaiting for the physical disk operation to complete. It can im‑
prove write performance significantly at a minimal extra cost. Caching does however raise the prob‑
lem of data loss after a power failure. To ensure the integrity of data and the file system, consider a
battery backup facility for the caching disk controller.
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Consider using a suitable RAID storage solution. There are many RAID levels available depending on
performance and redundancy requirements. The following table specifies each of the RAID levels and
how applicable each standard is to Session Recording.

RAID Level Type
MinimumNumber of
Disks Description

RAID 0 Striped set without
parity

2 Provides high
performance but no
redundancy. Loss of
any disk destroys the
array. RAID 0 is a low
cost solution for
storing recorded
session files where the
impact of data loss is
low. Easy to scale up
performance by
adding more disks.

RAID 1 Mirrored set without
parity

2 No performance gain
over one disk, making
it a relatively
expensive solution.
Use this solution only
if a high level of
redundancy is
required.
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RAID Level Type
MinimumNumber of
Disks Description

RAID 3 Striped set with
dedicated parity

3 Provides high write
performance with
redundancy
characteristics similar
to RAID 5. RAID 3 is
recommended for
video production and
live streaming
applications. As
Session Recording is
this type of
application, RAID 3 is
most highly
recommended but it is
not common.

RAID 5 Striped set with
distributed parity

3 Provides high read
performance with
redundancy but at the
cost of slower write
performance. RAID 5 is
the most common for
general purpose
usages. But due to the
slow write
performance, RAID 5 is
not recommended for
Session Recording.
RAID 3 can be
deployed at a similar
cost but with better
write performance.
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RAID Level Type
MinimumNumber of
Disks Description

RAID 10 Mirrored set and
striped set

4 Provides performance
characteristics of RAID
0 with redundancy
benefits of RAID 1. An
expensive solution
that is not
recommended for
Session Recording.

RAID 0 and RAID 3 are the most recommended RAID levels. RAID 1 and RAID 5 are popular standards
but are not recommended for Session Recording. RAID 10 does provide some performance benefits
but is too expensive for the additional gain.

Decide on the type and specification of disk drives. IDE/ATA drives and external USB or Firewire drives
are not suitable for use in Session Recording. Themain choice is between SATA and SCSI. SATA drives
provide reasonably high transfer rates at a reduced cost per MB compared with SCSI drives. However,
SCSI drives providebetter performance andaremore common in server deployments. Server RAID so‑
lutionsmostly support SCSI drives but some SATA RAID products are now available. When evaluating
the specifications of disk drive products, consider the rotational speed of disk and other performance
characteristics.

Because the recording of thousands of sessions per day can consume significant amounts of disk
space, youmust choose betweenoverall capacity andperformance. From the earlier example, record‑
ing 5,000Outlook sessions over an 8‑hourwork day consumes about 100GBof storage space. To store
10days’worthof recordings (that is, 50,000 recorded session files), youneed1,000GB (1TB). This pres‑
sure on disk space can be eased by shortening the retention period before archiving or deleting old
recordings. If 1 TB of disk space is available, a seven‑day retention period is reasonable, ensuring
disk space usage remains around 700 GB, with 300 GB remaining as a buffer for busy days. In Session
Recording, the archiving and deleting of files is supported with the ICLDB utility. It has a minimum
retention period of two days. You can schedule a background task to run once a day at some off‑peak
time. For more information about the ICLDB commands and archiving, see Manage your database
records.

The alternative to using local drive and controllers is to use a SAN storage solution based on block‑
level disk access. To the Session Recording server, the disk array appears as a local drive. SANs are
more expensive to set up, but as the disk array is shared, SANs do have the advantage of simplified
and centralized management. There are two main types of SAN: Fibre Channel and iSCSI. iSCSI is
essentially SCSI over TCP/IP and is gaining popularity over Fibre Channel since the introduction of Gb
Ethernet.
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Database scalability

The volume of data sent to the Session Recording database is small because the database stores only
metadata about the recorded sessions. The files of the recorded sessions themselves are written to
a separate disk. Typically, each recorded session requires only about 1 KB of space in the database,
unless the Session Recording Event API is used to insert searchable events to the session.

The Express Editions of Microsoft SQL Server 2019, Microsoft SQL Server 2017, Microsoft SQL Server
2016,MicrosoftSQLServer 2014,MicrosoftSQLServer 2012, andMicrosoftSQLServer 2008R2 impose
a database size limitation of 10 GB. At 1 KB per recording session, the database can catalog about
4,000,000 sessions. Other editions of Microsoft SQL Server have no database size restrictions and are
limited only by available disk space. As the number of sessions in the database increases, perfor‑
mance of the database and speed of searches diminishes only negligibly.

If you are notmaking customizations through the Session Recording Event API, each recorded session
generates four database transactions: two when recording starts, one when the user logs on to the
session being recorded, and one when recording ends. If you use the Session Recording Event API
to customize sessions, each searchable event recorded generates one transaction. Because even the
most basic database deployment can handle hundreds of transactions per second, the processing
load on the database is unlikely to be stressed. The impact is light enough that the Session Recording
database can run on the same SQL Server as other databases, including the Citrix Virtual Apps and
Desktops data store database.

If your Session Recording deployment requiresmanymillions of recorded sessions to be cataloged in
the database, follow Microsoft guidelines for SQL Server scalability.

Install, upgrade, and uninstall

April 2, 2026

Note:

To configure server high availability through load balancing, see Configure load balancing in an
existing deployment and Deploy and load balance Session Recording in Azure.

To learnmore about how to quickly set up and configure Citrix Session Recording and Citrix Ses‑
sion Recording service, see the Citrix Tech Zone article POC Guide: Citrix Session Recording.

Youcan install theSessionRecording server andagentonanAzureAD joinedmachineandenable
Azure AD support for them. Later when you configure various policies and playback permissions
from the cloud, you can specify Azure AD users and groups who launch sessions from Azure AD
joined machines. The Enable Azure AD support option is not available on the GUI when you
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install the Session Recording server using the Citrix Virtual Apps and Desktops™ installer.

This article contains the following sections:

Installation checklist

Use Citrix® scripts to install the Windows roles and features prerequisites

Install Session Recording using the Citrix Virtual Apps and Desktops installer

Automate installation

Install the Session Recording database on cloud SQL database services

Upgrade Session Recording

Uninstall Session Recording

Integrate with Citrix Analytics for Security

Installation checklist

Before you start the installation, complete this list:

� Step

Select the machines on which you want to install
each Session Recording component. Ensure that
each computer meets the hardware and
software requirements for the components to be
installed on it.
Use your Citrix account credentials to access the
Citrix Virtual Apps™ and Desktops download
page and download the product ISO file. Unzip
the ISO file or burn a DVD of it.
To use the TLS protocol for communication
between the Session Recording components,
install the correct certificates in your
environment.
Install any hotfixes required for the Session
Recording components. The hotfixes are
available from the Citrix Support.
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� Step

Configure the Citrix Director to create and
activate the Session Recording policies. For
more information, see Configure Director to use
the Session Recording Server.

Note:

• We recommend that you divide the published applications into separate Delivery Groups
based on your recording policies. Session sharing for published applications can conflict
with the active policy if the applications are in the sameDelivery Group. Session Recording
matches the active policy with the first published application that a user opens. Starting
with the 7.18 release, you can use the dynamic session recording feature to start or stop
recording sessions at any time during the sessions. This feature can help to mitigate the
conflict issue with the active policy. For more information, see Dynamic session recording.

• If you are planning to use Machine Creation Services™ (MCS) or Provisioning Services, pre‑
pare a uniqueQMId. Failure to comply can cause recording data losses.

• SQL Server requires TCP/IP, running SQL Server Browser service, and enabledWindows Au‑
thentication.

• To use HTTPS, configure server certificates for TLS/HTTPS.
• Ensure that users under Local Users and Groups > Groups > Users have write permission
to the C:\windows\Temp folder.

(Required only for msi installation) Use Citrix scripts to install the Windows roles and
features prerequisites

For Session Recording to work properly, use the following Citrix scripts to install the necessary Win‑
dows roles and features prerequisites before
installing Session Recording:

• InstallPrereqsforSessionRecordingAdministration.ps1

1 <#
2 .Synopsis
3 Installs Prereqs for Session Recording Administration
4 .Description
5 Supports Windows Server 2025, Windows Server 2022, Windows

Server 2019.
6 Install below windows feature on this machine:
7 -Application Development
8 -Security - Windows Authentication
9 -Management Tools - IIS 6 Management Compatibility
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10 IIS 6 Metabase Compatibility
11 IIS 6 WMI Compatibility
12 IIS 6 Scripting Tools
13 IIS 6 Management Console
14 -Microsoft Message Queuing (MSMQ), with Active Directory

integration disabled, and MSMQ HTTP support enabled.
15 #>
16 function AddFeatures($featurename)
17 {
18
19 try
20 {
21
22 $feature=Get-WindowsFeature | ? {
23 $_.DisplayName -eq $featurename -or $_.Name -eq $featurename }
24
25 Add-WindowsFeature $feature
26 }
27
28 catch
29 {
30
31 Write-Host "Addition of Windows feature $featurename

failed"
32 Exit 1
33 }
34
35 Write-Host "Addition of Windows feature $featurename

succeeded"
36 }
37
38
39 $system= gwmi win32_operatingSystem | select name
40
41 if (-not (($system -Like '*Microsoft Windows Server 2025*') -or (

$system -Like '*Microsoft Windows Server 2022*') -or ($system
-Like '*Microsoft Windows Server 2019*')))

42 {
43
44 Write-Host("This is not a supported server platform.

Installation aborted.")
45 Exit
46 }
47
48
49 # Start to install Windows feature
50 Import-Module ServerManager
51
52 AddFeatures('Web-Asp-Net45') #ASP.NET 4.5
53 AddFeatures('Web-Mgmt-Console') #IIS Management Console
54 AddFeatures('Web-Windows-Auth') # Windows Authentication
55 AddFeatures('Web-Metabase') #IIS 6 Metabase Compatibility
56 AddFeatures('Web-WMI') #IIS 6 WMI Compatibility
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57 AddFeatures('Web-Lgcy-Scripting')#IIS 6 Scripting Tools
58 if (($system -Like '*Microsoft Windows Server 2022*') -or (

$system -Like '*Microsoft Windows Server 2019*'))
59 {
60
61 AddFeatures('Web-Lgcy-Mgmt-Console') #IIS 6 Management

Console
62 }
63
64
65 AddFeatures('MSMQ-HTTP-Support') #MSMQ HTTP Support
66 AddFeatures('web-websockets') #IIS Web Sockets
67 AddFeatures('NET-WCF-HTTP-Activation45') #http activate
68 AddFeatures('Web-IP-Security')#IIS-IPSecurity

• InstallPrereqsforSessionRecordingAgent.ps1

1 <#
2 .Synopsis
3 Installs Prereqs for Session Recording Agent
4 .Description
5 Supports Windows Server 2025, Windows Server 2022, Windows

Server 2019, Windows Server 2016, windows 11, and Windows
10.

6 Install below windows feature on this machine:
7 -Microsoft Message Queuing (MSMQ), with Active Directory

integration disabled, and MSMQ HTTP support enabled.
8 #>
9 function AddFeatures($featurename)

10 {
11
12 try
13 {
14
15 $feature=Get-WindowsFeature | ? {
16 $_.DisplayName -eq $featurename -or $_.Name -eq $featurename }
17
18 Add-WindowsFeature $feature
19 }
20
21 catch
22 {
23
24 Write-Host "Addition of Windows feature $featurename

failed"
25 Exit 1
26 }
27
28 Write-Host "Addition of Windows feature $featurename

succeeded"
29 }
30
31
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32 # Start to install Windows feature
33
34 $system= gwmi win32_operatingSystem | select name
35
36 if (-not (($system -Like '*Microsoft Windows Server 2025*') -or (

$system -Like '*Microsoft Windows Server 2022*') -or ($system
-Like '*Microsoft Windows Server 2019*') -or ($system -Like '*
Microsoft Windows Server 2016*') -or ($system -Like '*
Microsoft Windows 11*') -or ($system -Like '*Microsoft Windows
10*')))

37 {
38
39 Write-Host("This is not a supported platform. Installation

aborted.")
40 Exit
41 }
42
43
44 if ($system -Like '*Microsoft Windows Server*')
45 {
46
47 Import-Module ServerManager
48 AddFeatures('MSMQ-Server') #Message Queuing
49 }
50
51 else
52 {
53
54 try
55 {
56
57 dism /online /enable-feature /featurename:MSMQ-Server /

all
58 }
59
60 catch
61 {
62
63 Write-Host "Addition of Windows feature MSMQ failed"
64 Exit 1
65 }
66
67 write-Host "Addition of Windows feature MSMQ succeeded"
68 }

To install the Windows roles and features prerequisites, complete the following steps:

1. On the machine where you plan to install the Session Recording administration components:

a) Make sure that the execution policy is set to RemoteSigned or Unrestricted in Power‑
Shell.

1 Set-ExecutionPolicy RemoteSigned

© 1997–2026 Citrix Systems, Inc. All rights reserved. 45



Session Recording 2603

b) Start a command prompt as an administrator and run the powershell.exe -file
InstallPrereqsforSessionRecordingAdministration.ps1 command.

The script displays the features that are successfully added and then stops.

c) After the script runs, make sure that the execution policy is set to a proper value based on
your company policy.

2. On the machine where you plan to install the Session Recording agent component:

a) Make sure that the execution policy is set to RemoteSigned or Unrestricted in Power‑
Shell.

1 Set-ExecutionPolicy RemoteSigned

b) Start a command prompt as an administrator and run the powershell.exe -file
InstallPrereqsforSessionRecordingAgent.ps1 command.

The script displays the features that are successfully added and then stops.

c) After the script runs, make sure that the execution policy is set to a proper value based on
company policy.

Install Session Recording using the Citrix Virtual Apps and Desktops installer

Citrix Session Recording comprises the following components:

• Session Recording Administration (including the Session Recording database, Session Record‑
ing server, and Session Recording policy console)

• Session Recording agent
• Session Recording player
• Session Recording web player

While installing all the components on a single server is acceptable for a proof of concept, we recom‑
mend installing them on separate servers as follows:

• Install the Microsoft SQL Server on Machine A.

• Install the Session Recording server, Session Recording administrator logging, and Session
Recording database on Machine B.

Note:

The Session Recording database isn’t an actual database. It is a component that creates
and configures the required databases in the Microsoft SQL Server instance during instal‑
lation.

Installing the Session Recording server lets you install the Session Recording web player
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automatically.

• Install the Session Recording policy console on Machine C.

• Install the Session Recording player on either Machine C or Machine D.

• Install the Session Recording agent on the VDA.

Install the Session Recording Administration components

Install the Session Recording agent

Install the Session Recording player

Install the Session Recording Administration components

Note:

By default, for secure, Session Recording work only on TLS enabled scenario, which means you
need to bind a valid certificate on Session Recording IIS ‑> default web site. Do NOT specify host‑
name during binding.

If you want to use http only for session recording, see Use HTTP as the communication protocol.

The Session Recording Administration components include the Session Recording database, Session
Recording server, and Session Recording policy console. You can choose the component to install on
a server.

Step 1: Download the product software and launch the wizard

1. Use your Citrix account credentials to access the Citrix Virtual Apps and Desktops download
page and download the product ISO file. Unzip the ISO file or burn a DVD of it.

2. Use a local administrator account to log on to the machine where you are installing the Ses‑
sion Recording Administration components. Insert the DVD in the drive or mount the ISO file.
If the installer does not launch automatically, double‑click the AutoSelect application or the
mounted drive.
The installation wizard launches.
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Step2: Choosewhichproduct to install

Click Start next to the product to install Citrix Virtual Apps or Citrix Virtual Desktops™.
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Step3: SelectSessionRecording

Select the Session Recording entry.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 49



Session Recording 2603

Step4: Readandaccept the licenseagreement

On the Software License Agreement page, read the license agreement, accept it, and then click
Next.
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Step5: Select thecomponents to install andthe installation location

On the Core Components page:

• Location: By default, components are installed in C:\Program Files\Citrix. The default location
works for most deployments. You can specify a custom installation location.

• Component: By default, all the check boxes next to the components that can be installed are
selected. The installer knowswhether it is running on a single‑session OS or amulti‑session OS.
It allows the Session Recording Administration components to be installed on a multi‑session
OS only. It allows the Session Recording agent to be installed only on amachine that has a VDA
installed. If you install the Session Recording agent on a machine that has no VDA installed in
advance, the Session Recording Agent option is unavailable.

Select Session Recording Administration and clickNext.
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Step6: Select the features to install

On the Features page:

• By default, all the check boxes next to the features that can be installed are selected. Installing
all these features on a single server is fine for a proof of concept. For a large production envi‑
ronment, install the Session Recording policy console on a separate server. Install the Session
Recording server, administrator logging, and database on another separate server.

• The Session Recording administrator logging is an optional subfeature of the Session Record‑
ing server. Select the Session Recording server before you can select the Session Recording ad‑
ministrator logging. The Session Recording database is a mandatory subfeature of the Session
Recording server. When the Session Recording server is selected for installation, the Session
Recording database is also selected automatically and cannot be unselected.
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• If you select the Session Recording server, the Session Recording web player is installed too.

• To add features on the same server after you select and install features on it, you can only use
the msi package. You cannot run the installer again.

• Session Recording server

The Session Recording server is a server that hosts:

• The Broker. An IIS 6.0+ hosted Web application that serves the following purposes:
• Handling search queries and file download requests from the Session Recording
player and web player.

• Handling policy administration requests from the Session Recording policy console.
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• Evaluating recordingpolicies for eachCitrix Virtual Apps andDesktops or Citrix DaaS™
(formerly Citrix Virtual Apps and Desktops service) session.

• The StorageManager. AWindows service thatmanages the recorded session files received
from each Session Recording‑enabled VDA.

• Administrator Logging. An optional subcomponent installed with the Session Recording
server to log the administration activities. All the logging data is stored in a separate SQL
Server database named CitrixSessionRecordingLogging by default. You can customize
the database name.

• Session Recording database

• The Session Recording database isn’t an actual database. It is a component that creates
and configures the required databases in the Microsoft SQL Server instance during instal‑
lation. Session Recording supports three solutions for database high availability based on
Microsoft SQL Server. For more information, see Database high availability.

• You can install the Session Recording database on the following cloud SQL database ser‑
vices:

• Azure SQL Database
• Azure SQL Managed Instance
• SQL Server on Azure Virtual Machines (VMs)
• AWS RDS
• Google Cloud SQL Server

• Session Recording admin logging

We recommend that you install the Session Recording administrator logging together with the
Session Recording server at the same time. If you don’t want the administrator logging fea‑
ture to be enabled, you can disable it on a later page. However, if you choose not to install this
feature at the beginning but want to add it later, you can onlymanually add it by using Session‑
RecordingAdministrationx64.msi.

• Session Recording policy console

You can use the Session Recording policy console to configure policies.

Step 6.1: Install the Session Recording server, database, and administrator logging As de‑
scribed earlier, the Session Recording database is a mandatory subfeature of the Session Recording
server andwe recommend that you install the Session Recording administrator logging together with
the Session Recording server at the same time. Therefore, this section walks you through installing
the three components on the samemachine.
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1. On the Features page, select Session Recording Server and Session Recording Administra‑
tor Logging. With Session Recording Server selected, Session Recording Database is also
selected automatically. Click Next.

2. On the Database and Server Configuration page, specify the instance name and database
name of the Session Recording database, enable SQL Server authentication as needed, and
clickNext.

Note:

Starting with 2507, in addition to SQL Server authentication, Session Recording supports
Entra ID (formerly Azure Active Directory) password and service principal authentication
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with Cloud Managed Entra id account. For more information, see Install the complete set
of the Session Recording Administration components by using a single command.

On the Database and Server Configuration page:

• EnableSQLServerauthentication: Thisoption lets youconnect to theSessionRecording
database using SQL Server authentication.

• Instancename: If the database instance isn’t a named instance, you canuse only the com‑
puter name of the SQL Server. If you have named the instance during the instance setup,
use computer‑name\instance‑name as the database instance name. To determine the
server instance name that you are using, run select @@servername on the SQL Server.
The return value is the exact database instance name. If your SQL server uses a custom
port instead of the default 1433, append a comma and the custom port to the instance
name. For example, type DXSBC‑SRD‑1,2433 in the Instance name text box, where 2433
denotes the custom port.

• Database name: Type a customdatabase name in theDatabase name text box or use the
default database name preset in the text box. Click Test connection to test the connectiv‑
ity to the SQL Server instance and the validity of the database name.

Note:

The Session Recording server default installation uses HTTPS/TLS to secure commu‑
nications. If TLS is not configured in the default Internet Information Services (IIS)
site of the Session Recording server, use HTTP. To do so, cancel the selection of SSL
in the IIS Management Console by navigating to the Session Recording Broker site,
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opening the SSL settings, and clearing the Require SSL check box.

Important:

A custom database name must contain only A‑Z, a‑z, 0–9, and underscores, and can‑
not exceed 123 characters.

You must have the securityadmin and dbcreator server role permissions of the SQL
Server instance. If you do not have the permissions, you can:

• Ask thedatabaseadministrator to assign thepermissions for the installation. After the
installation completes, the securityadminanddbcreator server rolepermissions are
no longer necessary and can be safely removed.

• Or, use the SessionRecordingAdministrationx64.msi package under \x64\Session
Recording on the Citrix Virtual Apps and Desktops ISO. During the msi installation,
a dialog box prompts for the credentials of a database administrator with the
securityadmin and dbcreator server role permissions. Type the correct credentials
and then clickOK to continue the installation.

The installation creates the Session Recording database and adds the machine ac‑
count of the Session Recording server as db_owner.

3. On theAdministration Logging Configuration page, specify configurations for the administra‑
tion logging feature.

On the Administration Logging Configuration page:

• TheAdministrationLoggingdatabase is installedon theSQLServer instance: This text
box is not editable. The SQL Server instance name of the Administration Logging data‑
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base is automatically grabbed from the instance name that you typed on the Database
and Server Configuration page. Starting with the 2411 release, you can install the Ses‑
sionRecording admin loggingdatabaseona separate instance from theSessionRecording
database. To do so, complete the following steps before installing them:

a) Go to the machine where you are going to install the Session Recording server.
b) Open the Registry Editor.
c) Modify the registry:

• Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor
\Server.

• Add the SmAudDatabaseLoggingState DWORD (32‑bit) value and set the
value data to 1.

• Add the SmAudDatabaseLoggingInstance value and set the value data to
the instancenamewhere youwant to install the SessionRecording admin logging
database.

Later when you install the databases, the Session Recording admin logging database is in‑
stalled on the separate instance specified by the SmAudDatabaseLoggingInstance
registry value. Youmust configure the same authenticationmode for both databases (SQL
Server authentication, Windows authentication, or Microsoft Entra ID authentication) and
grant identical user permissions.

• Administrator Logging database name: To install the Session Recording administrator
logging feature, type a custom database name for the administrator logging database in
this text box or use the default database name CitrixSessionRecordingLogging that is
preset in the text box.

Note:

The administrator logging database namemust be different from the Session Record‑
ing database name that is set in the Database name text box on the previous Data‑
base and Server Configuration page.

• After typing the administrator logging database name, click Test connection to test the
connectivity to the administrator logging database.

• Enable Administration Logging: By default, the administration logging feature is
enabled. You can disable it by clearing the check box.

• Enable mandatory blocking: By default, mandatory blocking is enabled. The normal
featuresmight be blocked if logging fails. You can disablemandatory blocking by clearing
the check box.

ClickNext to continue the installation.
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4. Review the prerequisites and confirm the installation.

The Summary page shows your installation choices. You can click Back to return to the earlier
wizard pages andmake changes, or click Install to start the installation.

5. Complete the installation.
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TheFinish Installationpageshowsgreencheckmarks forall theprerequisitesandcomponents
that have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording server, database, and admin‑
istrator logging.

Step6.2: Install theSessionRecordingpolicy console To install the SessionRecording policy con‑
sole, complete the following steps:

1. On the Features page, select Session Recording Policy Console and click Next.

2. Review the prerequisites and confirm the installation.
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The Summary page shows your installation choices. You can click Back to return to the earlier
wizard pages andmake changes, or click Install to start the installation.

3. Complete the installation.
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TheFinish Installationpageshowsgreencheckmarks forall theprerequisitesandcomponents
that have been installed and initialized successfully.

Click Finish to complete your installation of the Session Recording policy console.

Step 7: Install Broker_PowerShellSnapIn_x64.msi

Important:

Touse theSessionRecordingpolicy console, install theBrokerPowerShell Snap‑in (Broker_PowerShellSnapIn_x64
.msi)manually. Locate the snap‑in on theCitrix Virtual Apps andDesktops ISO (\x64\Citrix
Desktop Delivery Controller) and follow the instructions for installing it. Failure to

comply can cause an error.

Install the Session Recording agent

The Session Recording agent is a component installed on each VDA for multi‑session OS or single‑
session OS to enable recording. It is responsible for recording session data.

Step1: Download theproduct softwareand launch thewizard Usea local administrator account
to log on to the machine where you are installing the Session Recording agent. Insert the DVD in the
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drive ormount the ISO file. If the installer does not launch automatically, double‑click theAutoSelect
application or the mounted drive.

The installation wizard launches.

Step2: Choosewhichproduct to install

Click Start next to the product to install Citrix Virtual Apps or Citrix Virtual Desktops.
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Step3: SelectSessionRecording

Select the Session Recording entry.
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Step4: Readandaccept the licenseagreement

On the Software License Agreement page, read the license agreement, accept it, and then click
Next
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Step5: Select thecomponent to install andthe installation location

Select Session Recording Agent and clickNext.
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Step6: Specify theagentconfiguration

On the Agent Configuration page, complete the following settings:

• Type the computer name of themachine where you installed the Session Recording server and
the protocol and port information for connecting to the Session Recording server. If you have
not installed Session Recording yet, you can change such information later in Session Record‑
ing Agent Properties.

• If you want to install the Session Recording message queue or MSMQ manually later. You can
check “Skip MSMQ installation”. This option lets you proceed without installing Microsoft Mes‑
sage Queuing (MSMQ).

• If you are installing the Session Recording agent on an Azure AD joinedmachine, select Enable
Azure AD support. To fully enable Azure AD identity support for configuring playback permis‑
sions and various Session Recording policies from the cloud, complete the following steps and
then restart the VDA:

Note:

Azure AD support is a preview feature. It is available with Session Recording version 2402
and later.
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Preview features might not be fully localized and are recommended for use in
non‑production environments. Citrix Technical Support doesn’t support issues found
with preview features.

• Use theMSI package to install the SessionRecording server onanAzureAD joinedmachine
as well. Select Enable Azure AD support during the MSI installation.

• Connect Citrix Cloud to Azure AD.

• Go to the home page for the Full Configuration interface and enable the SessionRecord‑
ingSupportAAD and Send User Identity Info In Prepare Session toggles under the Pre‑
view features section. To access the home page for the Full Configuration interface, com‑
plete the following steps:

1. Sign in to Citrix Cloud.
2. In the upper leftmenu, selectMy Services > DaaS. By default, the home page for the

Full Configuration interface appears.

Note:

There is a limitation with the test connection function of the installer. It does not support the
“HTTPS requires TLS 1.2”scenario. If you use the installer in this scenario, the test connection
fails but you can ignore the failure and click Next to continue the installation. It does not affect
normal functioning.
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Step7: Reviewtheprerequisitesandconfirmthe installation

The Summary page shows your installation choices. You can clickBack to return to the earlier wizard
pages andmake changes, or click Install to start the installation.
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Step8: Complete the installation

The Finish Installation page shows green checkmarks for all the prerequisites and components that
have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording Agent.

Note:

WhenMachine Creation Services (MCS) or Citrix Provisioning™ createsmultiple VDAs with amas‑
ter imageandMicrosoftMessageQueuing (MSMQ) installed, theVDAsmight have the sameQMId.
The sameQMIdmight cause various issues, for example:

• Sessions might not be recorded even if the recording agreement is accepted.
• The Session Recording Server might not be able to receive session logoff signals and there‑
fore, sessions might always be in Live status.

As aworkaround, create a uniqueQMId for each VDA and it differs depending on the deployment
methods.

Noextraactionsare required if single‑sessionOSVDAswith theSessionRecordingagent installed
are createdwith PVS 7.7 or later andMCS 7.9 or later in the static desktopmode that is, for exam‑
ple, configured tomake all changes persistent with a separate Personal vDisk or the local disk of
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your VDA.

For multi‑session OS VDAs created with MCS or PVS and single‑session OS VDAs that are config‑
ured to discard all changes when a user logs off, use theGenRandomQMID.ps1 script to change
the QMId on system startup. Change the power management strategy to ensure that enough
VDAs are running before user logon attempts.

To use the GenRandomQMID.ps1 script, do the following:

1. Ensure that the execution policy is set to RemoteSigned or Unrestricted in PowerShell.

Set‑ExecutionPolicy RemoteSigned

2. Create a scheduled task, set the trigger as on system startup, and run with the SYSTEM ac‑
count on the PVS or MCSmaster imagemachine.

3. Add the command as a startup task.

powershell .exe -file C:\\GenRandomQMID.ps1

Summary of the GenRandomQMID.ps1 script:

1. Remove the currentQMId from the registry.
2. Add SysPrep = 1 to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSMQ\

Parameters.
3. Stop related services, including CitrixSmAudAgent and MSMQ.
4. To generate a randomQMId, start the services that stopped previously.

Example GENRANDOMQMID.PS1:

1 # Remove old QMId from registry and set SysPrep flag for MSMQ
2
3 Remove-Itemproperty -Path HKLM:Software\Microsoft\MSMQ\Parameters\

MachineCache -Name QMId -Force
4
5 Set-ItemProperty -Path HKLM:Software\Microsoft\MSMQ\Parameters -

Name "SysPrep" -Type DWord -Value 1
6
7 # Get dependent services
8
9 $depServices = Get-Service -name MSMQ -dependentservices | Select -

Property Name
10
11 # Restart MSMQ to get a new QMId
12
13 Restart-Service -force MSMQ
14
15 # Start dependent services
16
17 if ($depServices -ne $null) {
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18
19
20     foreach ($depService in $depServices) {
21
22
23         $startMode = Get-WmiObject win32_service -filter "NAME = '$

($depService.Name)'" | Select -Property StartMode
24
25          if ($startMode.StartMode -eq "Auto") {
26
27
28              Start-Service $depService.Name
29          }
30
31 }
32
33
34 }

Install the Session Recording player

The Session Recording player is a user interface that you access from a workstation to play recorded
session files. Install the Session Recording player on the Session Recording server or on workstations
in the domain.

Tip:

• Installing the Session Recording server lets you install the Session Recording web player
automatically.

• Before or after you install the Session Recording player, install the Microsoft Visual C++ Re‑
distributable package called VC_redist.x86.exe. You can find the package on the Citrix Vir‑
tual Apps and Desktops ISO under \Support\VcRedist.

Step1: Download theproduct softwareand launch thewizard Usea local administrator account
to log on to themachinewhere you are installing the Session Recording player component. Insert the
DVD in the drive or mount the ISO file. If the installer does not launch automatically, double‑click the
AutoSelect application or the mounted drive.

The installation wizard launches.
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Step2: Choosewhichproduct to install

Click Start next to the product to install Citrix Virtual Apps or Citrix Virtual Desktops.
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Step3: SelectSessionRecording

Select the Session Recording entry.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 75



Session Recording 2603

Step4: Readandaccept the licenseagreement

On the Software License Agreement page, read the license agreement, accept it, and then click
Next.
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Step5: Select thecomponent to install andthe installation location

Select Session Recording Player and clickNext.
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Step6: Reviewtheprerequisitesandconfirmthe installation

The Summary page shows your installation choices. You can clickBack to return to the earlier wizard
pages andmake changes, or click Install to start the installation.
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Step7: Complete the installation

The Finish Installation page shows green checkmarks for all the prerequisites and components that
have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording player.

Choose themessage queuing solution

The default message queue for Session Recording is Microsoft Message Queue (MSMQ). Session
Recording offers the Session Recording message queue as an alternative to MSMQ. Its installation
and configuration are described further in this section. The active message queue can be changed
using registry settings.

MSMQ

It is recommended that users of MSMQ configure the Access Control List (ACL) following the Session
Recording installation. For more information, see Security recommendations.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 79

https://docs.citrix.com/en-us/session-recording/2507-ltsr/get-started/security-recommendations.html


Session Recording 2603

Session Recordingmessage queue

The Session Recordingmessage queue solution is designed to enhance Session Recording’s capabili‑
ties by:

• Supporting modern .NET environments: Built on WebSocket and nats.io, it eliminates the
dependency on the .NET Framework required by MSMQ.

• Providingenhanced features: Offerspersistent storage,multipleauthenticationmethods, SSL
encryption, and various configuration options.

• Improving authentication flexibility: Supports better authentication choices for Azure AD or
other non‑AD scenarios.

Install and configure the Session Recordingmessage queue

1. To proceed with the installation and configuration of the Session Recording message queue,
ensure that the following prerequisites are met:

• Youmust have administrator privileges.
• .NET 8 Runtime must be installed from https://dotnet.microsoft.com/en‑us/download/
dotnet/8.0 before you install the Session Recording message queue.

2. On the Session Recording server, run wf.msc (Windows Firewall with Advanced Security) and
add inbound rules to allow inbound TCP traffic on ports 8221 and 8223. (Port numbers can be
modified, as described in the followingOptional configurations section.)
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3. On the VDA, install the Session Recording agent using either themeta installer from the ISO file
or by directly running SessionRecordingAgentx64.msi.

If your environment uses only the Session Recording message queue and will not switch to
MSMQ, youmay select the “Skip MSMQ Installation”option during the Session Recording agent
installation. This ensures that:

• MSMQwill not be installed on the VDA bymeta installer.

• The Session Recording agent service is not configured with an MSMQ dependency.

After completing the agent installation, deploy the Session Recording message queue by run‑
ning SessionRecordingMsgQueue.msi from the ISO file.
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4. Restart the VDA.

5. Configure the permissions, policies, and other settings for Session Recording. Recorded ses‑
sions can now be transmitted through the Session Recording message queue.

Optional configurations

Use SSL encryption

1. On the Session Recording server, bind the certificate to port 8223. For example, use the follow‑
ing command, filling in the certificate’s thumbprint to bind to port 8223:

1 netsh http add sslcert ipport=0.0.0.0:8223 certhash=CertThumbprint
appid={

2 NewGuid }

Note:

Theappid’sGUIDvalue is anyuppercase string that conforms to theGUID format, enclosed
in curly braces. The certhash value comes from the thumbprint value in the certificate’s
details and is case‑sensitive.

2. On theVDA, in the registryComputer\HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\MsgQueue,
modify OutboundPort to 8223, modify OutboundUseSSL to 1, and modify OutboundFQDN
to the FQDN supported by the certificate, for example, SessionRecordingServer.bvt.local. If
this item is not filled, the IP address resolved within the AD domain is used.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 82



Session Recording 2603

3. Restart the VDA, or restart the CitrixSmAudMsgQueue service on the VDA.

Modify port numbers

1. On theSessionRecordingserver, in the registryComputer\HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server,
add DWORD type keys named SmAudMsgQueueServerPort for the HTTP port and SmAudMs‑
gQueueServerHTTPSPort for the HTTPS port. Also, add inbound rules to the firewall’s
inbound rules to allow traffic through the modified ports. After adding the keys, restart the
Session Recording server or restart the CitrixSsRecMsgQueue service on the server.

2. On theVDA, in the registryComputer\HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\MsgQueue,
modify the OutboundPort key. When OutboundUseSSL is set to 0, it configures the HTTP
port, and whenOutboundUseSSL is set to 1, it configures the HTTPS port. After modifying the
key, restart the VDA or restart the CitrixSmAudMsgQueue service on the VDA.

Modify the authenticationmode

1. By default, the Session Recording message queue uses Active Directory (AD) domain authen‑
tication between the Session Recording server and the VDA.

2. On the Session Recording server, navigate to the registry path:
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server
Add a new DWORD key named SmAudMsgQueueServerAuth with one of the following val‑
ues:

• 0: No authentication (accepts all messages without verification)—not recommended

• 1: Default AD domain authentication

• 2: Citrix Cloud authentication (required for Azure AD scenarios)

After adding the key, restart the Session Recording server or the CitrixSsRecMsgQueue service..
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3. On the VDA, in the registry Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\
SmartAuditor\MsgQueue, modify the OutboundAuthMethod key by setting its
value to the same value as SmAudMsgQueueServerAuth on the Session Recording server.
After modifying the key, restart the VDA or restart the CitrixSmAudMsgQueue service on
the VDA.

Troubleshooting

Communication failure

1. Check whether the CitrixSsRecMsgQueue and CitrixSsRecStorageManager services are in a
running state on the Session Recording server.

2. Check whether the CitrixSmAudAgent, CitrixSmAudMsgQueue, and CitrixSmAud‑
NatsServer services are in a running state on the VDA.

3. Check whether ports 8221 and 8223 are allowed through the firewall on the Session Recording
server.

4. Checkwhether theOutboundFQDN is configuredon theVDA. If it is empty, the server IPaddress
is automatically resolved within the AD domain. In Azure Active Directory scenarios and SSL
encryption scenarios, this field must be filled with the actual FQDN of the Session Recording
server.

5. Check whether the OutboundUseSSL registry key value on the VDA is set to 1. If it is 1, check
whether the Session Recording server has a certificate bound to port 8223.

6. Check whether the default ports have been modified on the VDA and the Session Recording
server. If the ports have beenmodified, check whether themodified ports are allowed through
the firewall and if a certificate is bound to them.

7. Checkwhether the default authenticationmode has beenmodified on the VDA and the Session
Recording server. If theauthenticationmodehasbeenmodified, checkwhether theOutbound‑
AuthMethod value and the SmAudMsgQueueServerAuth value are the same.

The VDA’s CitrixSmAudMsgQueue service fails to start

1. Check whether .NET 8 Runtime is installed on the VDA.
2. Check whether you have administrator privileges when installing SessionRecordingMs‑

gQueue.msi.

Unable to stop the MSMQ service or disable the MSMQ feature

1. On theVDA, in the registryComputer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet
\Services\CitrixSmAudAgent, remove MSMQ from the DependOnService key, leave
the rest unchanged, and clickOK then restart VDA.
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Automate installation

Session Recording supports silent installation with options.

Automate installation of the Session Recording Administration components

Install the complete set of the Session Recording Administration components by using a single
command Session Recording now supports different types of SQL authentication. Refer to the fol‑
lowing table for details:

Session Recording
Version

Supported SQL Server
Type

Supported SQL
Authentication Method Notes

< 2411
• On‑Premises
SQL Server

• Azure SQL
Database

• Azure SQL
Managed
Instance

• SQL Server on
Azure VMs

• AWS RDS
• Google Cloud
SQL Server

SQL Server
Authentication

For more information,
see Install the Session
Recording database on
cloud SQL database
services

Starting from 2411
• On‑Premises
SQL Server

• Azure SQL
Database

• Azure SQL
Managed
Instance

• SQL Server on
Azure VMs

• AWS RDS
• Google Cloud
SQL Server

• SQL Server
Authentication

• Microsoft Entra
ID Password
Authentication
with Cloud
Managed Entra
id account

Microsoft Entra ID
Password
Authentication only
supported Azure SQL
Database and Azure
SQL Managed Instance.
For more information,
see Install the Session
Recording database on
Azure SQL Database
and Install the Session
Recording database on
Azure SQL Managed
Instance or on AWS
RDS.
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Session Recording
Version

Supported SQL Server
Type

Supported SQL
Authentication Method Notes

Starting from 2507
• On‑Premises
SQL Server

• Azure SQL
Database

• Azure SQL
Managed
Instance

• SQL Server on
Azure VMs

• AWS RDS
• Google Cloud
SQL Server

• SQL Server
Authentication

• Microsoft Entra
ID Password
Authentication
with Cloud
Managed Entra
id account

• Microsoft Entra
ID Service
Principal
Authentication
with Cloud
Managed Entra
id account

• Microsoft Entra
ID Password
Authentication
only supported
Azure SQL
Database and
Azure SQL
Managed
Instance.

• Microsoft Entra
ID Service
Principal
Authentication
only supported
Azure SQL
Managed
Instance

For example, either of the following commands installs the complete set of the Session Recording
Administration components and creates a log file to capture the installation information.

1 msiexec /i "c:\SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="WNBIO-SRD-1" DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="CitrixSessionRecordingLogging" DATABASEUSER="
localhost" /q /l*vx "yourinstallationlog"

1 msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="DatabaseConnectionString" DATABASENAME="
CitrixSessionRecording" LOGGINGDATABASENAME="
CitrixSessionRecordingLogging" AZURESQLSERVICESUPPORT="1"
DATABASEUSER="localhost" CLOUDDBSUPPORT="0" AZUREUSERNAME="
SQLorEntraIDAdminName" AZUREPASSWORD="SQLorEntraIDAdminPassword"
AADPASSWORD="1" SERVICEKEYAUTHENABLE="1" /qn+ /l*vx "
yourinstallationlog"

1 msiexec /i "SessionRecordingAdministrationx64.msi"
2 ADDLOCAL="SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
3 DATABASEINSTANCE="DatabaseConnectionString" DATABASENAME="

CitrixSessionRecording" LOGGINGDATABASENAME="
CitrixSessionRecordingLogging" AZURESQLSERVICESUPPORT="1"

4 CLOUDDBSUPPORT="0"
5 AZUREUSERNAME="ServicePrincipalClientId" AZUREPASSWORD="

ServicePrincipalClientsecret"
6 AADPASSWORD="0"
7 AZURETENANTID="ServicePrincipalTenantId"
8 SERVICEPRINCIPAL="1" /qn+ /l*vx "yourinstallationlog "

Note:

You can find the SessionRecordingAdministrationx64.msi file on the Citrix Virtual
Apps and Desktops ISO under \x64\Session Recording.
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Regardless of the instance specified by DATABASEINSTANCE here, starting with the 2411 re‑
lease, you canalso choose to install the SessionRecording admin loggingdatabaseona separate
instance from the Session Recording database. To do so, complete the following steps before
running either of the commands to install them:

1. Go to the machine where you are going to install the Session Recording server.

2. Open the Registry Editor.

3. Modify the registry:

• Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\
Server.

• Add the SmAudDatabaseLoggingState DWORD (32‑bit) value and set the value
data to 1.

• Add theSmAudDatabaseLoggingInstance value and set the value data to the in‑
stance namewhere youwant to install the Session Recording admin logging database.

Later when you install the databases, the Session Recording admin logging database is in‑
stalled on the separate instance specified by the SmAudDatabaseLoggingInstance
registry value. Youmust configure the same authentication mode for both databases (SQL
Server authentication, Windows authentication, or Microsoft Entra ID authentication) and
grant identical user permissions.

Where:

• ADDLOCAL provides the features for you to select. You can selectmore than one option. SsRec‑
Server is the Session Recording server. PolicyConsole is the Session Recording policy console.
SsRecLogging is the Administrator Logging feature. StorageDatabase is the Session Recording
database. Session Recording Administrator Logging is an optional subfeature of the Session
Recording server. Select the Session Recording server before you can select Session Recording
administrator logging.

• DATABASEINSTANCE is the instance name of the Session Recording database. For exam‑
ple,.\SQLEXPRESS,computer-name\SQLEXPRESS,computer-name or tcp:srt-
sql-support.public.ca7b16b60789.database.windows.net,3342 if you are
using Azure SQL Managed Instance. As described earlier, you can install the Session Recording
database and the Session Recording admin logging database on the same instance or separate
instances.

• DATABASENAME is the database name of the Session Recording database.

• LOGGINGDATABASENAME is the name of the administrator logging database.

• AZURESQLSERVICESUPPORTdetermineswhether SQLServer authentication is supported. To
use SQL Server authentication, set it to 1.
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• DATABASEUSER is the computer account of the Session Recording server.

• CLOUDDBSUPPORT determines whether Azure SQL Databases are supported.

• AZUREUSERNAME is theSQLServerorMicrosoftEntra IDadministratornameorMicrosoftEntra
ID ServicePrincipal client id(Application ID). To useMicrosoft Entra ID authentication, complete
the following steps:

1. Make sure that Visual C++ Redistributable has been installed on the Session Recording
server. Otherwise, download and install it from https://learn.microsoft.com/en‑us/c
pp/windows/latest‑supported‑vc‑redist?view=msvc‑170.

2. Make sure that theMicrosoftODBCDriver for SQL Server has been installed on the Session
Recording server. Otherwise, download and install it from https://learn.microsoft.com/
en‑us/sql/connect/odbc/download‑odbc‑driver‑for‑sql‑server?view=sql‑server‑ver16.

3. Include the AADPASSWORD parameter and set it to 1 when running the database installa‑
tion command.

4. Create an Entra ID admin and grant it SQL Server administrative permissions. For more
information, see the Microsoft documentation: https://learn.microsoft.com/en‑us/azu
re/azure‑sql/database/authentication‑aad‑configure?view=azuresql&tabs=azure‑
powershell.

• AZUREPASSWORD is the SQL Server or Microsoft Entra ID administrator password or Microsoft
Entra ID ServicePrincipal client secret.

• AADPASSWORD determines whether Microsoft Entra ID authentication is supported. To use
Microsoft Entra ID authentication, set it to 1.

• AZURETENANTID is Azure tenantid(Directory ID).

• SERVICEPRINCIPAL determines whether Microsoft Entra ID ServicePrincipal authentication is
supported. To use Microsoft Entra ID ServicePrincipal authentication, set it to 1.

• SERVICEKEYAUTHENABLEenables the servicekeyauthenticationbetween theSessionRecord‑
ing agent and the Session Recording server. This parameter is required only when you want to
enable Azure AD support and youmust set it to 1. Otherwise, do not add this parameter.

• /q specifies quiet mode.

• /l*v specifies verbose logging.

• yourinstallationlog is the location of your installation log file.

Create a master image for deploying the Session Recording server You might already have the
SessionRecordingdatabaseand theadministration loggingdatabase inplace fromanexistingdeploy‑
ment. For such scenarios, you can now forego database checks when you are installing the Session
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Recording Administration components using SessionRecordingAdministrationx64.msi. You can cre‑
ate a master image for deploying the Session Recording server easily on many other machines. After
deploying the Session Recording server on target machines using the master image, run a command
on each machine to connect to the existing Session Recording database and administration logging
database. This master image support facilitates deployment and minimizes the potential impact of
human error. It applies only to fresh installations and consists of the following steps:

1. Start a command prompt and run a command similar to the following:

1 msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="sqlnotexists" DATABASENAME="
CitrixSessionRecording2" LOGGINGDATABASENAME="
CitrixSessionRecordingLogging2" DATABASEUSER="localhost" /q /l*
vx "c:\WithLogging.log" IGNOREDBCHECK="True"

This command installs the Session Recording Administration components without configuring
and testing connectivity to theSessionRecordingdatabaseand theadministration loggingdata‑
base.

Set the IGNOREDBCHECK parameter to True and use random values for DATABASEINSTANCE,
DATABASENAME, and LOGGINGDATABASENAME.

2. Create a master image on the machine that you are operating.

3. Deploy the master image to other machines for deploying the Session Recording server.

4. On each of the machines, run commands similar to the following:

1 .\SsRecUtils.exe -modifydbconnectionpara DATABASEINSTANCE
DATABASENAME LOGGINGDATABASENAME

2
3 iisreset /noforce

The commands connect the Session Recording server installed earlier to an existing Session
Recording database and administration logging database.

You can find the SsRecUtils.exe file at \Citrix\SessionRecording\Server\bin
\. Set the DATABASEINSTANCE, DATABASENAME, and LOGGINGDATABASENAME parameters
as needed.

Retain databases when uninstalling the Session Recording Administration components With
KEEPDB set to True, the following command retains the Session Recording database and the admin‑
istration logging database when uninstalling the Session Recording Administration components:

1 msiexec /x "SessionRecordingAdministrationx64.msi" KEEPDB="True"
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Automate installation of the Session Recording player andweb player

For example, the following commands install the Session Recording player and web player, respec‑
tively.

1 msiexec /i "c:\SessionRecordingPlayer.msi" /q /l*\vx "
yourinstallationlog"

1 msiexec /i "c:\SessionRecordingWebPlayer.msi" /q /l*vx "
yourinstallationlog"

Note:

You can find SessionRecordingPlayer.msi on the Citrix Virtual Apps and Desktops ISO
under \x86\Session Recording.

You can find SessionRecordingWebPlayer.msi on the Citrix Virtual Apps and Desktops
ISO under \x64\Session Recording.

Where:

• /q specifies quiet mode.
• /l*v specifies verbose logging.
• yourinstallationlog is the location of your installation log file.

Automate installation of the Session Recording agent For example, the following command in‑
stalls the Session Recording agent and creates a log file to capture the installation information.

1 msiexec /i SessionRecordingAgentx64.msi /q /l*vx yourinstallationlog
SESSIONRECORDINGSERVERNAME=yourservername

2 SESSIONRECORDINGBROKERPROTOCOL=yourbrokerprotocol
SESSIONRECORDINGBROKERPORT=yourbrokerport
SESSIONRECORDINGAUTHENTICATION="Citrix Cloud™" SESSIONRECORDINGRPC="
Websocket" SESSIONRECORDINGIDP="IDP"

Note:

You can findSessionRecordingAgentx64.msion theCitrix Virtual Apps andDesktops ISO
under \x64\Session Recording.

Where:

• yourservername is the NetBIOS name or FQDN of the machine hosting the Session Recording
server. If not specified, this value defaults to localhost.

• yourbrokerprotocol is the HTTP or HTTPS that the Session Recording agent uses to communi‑
cate with the Session Recording Broker. If not specified, this value defaults to HTTPS.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 90



Session Recording 2603

• yourbrokerport is the port number that the Session Recording agent uses to communicate
with the Session Recording Broker. If not specified, this value defaults to zero, which directs
the Session Recording Agent to use the default port number for your selected protocol: 80 for
HTTP or 443 for HTTPS.

• SESSIONRECORDINGAUTHENTICATION is the authentication type between the Session
Recording agent and the Session Recording server. This parameter is required only when you
want to enable Azure AD support. To enable Azure AD support, add this parameter and set it to
Citrix Cloud.

• SESSIONRECORDINGRPC is the communicationmethodbetween the SessionRecording agent
and the Session Recording server. This parameter is required only when you want to enable
Azure AD support. To enable Azure AD support, add this parameter and set it toWebsocket.

• SESSIONRECORDINGIDP specifies the identity type. This parameter is required only when you
want to enable Azure AD support. To enable Azure AD support, add this parameter and set it to
IDP.

• /q specifies quiet mode.
• /l*v specifies verbose logging.
• yourinstallationlog is the location of your installation log file.

Upgrade Session Recording

You can upgrade certain deployments to later versions without having to first set up newmachines or
sites. You can upgrade from the version of Session Recording included in the latest CU of XenApp and
XenDesktop 7.6 LTSR, and from any later version, to the latest release of Session Recording.

Note:

When you upgrade Session Recording Administration from 7.6 to 7.13 or later and chooseMod‑
ify in Session Recording Administration to add the administrator logging service, the SQL Server
instance name does not appear on the Administrator Logging Configuration page. The follow‑
ing errormessage appearswhen you clickNext: Database connection test failed. Pleaseenter
correctDatabase instancename. Asaworkaround, add the readpermission for localhostusers
to the following SmartAuditor Server registry folder: HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Server.

You cannot upgrade from a Technical Preview version.

Requirements, preparation, and limitations

• Use the Session Recording installer’s graphical or command‑line interface to upgrade the Ses‑
sion Recording components on the machine where you installed the components.
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• Before any upgrade activity, back up the database named CitrixSessionRecording in the SQL
Server instance. In this way, you can restore it if any issues are discovered after the database
upgrade.

• In addition to being a domain user, you must be a local administrator on the machines where
you are upgrading the Session Recording components.

• If the Session Recording server and Session Recording database aren’t installed on the same
server, youmust have the database role permission to upgrade the SessionRecording database.
Otherwise, you can:

• Ask the database administrator to assign the securityadmin and dbcreator server role
permissions for the upgrade. After the upgrade completes, the securityadmin anddbcre‑
ator server role permissions are no longer necessary and can be safely removed.

• Or, use the SessionRecordingAdministrationx64.msi package to upgrade. During the msi
upgrade, a dialog box prompts for the credentials of a database administratorwhohas the
securityadmin and dbcreator server role permissions. Type the correct credentials and
then clickOK to continue the upgrade.

• You can choose not to upgrade all Session Recording agents at the same time. Session Record‑
ingagent7.6.0 (and later) is compatiblewith the latest (current) releaseof theSessionRecording
server. However, some new features and bug fixes might not take effect.

• Any sessions started during the upgrade of the Session Recording server are not recorded.
• The Graphics Adjustment option in Session Recording agent Properties is enabled by default
after a fresh installation or upgrade to keep compatible with the Desktop Composition Redirec‑
tion mode. You can disable this option manually after a fresh installation or upgrade.

• The administrator logging feature is not installed after you upgrade Session Recording from a
previous release where the feature is unavailable. To add the feature, modify the installation
after the upgrade.

• If there are live recording sessions when the upgrade process starts, there is little chance that
the recording can be complete.

• Review the following upgrade sequence, so that you can plan andmitigate potential outages.

Upgrade sequence

To upgrade an existing installation, go to each machine where a Session Recording component is in‑
stalled and then run the Citrix Virtual Apps and Desktops ISO.

Tip:

Go to the Citrix Virtual Apps and Desktops download page to download the appropriate version
of Citrix Virtual Apps and Desktops.

Upgrading an existing installation generally follows the following sequence:
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1. Upgrade the Session Recording server component.

If there is more than one Session Recording server, first upgrade the one where the Session
Recording database component is installed. After that, upgrade the rest Session Recording
servers.

To do so, complete the following steps:

a) Stop the Session Recording Storage Manager service manually on the Session Recording
server.

b) Through the Internet Information Services (IIS) Manager, ensure that the Session Record‑
ing Broker is running.

c) Run the Citrix Virtual Apps and Desktops ISO and select the Session Recording entry to
upgrade.

2. The Session Recording service is back online automatically when the upgrade of the Session
Recording server is completed.

3. Upgrade the Session Recording agent (on the master image).

4. Upgrade the Session Recording policy console with or after the Session Recording server.

5. Upgrade the Session Recording player.

Important note about upgrading to version 2511:

To prevent session recording failures due to incomplete upgrades of Session Recording agents,
follow these steps when upgrading to 2511:

1. Upgrade each Session Recording server to version 2511.

2. Enable remote access using .NET Remoting with the following command:

<SessionRecordingserverinstallationpath>\Bin\SsRecUtils.exe -
EnableBrokerRemoting

3. Upgrade each Session Recording agent to version 2511.

4. After all Session Recording agents are upgraded, disable remote access using .NET Remot‑
ing with the following command:

<SessionRecordingserverinstallationpath>\Bin\SsRecUtils.exe -
DisableBrokerRemoting

Install the Session Recording database on cloud SQL database services

This section describes how to install the Session Recording database on the following cloud SQL data‑
base services:
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• Azure SQL Database
• Azure SQL Managed Instance
• SQL Server on Azure VMs
• AWS RDS
• Google Cloud SQL Server

Install the Session Recording database on Azure SQL Database

1. Create an Azure SQL Database.

a) Sign in to the Azure portal using your Azure account.

b) From the portal menu, select Create a resource.

c) In the portal search box, enter SQL database.

d) From the list of search results, select SQL databases.

e) Click Create to create an Azure SQL Database.

f) In the Create SQL Database section, provide the following information:

• Subscription: Select the Azure subscription that you want.
• Resource Group: Select Create new or choose an existing resource group.
• Database Name: A unique name is required.
• Server: Select Create new, and fill out theNewServer formwith the following values:

• Server name: Enter a unique name. Server names must be globally unique for
all servers in Azure.

• Location: Select a location from the drop‑down list.
• Authenticationmethod: SelectUseSQLauthentication, Entra ID authentication,
or both.

• Server admin login: Enter a SQLServer orMicrosoftEntra ID administrator name.
Startingwith 2411, Session Recording supports Entra ID authentication for cloud‑
based SQL databases including Azure SQL Database and Azure SQL Managed In‑
stance. For more information about Microsoft Entra ID authentication, see the
command parameter descriptions in this article.

• Password: Enter a SQL Server or Microsoft Entra ID administrator password that
meets requirements and enter it again in the Confirm password field.

• SelectOK.

After providing the preceding information, clickReview + Create. Click the Create button
to complete the Azure SQL Database.

2. Repeat Step 1 to create a different Azure SQL Database on the same Server.
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3. Get the server connection string for the created Azure SQL Databases.

a) In the Azure portal, search for and click either of the Azure SQL Databases that you have
created.

b) Click Connection strings from the left navigation.
c) Keep a record of the Server string that is to be used as the instance name of the Session

Recording database and the Session Recording logging database later.

4. Run a command similar to the following to install the Session Recording database on the Azure
SQL Database that you have created earlier.

Note:

On Azure SQL Database, installation of the Session Recording database can be done only
by running a command similar to the following.

msiexec /i "SessionRecordingAdministrationx64.msi"ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"DATABASEINSTANCE
="DatabaseConnectionString"DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="CitrixSessionRecordingLogging"AZURESQLSERVICESUPPORT
="1"DATABASEUSER="localhost"CLOUDDBSUPPORT="1"AZUREUSERNAME="
SQLorEntraIDAdminName"AZUREPASSWORD="SQLorEntraIDAdminPassword"
AADPASSWORD="1"/qn+ /l*vx "yourinstallationlog"

Where:

• ADDLOCAL provides the features for you to select. You can select more than one option.
SsRecServer is the Session Recording server. PolicyConsole is the Session Recording pol‑
icy console. SsRecLogging is the Administrator Logging feature. StorageDatabase is the
Session Recording database. Session Recording Administrator Logging is an optional sub‑
feature of the Session Recording server. Select the Session Recording server before you
can select Session Recording administrator logging.

• DATABASEINSTANCE is the instance name of the Session Recording database, which is
specified by the Azure SQL Database connection string.

• DATABASENAME is the database name of the Session Recording database.

• LOGGINGDATABASENAME is the name of the administrator logging database.

• AZURESQLSERVICESUPPORT determines whether SQL Server authentication is sup‑
ported. To use SQL Server authentication, set it to 1.

• CLOUDDBSUPPORT determines whether Azure SQL Databases are supported.

• DATABASEUSER is the computer account of the Session Recording server.
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• AZUREUSERNAME is the SQL Server or Microsoft Entra ID administrator name. Starting
with 2411, Session Recording supports Entra ID authentication for cloud‑based SQL data‑
bases including Azure SQL Database and Azure SQL Managed Instance. To use Microsoft
Entra ID authentication, complete the following steps:

a) Make sure that Visual C++Redistributable hasbeen installedon theSessionRecording
server. Otherwise, download and install it from https://learn.microsoft.com/en‑
us/cpp/windows/latest‑supported‑vc‑redist?view=msvc‑170.

b) Make sure that the Microsoft ODBC Driver for SQL Server has been installed on the
Session Recording server. Otherwise, download and install it from https://learn.micr
osoft.com/en‑us/sql/connect/odbc/download‑odbc‑driver‑for‑sql‑server?view=sql‑
server‑ver16.

c) Include the AADPASSWORD parameter and set it to 1 when running the database in‑
stallation command.

d) Create an Entra ID admin and grant it SQL Server administrative permissions. For
more information, see theMicrosoftdocumentation: https://learn.microsoft.com/en‑
us/azure/azure‑sql/database/authentication‑aad‑configure?view=azuresql&tabs=
azure‑powershell.

• AZUREPASSWORD is the SQL Server or Microsoft Entra ID administrator password.

• AADPASSWORD determines whether Microsoft Entra ID authentication is supported. To
use Microsoft Entra ID authentication, set it to 1.

• /q specifies quiet mode.

• /l*v specifies verbose logging.

• yourinstallationlog is the location of your installation log file.

Install the Session Recording database on Azure SQL Managed Instance or on AWS RDS

Tip:

OnAzureSQLManaged InstanceandonAWSRDS, youcan install theSessionRecordingdatabase
by:

• Double‑clicking and running the SessionRecordingAdministrationx64.msi package.

• Running a command similar to the following:

1 msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="DatabaseConnectionString "DATABASENAME="
CitrixSessionRecording" LOGGINGDATABASENAME="
CitrixSessionRecordingLogging" AZURESQLSERVICESUPPORT="1"
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CLOUDDBSUPPORT="1" AZUREUSERNAME="SQLorEntraIDAdminName"
AZUREPASSWORD="SQLorEntraIDAdminPassword" AADPASSWORD="1"/
qn+ /l*vx "yourinstallationlog"

1. Create anAzure SQLManaged instanceor create a SQLServer instance through theAmazonRDS
console.

2. (For Azure SQL only) Keep a record of the Server strings that appear in the properties panel.
The strings are the instance name of the Session Recording database. For an example, see the
following screen capture.

3. (For AWS RDS only) Keep a record of the Endpoint and Port information. We use it as the in‑
stance name of your database, in the format of <Endpoint, Port>.
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4. Run SessionRecordingAdministrationx64.msi to install the Session Recording database.

Select theEnableSQLServerauthenticationcheckboxand fill in theSQLServeradministrator
name and password. Make other required configurations.
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Note:

• If you change the SQL Server administrator password, youmust update the password
inSessionRecordingServer Properties. When youopenSessionRecordingServer
Properties, an error message appears. Click OK to proceed, select the Cloud DB
tab, and type the new SQL Server administrator password. Restart the Citrix Session
Recording Analytics service, the Citrix Session Recording Storage Manager service,
and the IIS service.

• In addition to SQL Server authentication, Session Recording supports Entra ID (for‑
merly Azure Active Directory) authentication for cloud‑based SQL databases, includ‑
ing Azure SQL Database and Azure SQL Managed Instance. To use Microsoft Entra ID
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authentication, install the database through the command line and follow the instruc‑
tions described earlier in this article.

• Azure AD authentication is not supported.

Migrate an on‑premises database to cloud SQLManaged Instance

1. Migrate your on‑premises database according to https://docs.microsoft.com/en‑us/data‑
migration/ or https://docs.aws.amazon.com/prescriptive‑guidance/latest/patterns/migrate‑
an‑on‑premises‑microsoft‑sql‑server‑database‑to‑amazon‑rds‑for‑sql‑server.html.

2. TomakeSessionRecordingworkproperly after themigration, runSsRecUtils.exeon theSession
Recording server.

C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils.
exe -modifyazuredbconnectionpara { Database Instance } { Session
Recording Database Name } { Session Recording Logging Database
Name } { AzureAdminName } { AzureAdminPassword } iisreset /

noforce

3. On theSessionRecording server, restart theCitrix SessionRecordingAnalytics service, theCitrix
Session Recording Storage Manager service, and the IIS service.

Migrate a production database from Azure SQL Managed Instance to an on‑premises database

1. Migrate the database according to https://docs.microsoft.com/en‑us/data‑migration/.

2. TomakeSessionRecordingworkproperly after themigration, runSsRecUtils.exeon theSession
Recording server.

C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils
.exe -modifydbconnectionpara { Database Instance } { Session
Recording Database Name } { Session Recording Logging Database
Name } iisreset /noforce

3. On theSessionRecording server, restart theCitrix SessionRecordingAnalytics service, theCitrix
Session Recording Storage Manager service, and the IIS service.

Install the Session Recording database on SQL Server on Azure VMs

On SQL Server on Azure VMs, you can install the Session Recording database by double‑clicking and
running the SessionRecordingAdministrationx64.msi package or by using the Citrix Virtual Apps and
Desktops installer.
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1. Check out an Azure SQL VM.
2. Configure the VMandadd it to thedomainwhere you install the SessionRecording components.
3. Use the VM’s FQDN as the instance name during the installation of the Session Recording data‑

base.
Note: If you are using SessionRecordingAdministrationx64.msi for the installation, clear theEn‑
able SQL Server authentication check box.

4. Follow the installation user interface to complete installing the Session Recording database.

Install the Session Recording database on Google Cloud SQL Server

Tip:

On Google Cloud SQL Server, installation of the Session Recording database can be done by
running a command similar to the following or by double‑clicking and running the Session‑
RecordingAdministrationx64.msi package. For a description of the command parameters, see
the preceding Automate installation section in this article.

1 msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="CloudSQL" DATABASENAME="CitrixSessionRecording
" LOGGINGDATABASENAME="CitrixSessionRecordingLogging"
AZURESQLSERVICESUPPORT="1" AZUREUSERNAME="CloudSQLAdminName"
AZUREPASSWORD="CloudSQLAdminPassword" /q /l*vx "c:\WithLogging.
log"

This section details the installation method by using SessionRecordingAdministrationx64.msi that
you can find on the Citrix Virtual Apps and Desktops ISO under \x64\Session Recording.

1. Create a SQL Server instance in Google Cloud.

a) Go to the Google Cloud console and open the SQL instances page.

b) Click CREATE INSTANCE. For example:

c) Choose SQL Server as your database engine.
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d) Fill in the Instance ID field and enter a password for the user. Keep a record of the pass‑
word. Select a SQL Server version for your instance. Do other configurations as needed.
For example:

e) Assign the instance a public IP address and set an authorized network that can connect to
the instance. In theNetwork field, enter the IP address of themachine where the Session
Recording server is installed. For example:
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f) Click CREATE INSTANCE and wait for a fewminutes.
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g) On the page of the newly created instance, find the public IP address and keep a record of
it.

h) Run SessionRecordingAdministrationx64.msi to install the Session Recording database.

On the following page during the installation, make the following configurations:
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• Select the Enable SQL Server authentication check box.
• In the Instancename field, enter the public IP address of the SQLServer instance that
you created earlier.

• Fill in the SQL Server administrator name and password.

Uninstall Session Recording

To remove the Session Recording components from a server or workstation, use the uninstall
or remove programs option available from the Windows Control Panel. To remove the Session
Recording database, youmust have the same securityadmin and dbcreator SQL Server role permis‑
sions as when you installed it.

For security reasons, the administrator logging database is not removed after the components are
uninstalled.

Integrate with Citrix Analytics for Security™

You can configure Session Recording servers to send user events to Citrix Analytics for Security, which
processes the user events to provide actionable insights into user behaviors.

Prerequisites

Before you begin, ensure the following:

• The Session Recording server must be able to connect to the following addresses:

• https://*.cloud.com

• https://*.citrixdata.com

• https://api.analytics.cloud.com
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• TheSessionRecordingdeploymentmusthaveport 443open foroutbound internet connections.
Any proxy servers on the networkmust allow this communication with Citrix Analytics for Secu‑
rity.

• If you are using Citrix Virtual Apps and Desktops 7 1912 LTSR, the supported Session Recording
version is 2103 or later.

Connect your Session Recording server to Citrix Analytics for Security

1. Sign in to Citrix Cloud.

2. Find Citrix Analytics for Security and clickManage.

3. From the top bar, click Settings > Data Sources.

4. On the Virtual Apps and Desktops‑ Session Recording site card, click Connect Session
Recording server.

5. On theConnectSessionRecordingServerpage, review the checklist, and select all themanda‑
tory requirements. If you do not select a mandatory requirement, the Download File option is
disabled.
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6. If you have proxy servers in your network, enter the proxy address in the SsRecStorageMan‑
ager.exe.config file in your Session Recording server.

You can find the configuration file at <SessionRecordingserverinstallationpath
>\bin\SsRecStorageManager.exe.config

For example: C:\Program Files\Citrix\SessionRecording\Server\Bin\
SsRecStorageManager.exe.config

7. Click Download File to download the SessionRecordingConfigurationFile.json file.

Note:

The file contains sensitive information. Keep the file in a safe and secure location.

8. Copy the file to the Session Recording server that you want to connect to Citrix Analytics for
Security.

9. If you have multiple Session Recording servers in your deployment, you must copy the file in
each server that you want to connect and follow the steps to configure each server.
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10. On the Session Recording server, run the following command to import the settings:

1 <SessionRecordingserverinstallationpath>\bin\SsRecUtils.exe -
Import_SRCasConfigurations <configuration file path>

For example:

1 C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils.exe
-Import_SRCasConfigurations C:\Users\administrator\Downloads\
SessionRecordingConfigurationFile.json

11. Restart the following services:

• Citrix Session Recording Analytics Service

• Citrix Session Recording Storage Manager

12. After configuration is successful, go toCitrix Analytics for Security to view the connectedSession
Recording server. ClickTurnOnDataProcessing toallowCitrix Analytics forSecurity toprocess
the data.

Note:

If you are using Session Recording server version 2103 or 2104, youmust first launch a Vir‑
tual Apps and Desktops session to view the connected Session Recording server on Citrix
Analytics for Security. Otherwise the connected Session Recording server fails to get dis‑
played. This requirement is not applicable for Session Recording server version 2106 and
later.

View the connected deployments

The server deployments appear on the Session Recording site card only if the configuration is suc‑
cessful. The site card shows the number of configured servers that have established connectionswith
Citrix Analytics for Security.

If you don’t see your Session Recording servers even after the configuration was successful, refer to
the troubleshooting section at Configured Session Recording server fails to connect.
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On the site card, click thenumber of deployments to view the connected server groupswithCitrix Ana‑
lytics for Security. For example, click 1 Session RecordingDeployment to view the connected server
or server groups. Each Session Recording server is represented by a baseURL and a ServerGroupID.

View received events

The site card displays the connected Session Recording deployments and the events received from
these deployments for the last one hour, which is the default time selection. You can also select 1
week (1 W) and view the data. Click the number of received events to view the events on the self‑
service search page.

After you have enabled data processing, the site cardmight display theNo data received status. This
status appears for two reasons:

1. If you have turned on data processing for the first time, the events take some time to reach the
event hub in Citrix Analytics. When Citrix Analytics receives the events, the status changes to
Data processing on. If the status does not change after some time, refresh the Data Sources
page.

2. Citrix Analytics has not received any events from the data source in the last one hour.

Add Session Recording servers

To add a Session Recording server, do one of the following:

• On theConnectedSessionRecordingDeploymentspage, clickConnect toSession recording
server.
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• On the Virtual Apps and Desktops‑ Session Recording site card, click the vertical ellipsis (�)
and then select Connect Session Recording server.

Follow the steps to download the configuration file and configure a Session Recording server.

Remove Session Recording servers

To remove a Session Recording server:

1. On Citrix Analytics for Security, go to the Connected Session Recording Deployments page
and select the server deployment that you want to remove.

2. Click the vertical ellipses (�) and select Remove Session Recording server from Analytics.
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3. On the Session Recording server that you have removed fromCitrix Analytics, run the following
command:

1 <SessionRecordingserverinstallationpath>\bin\SsRecUtils.exe -
Remove_SRCasConfigurations

For example:

1 C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils.exe
-Remove_SRCasConfigurations

Turn on or off data processing on the data source

You can stop the data processing at any time for a particular data source‑ Director andWorkspace app.
On the data source site card, click the vertical ellipsis (�) and then select Turn off data processing.
Citrix Analytics stops processing data for that data source. You can also stop the data processing from
the Virtual Apps and Desktops site card. This option applies to both data sources‑ Director and Work‑
space app.
To enable data processing again, click Turn On Data Processing.

Configured Session Recording server fails to connect

Your Session Recording server fails to connect to Citrix Analytics after configuration. Therefore, you
don’t see the configured server on the Session Recording site card.

To troubleshoot this issue, do the following:

1. On your configured Session Recording server, run the following PowerShell command to check
the Client Machine Identification (CMID):

1 Get-WmiObject -class SoftwareLicensingService | select
Clientmachineid

2. If CMID is empty, add the following registry files in the specified paths:
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Registry name Registry path Key type Value

AuditorUniqueID Computer\
HKEY_LOCAL_MACHINE
\SOFTWARE\
Citrix\
SmartAuditor\
Server\

String Enter your UUID.

EnableCASUseAuditorUniqueIDComputer/
HKEY_LOCAL_MACHINE
/SOFTWARE/
Citrix/
SmartAuditor/
Server/

REG_DWORD 1

3. Restart the following services:

• Citrix Session Recording Analytics Service

• Citrix Session Recording Storage Manager

Session recording for endpoint devices (preview)

April 28, 2026

In addition to recording activities within virtual app and desktop sessions (VDI), Citrix Session Record‑
ing also captures user actions on endpoint devices accessing Citrix‑delivered web apps, virtual apps
and desktops.

Citrix session recording forwebapps reliesonwebappsbeingdelivered throughaCitrix infrastructure.
The following are the fundamental on‑premises Citrix components required for delivering web apps
and using session recording for endpoint devices, ensuring that end users can see and launch the
configured web apps successfully through Citrix Workspace™ app through NetScaler® Gateway.

• CitrixWorkspaceapp forWindows: Touse session recording for endpoint devices, ensure that
Citrix Workspace app for Windows is installed, version 2503 or later.

• Secure Private Access: Secure Private Access enables secure delivery of web apps. Installing
this component is a foundational step for making web apps available for recording.

• StoreFront™: The application store that users access to launch their web and SaaS apps.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 112



Session Recording 2603

• NetScaler (ADC/Gateway): This component provides secure remote access, load balancing,
and traffic management for StoreFront and the web apps.

Note:

Use NetScaler firmware version 14.1 or later to use session recording for endpoint devices.

• StoreFront and NetScaler (ADC/Gateway) integration: The integration is key for session
recording for endpoint devices to capture remote web app sessions. If the integration is
misconfigured or not set up, users can’t launch web apps remotely, leaving no session to
record. Refer to the following documentation for integration:

• Integrate NetScaler Gatewaywith StoreFront (gateway side): Integrate NetScaler Gateway
with StoreFront

• Configure Citrix Gateways (StoreFront side): Configure Citrix Gateways

Note:

This step can be skipped if you are using Citrix CloudWorkspace (cloud‑hosted Store‑
Front).

The procedure for configuring the session recording for endpoint devices feature involves the follow‑
ing steps.

Step 1: Configure settings in Site Setting

1. Open the Session Recording Web Console and navigate to Site Settings, enter the following de‑
tails

• Session Recording server address: e.g., SRServer.domain.com

• STA server address: e.g., https://sta.domain.com

• Gateway URL: e.g., https://gateway.domain.com

• StoreFront server address: e.g., https://storefront.domain.com/citrix/store

2. Test connection for STA/Gateway/Storefront input.

3. Apply changes.
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Step 2: Integrate the Session Recording server with StoreFront

Note:

This step can be skipped if you are using Citrix Cloud Workspace (cloud‑hosted StoreFront).

Perform the following steps to configure StoreFront manually.

1. Download the script from the Session Recording Web Console (Configuration> Site Settings‑>
Endpoint recording‑> StoreFront areas.

2. Click the download icon corresponding to the StoreFront entry for which the configuration
changesmust bemade. The downloaded zip file contains a configuration script, a README file,
and a configuration cleanup script. The cleanup script can be used in case integration between
StoreFront and Session Recording Server is to be removed.

The download button will be enabled when the Session Recording Server address and Store‑
front address are both not empty.

3. Run the script as an admin on a PowerShell 64‑bit instance by using the command. / Configure‑
Storefront.ps1.

• No other parameters are required.

• The PowerShell script execution policy must be set to Unrestricted or Bypass to run the
StoreFront script.

• The script also propagates the configuration to other StoreFront servers if StoreFront is
configured as a cluster.
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Step 3: Integrate the Session Recording server with Secure Ticket Authority

Note:

This step can be skipped if using On‑prem StoreFront.

1. STA is an XML web service that exchanges XenApp® server information for randomly generated
tickets. It is used to control access for a Citrix Secure Gateway server.

2. Use your Citrix account credentials to access the Citrix Virtual Apps and Desktops™ download
page and download the product ISO file. Unzip the ISO file or burn a DVD of it.

3. Use a local administrator account to log on to the machine in your trusted network and that
is accessible by the Session Recording Server. Insert the DVD in the drive or mount the ISO
file. The installer can be found in x64/Citrix Desktop Delivery Controller/
Sta_Service_x64.msi.

4. Install the secure ticket authority server. On a trusted machine, mount the CVAD product
ISO and install the STA service from x64/Citrix Desktop Delivery Controller/
Sta_Service_x64.msi.

5. Configure Secure Ticket Authority service.

a) This step ismandatory if sta service is installed in the samemachinewith session recording
server.

i. Update new ports for STA service: navigate to "C:\Program Files\Citrix\
StaService\Service"

ii. run.\StaService.exe -StoreFrontPort 8980 -StoreFrontTlsPort
8443

b) Update Certificate Binding for New HTTPS Port.
c) Restart Citrix Secure Ticketing Authority Service in Windows Services Management.

Step 4: Integrate the Session Recording server with NetScaler

1. On the Session Recording server, download the generated NetScaler configuration script from
the Session Recording Web Console Configuration> Site Settings‑> Endpoint recording‑> Gate‑
way areas.

2. Upload the script to the NetScaler appliance. You can use tools such asWinSCP or a scp com‑
mand similar to the following:

1 scp ns_gateway_sessionrecording.sh root@NetScaler:/var/tmp

(ReplaceNetScalerwith the actual host name or IP address.)

Ensure that the script is savedwith LF (Line Feed) line endings. FreeBSD (which NetScaler OS is
based on) does not support CRLF (Carriage Return Line Feed) line endings. If you encounter the
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error ‑bash: /var/tmp/ns_gateway_sessionrecording.sh: /bin/sh^M: bad interpreter: No
such file or directory, it indicates incorrect line endings. Convert the script using a text editor
such as Notepad++ and ensure that it’s saved with LF line endings.

3. Connect to the NetScaler appliance through SSH and switch to the NetScaler shell by typing
shell in the NetScaler CLI.

4. Make the uploaded script executable using the chmod command:

1 Chmod +x /var/tmp/ns_gateway_sessionrecording.sh

5. Run the uploaded script in the NetScaler shell.

6. Provide the required parameters. The script prompts you for the following:

• The name of the virtual server in NetScaler Gateway, which can be found in the NetScaler
console.

• TheFullyQualifiedDomainName (FQDN)of theSessionRecording server (or loadbalancer
if applicable).

• The script generates a new file, /var/tmp/ns_gateway_sessionrecording, containing
multiple NetScaler commands. You can review the input parameters using the cat
/var/tmp/ns_gateway_sessionrecording command.

7. Return to the NetScaler CLI and run the generated commands using a batch command similar
to the following:
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1 batch -fileName /var/tmp/ns_gateway_sessionrecording -outfile /var
/tmp/ns_gateway_sessionrecording_output

NetScaler executes the commands sequentially. If a command fails, it proceeds to the next.

8. Ensure that all commands were successfully completed.

9. [Optional] Add Secure Ticket Authority(STA) server address in NetScaler. Formore information,
see Configure NetScaler Gateway to handle the STA and ICA traffic

Note:

If you are using Citrix Workspace app for Windows version 2503, ensure that ICA® Proxy
mode is set to OFF on the Citrix NetScaler Gateway to enable endpoint recording function‑
ality.

For detailed configuration steps, refer to the NetScaler command reference guide.

Step 5: Configure endpoint recording policies

System‑defined endpoint recording policy

Session Recording provides a system‑defined endpoint recording policy:

• Donot record endpoint sessions. The default policy. When it’s active, Session Recording does
not capture user actions on endpoint devices accessing Citrix‑delivered web apps.

You can’t modify or delete the system‑defined endpoint recording policy.

Create a custom endpoint recording policy

You can enable endpoint recording for specific users or groups. Awizardwithin the Session Recording
policy console helps you create rules. For each rule you create, you specify a recording action and rule
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criteria. The recording action applies to sessions that meet the rule criteria.

For each rule, choose one recording action:

• Enable endpoint recording with notification. This option records user actions on endpoint
devices accessing Citrix‑delivered web apps. Users receive recording notifications in advance.

• Enable endpoint recording without notification. This option records user actions on end‑
point devices accessing Citrix‑delivered web apps. Users do not receive recording notifications.

• Disable endpoint recording. This option means that no user actions on endpoint devices are
recorded.

• Citrix Delivered Web Apps. This option lets you specify particular Citrix‑delivered web apps
for recording user actions on endpoint devices accessing these apps.

• Citrix Delivered Virtual Apps and Desktops. This option lets you specify particular Citrix‑
delivered virtual apps and desktops for recording user actions on endpoint devices accessing
these apps.

• Extend to full‑screen recording. This option lets you record the entire screen space, includ‑
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ing any extended displays, of the endpoint devices accessing the specified Citrix‑delivered web
apps.

For each rule, create a list of users or groups to which the action of the rule applies:

When you create more than one rule in an endpoint recording policy, some sessions might match
the criteria for more than one rule. In these cases, the rule with the highest priority is applied to the
sessions.

The recording action of a rule determines its priority:

• Rules with the Disable endpoint recording action have the highest priority.
• Rules with the Enable endpoint recording with notification action have the second‑to‑
highest priority.

• Rules with the Enable endpoint recording without notification action have the lowest prior‑
ity.

Some sessions might not meet any rule criteria in an endpoint recording policy. For these sessions,
theactionof thepolicy fallback ruleapplies. Theactionof the fallback rule is alwaysDisableendpoint
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recording. You can’t modify or delete the fallback rule.

Step 6: Install the Citrix session recording for endpoint devices agent

To enable session recording for endpoint devices, install the session recording agent for endpoint
devices on each client where you install the Citrix Workspace app. To install the session recording
agent for endpoint devices, follow these steps:

1. Ensure that Citrix Workspace app for Windows is installed, version 2503 or later.

2. Install the session recording agent for endpoint devices using either the GUI or the command
prompt.

3. Exit Citrix Workspace app for Windows from the system tray, and then reopen it.

Note:

• Temporarily disable any anti‑screen capture features when installing the session recording
agent for endpoint devices.

• If using Citrix Workspace app authentication and the self‑service plug‑in:

• Either disable the anti‑screen capture feature entirely (see Configure Anti‑keylogging
and Anti‑screen capture for authentication and self‑service plug‑in).

• Or add the session recording agent for endpoint devices executable (SRGraphicsEn‑
gine.exe) to the screen capture allow list (see Configure Screen Capture Allow List).

• ForwebandSaaSapps, seeConfigure Anti‑keylogging andAnti‑screen capture forWeband
SaaS apps for specific anti‑keylogging and anti‑screen capture configurations.
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• For virtual apps and desktops, see Configure Anti‑keylogging and Anti‑screen capture for
anti‑screen capture configurations.

Dynamic session recording

December 26, 2025

Previously, session recording started strictly at the very beginning of sessions that met the recording
policies and stopped strictly when those sessions ended.

Starting with the 7.18 release, Citrix introduces the dynamic session recording feature. With this fea‑
ture, you can start or stop recording a specific session or sessions that a specific user launches, at any
time during the sessions.

Note:

Tomake the feature work as expected, upgrade Session Recording, VDA, and Delivery Controller
to Version 7.18 or later.

Enable or disable dynamic session recording

On the Session Recording agent, a registry value is added for enabling or disabling the feature. The
registry value is set to 1 by default, which means that the feature is enabled by default.

To enable or disable the feature, complete the following steps:

1. After the Session Recording installation is complete, log on as an administrator to the machine
where you installed the Session Recording agent.

2. Open the Registry Editor.
3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor.
4. Set the value of DynamicControlAllowed to 0 or use the default value, 1.

1: enable dynamic recording
0: disable dynamic recording

5. Restart the Session Recording agent to make your setting take effect.
If you are using MCS or PVS for deployment, change the setting on your master image and per‑
form an update to make your change take effect.

Warning:

Incorrectly editing the registry can cause serious problems that might require you to reinstall
your operating system. Citrix® cannot guarantee that problems resulting from the incorrect use
of the Registry Editor can be solved. Use the Registry Editor at your own risk. Be sure to back up
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the registry before you edit it.

Dynamically start or stop recording by using PowerShell commands in the Citrix SDKs

Youcanuse thedynamic session recording feature inbothon‑premisesandCitrixCloudenvironments.
To use the feature in an on‑premises environment, use the Citrix Virtual Apps and Desktops™ Power‑
Shell SDK. To use the feature in a Citrix Cloud environment, use the Citrix DaaS Remote PowerShell
SDK (formerly Citrix Virtual Apps and Desktops Remote PowerShell SDK).

To determine which SDK to install and use, be aware of the Delivery Controller™ that you specified
when creating your recording policy. If you select the Citrix Cloud Controller check box to record
sessions in a Citrix Cloud environment, youmust validate your Citrix Cloud credentials.

Note:

Donot install theCitrixDaaSRemotePowerShell SDKonaCitrix CloudConnector™machine. You
can install the Remote PowerShell SDKon any domain‑joinedmachinewithin the same resource
location. We recommend that you do not run this SDK’s cmdlets on Cloud Connectors. The SDK’
s operation does not involve the Cloud Connectors.

The following table lists three PowerShell commands that both Citrix SDKs provide for dynamic ses‑
sion recording.
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Command Description

Start‑BrokerSessionRecording Lets you start recording a specific active session,
a list of active sessions, or sessions launched by
a specific user. If a specific session is originally
set up for an event‑only recording according to
policy settings, using this command allows you
to start capturing the screen in addition to the
target events. For more information, run Get-
Help Start-BrokerSessionRecording
to see the command online help.

Stop‑BrokerSessionRecording Lets you stop recording a specific active session,
a list of active sessions, or sessions launched by
a specific user. For more information, run Get-
Help Stop-BrokerSessionRecording
to see the command online help.

Get‑BrokerSessionRecordingStatus Lets you get the recording status of a specific
active session. For more information, run
Get-Help Get-
BrokerSessionRecordingStatus to see
the command online help.

For example, when a user reports an issue and needs timely support, you can use the feature to dy‑
namically start recording the user’s active sessions. You can play the live recording to proceed with
the follow‑up troubleshooting. You can do the following:

1. (For Citrix Virtual Apps™ and Desktops PowerShell SDK only) Launch PowerShell from the Citrix
Studio console.
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2. Use the Get-BrokerSession command to get all the active sessions of the target user.

3. Use the Get-BrokerSessionRecordingStatus command to get the recording status of
the specified session.

Note:

The ‑Session parameter can accept only one session UID at a time.

4. Use the Start-BrokerSessionRecording command to start recording. By default, a no‑
tification message appears to inform users of the recording activity.

The following table shows commonways of using the Start-BrokerSessionRecording
command.

Command Description

Start-BrokerSessionRecording -
User DomainA \ UserA

Starts recording all sessions of user UserA in the
domain named DomainA and notifies UserA.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 124



Session Recording 2603

Command Description

Start-BrokerSessionRecording -
User DomainA \ UserA -NotifyUser
$false

Starts recording all sessions of user UserA in the
domain named DomainA and does not notify
UserA.

Start-BrokerSessionRecording -
Sessions $SessionObject

Starts recording all sessions in the object named
$SessionObject and notifies the user. To get the
object $SessionObject, run
$SessionObject=Get-BrokerSession
–username UserA. The name of an object is
prefixed with a dollar sign $. For more
information, see Step 2 and the command online
help.

Start-BrokerSessionRecording -
Sessions uid1,uid2,…,uidn

Starts recording the sessions UID1, UID2,…,
and UIDn, and notifies the users.

5. Use the Get-BrokerSessionRecordingStatus command to get the recording status of
each target session. The status is supposed to be SessionBeingRecorded.

6. Play back the recordings and proceed with the follow‑up troubleshooting.

Note�

When you play a Complete recording by Session Recording Player ended by the Stop-
BrokerSessionRecording command, the last section of the timeline on the player
progress barmight show gray. And, the last section of the recorded session is idle. It is not
obvious when the recorded session has constant activities.

7. Use the Stop-BrokerSessionRecording command to stop recording when the reported
issue has been triaged or resolved.

The following table shows common ways of using this command:

Command Description

Stop-BrokerSessionRecording -User
DomainA \ UserA

Stops recording all sessions of user UserA in the
domain named DomainA.

Stop-BrokerSessionRecording -
Sessions $SessionObject

Stops recording all sessions in the
$SessionObject.
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Command Description

Stop-BrokerSessionRecording -
Sessions uid1,uid2,…,uidn

Stops recording the sessions UID1, UID2,…,
and UIDn.

On theCitrixStudioLogging screen, youcanviewthe resulting logsof theStart-BrokerSessionRecording
and Stop-BrokerSessionRecording commands.

End‑user triggered session recording

April 1, 2026

Previously, session recording started strictly basedon the recordingpolicies configuredbyadministra‑
tors. Starting with the current release, Session Recording introduces the end‑user triggered session
recording feature. With this feature, end users can start or stop recording their own sessions at any
time, providing greater flexibility for on‑demand recording needs.

Enable end‑user triggered recording

By default, end‑user triggered recording is disabled. To enable this feature, you must configure a
recording policy in the Session Recording Policy Console. For more information about how to con‑
figure the customized policy, see Create a custom recording policy.
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Start or stop recording by using Citrix Virtual Desktop Assistant

TheCitrix Virtual DesktopAssistant, installed by default in CVAD, provides a built‑in SessionRecording
page that enables users to manually record their active virtual desktop sessions.
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Start recording

Starts capturing the current session. A recording indicator is displayed to confirm that recording is in
progress.

Stop recording

Stops the recording and automatically saves the recorded session to the Session Recording server.
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Start or stop recording by using PowerShell commands

End users can trigger recording through PowerShell commands after importing the required
model.

Import the Session Recording Module

Before running the recording commands, youmust import the necessarymodule into the PowerShell
session.
Open PowerShell and Import the module by running:

Import-Module -DisableNameChecking 'C:\ProgramFiles\Citrix\SessionRecording
\Agent\Bin\EndUserInitiatedSRSnapin.dll'

Available Commands

The following table lists three PowerShell commands that provide for end user triggered session
recording.
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Command Description

Start‑SessionRecording Starts recording the active session in which the
command is executed. To record a specific active
session, use the -SessionId <ID>
parameter (requires local administrator
privileges). For more information, run
Get-Help Start-SessionRecording to
see the command online help.

Stop‑SessionRecording Stops recording the active session in which the
command is executed. To stop recording a
specific active session, use the
-SessionId <ID> parameter (requires local
administrator privileges). Note: Users can only
stop recordings they initiated. They cannot stop
recordings triggered by dynamic or policy‑based
recording. For more information, run
Get-Help Stop-SessionRecording to
see the command online help.

Get‑SessionRecordingStatus Retrieves the recording status of the active
session in which the command is executed. To
get the status of a specific active session, use the
-SessionId <ID> parameter. For more
information, run
Get-Help Get-SessionRecording Status
to see the command online help.

Scenario 1: End‑user triggered recording End users can trigger recordings for their current active
session to capture operations dynamically (for example, for troubleshooting purposes).

The user can perform the following steps inside the session:

1. Launch PowerShell from the session desktop.
2. Import the module as described in the previous section.
3. Use the Get-SessionRecordingStatus command to check the recording status, ensure

the session is not already being recorded.
4. Use the Start-SessionRecording command to start recording the session.
5. Use the Get-SessionRecordingStatus command to check the recording status, ensure

the session is being recorded. The status is supposed to be Recording.
6. Reproduce the issue or perform the operations that need to be documented.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 130



Session Recording 2603

7. Use the Stop-SessionRecording command to stop recording once the operations are
complete.

8. Inform the administrator to playback the Live or Complete recordings and proceed with the
follow‑up troubleshooting.

Scenario 2: Administrator‑triggered recording Administrators can trigger recordings for specific
active sessions on the machine (for example, to assist a user with troubleshooting).

The administrator can perform the following steps on the machine hosting the session:

1. Launch PowerShell as an administrator.
2. Import the module as described in the previous section.
3. Get the SessionID of the target user session by using : query session | find “Active”.
4. Use the Get-SessionRecordingStatus -SessionId <SessionID> command to

check the recording status, ensure the session is not already recorded.
5. Use the Start-SessionRecording -SessionId <SessionID> command to start

recording the session.
6. Use the Get-SessionRecordingStatus -SessionId <SessionID> command to

check the recording status, ensure the session is being recorded. The status is supposed to be
Recording.

7. Instruct the user to reproduce the issue or perform the operations that need to be documented.
8. Use theStop-SessionRecording -SessionId <SessionID> to stop recording once

the operations are complete.
9. Playback the Live or Complete recordings and proceed with the follow‑up troubleshooting.

Start or stop recording by using Hotkeys

End users can also control recording using shortcut keys (Hotkeys). By default, this feature is dis‑
abled.

Enable Hotkeys

To enable the hotkey functionality, add aDWORD value named EnableHotKeys under the registry
path: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\EndUserRecording
Set the value to 1 on the VDAmachine.
This setting is applied permachine and will take effect for all subsequent active sessions.

Default Hotkeys

Once enabled, the default hotkeys are:
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• Start recording: CTRL + SHIFT + F8
• Stop recording: CTRL + SHIFT + F9

Customize Hotkeys

If the default hotkeys conflict with other applications, add or modify the following REG_SZ values
under:

HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\EndUserRecording

• StartHotkey –specify the new hotkey for starting to record
• StopHotkey –specify the new hotkey for stopping to record

Hotkey rules

• Only F1–F12 or capital letters (A–Z) can be used as the last key.
• You only define the last key in the combination. The CTRL + SHIFT prefix is mandatory and
automatically applied.

Example: To set the start hotkey to CTRL + SHIFT + F5, set the value of StartHotkey to F5.

Configure

September 7, 2025

This section provides instructions for you to configure the following settings:
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• Settings on the Session Recording agent

• Enable or disable recording
• Configure the connection to the Session Recording Server
• Configure the communication protocol

• Settings on the Session Recording server

• Authorize users
• Customize recording notification messages
• Specify where recordings are stored
• Specify file size for recordings
• Enable or disable digital signing
• CEIP and Google Analytics

• Policies

• Configure session recording policies
• Configure recording viewing policies
• Configure event detection policies
• Configure event response policies

• High availability and load balancing

• Load balance Session Recording servers
• Configure database high availability

Configure settings on the Session Recording agent

June 21, 2024

This section guides you through the following settings:

• Enable or disable recording
• Configure the connection to the Session Recording Server
• Configure the communication protocol

Enable or disable recording

October 24, 2024
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You can install the Session Recording agent on both multi‑session OS and single‑session OS VDAs for
recording sessions hosted on those VDAs. Within each agent is a setting that enables recording for
the VDA on which it is installed. After recording is enabled, Session Recording evaluates the active
recording policy that determines which sessions are recorded.

We recommend you disable session recording on VDAs that are not recorded. There is a small impact
on performance, even if no recording takes place.

Enable or disable recording on a VDA

1. Log on to the server where the Session Recording agent is installed.

2. From the Startmenu, choose Session Recording Agent Properties.

3. Under Session Recording, select or clear the Enable session recording for this VDAmachine
check box to specify whether sessions can be recorded for this VDA.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 134



Session Recording 2603

4. When prompted, restart the Session Recording agent service to accept the change.

Note:

When you install Session Recording, the active policy is
Do not record (no sessions are recorded on any server). To begin recording, use the
Session Recording policy console to activate a different policy.
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Enable custom event recording

Session Recording allows you to use third‑party applications to insert custom data, known as events,
to recorded sessions. These events appear when the recorded session is played back. Events are part
of the recorded session file and can’t be modified after the session is recorded.

For example, an event might contain the following text: “User opened a browser.”Each time a user
opens a browser during a session being recorded, the text inserts to the recording at that point. When
a viewer plays back the recorded session, the viewer can locate and count the times that the user
opened a browser by noting the number of markers.

To insert custom events to recordings on a server:

• Use Session Recording Agent Properties to enable a setting on each server where you want
to insert custom events. Enable each server separately. You can’t globally enable all servers in
a site.

• Write applications built on the Event API that runs within each user’s virtual session, to inject
the data into the recording.

The Session Recording installation includes an event recording COM application (API) that allows you
to insert text from third‑party applications to a recording. You can use the API from many program‑
ming languages including Visual Basic, C++, or C#. For more information, see the Knowledge Center
article CTX226844. The Session Recording Event API .dll is installed as part of the Session Recording
installation. You can find it atC:\rogram Files\Citrix\SessionRecording\Agent\Bin
\Interop.UserApi.dll.

To enable custom event recording on a server, complete the following steps:

1. Log on to the server where the Session Recording agent is installed.
2. From the Startmenu, choose Session Recording Agent Properties.
3. In Session Recording Agent Properties, click the Recording tab.
4. Under Custom event recording, select the Allow third party applications to record custom

data on this server check box.

Enable compressed recording

You can enable compressed recording for parts of Thinwire‑transmitted session screens that are not
H.264 compressed. This feature reduces recording file size significantly.

Note:

• This feature is disabled by default.
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• This feature is incompatible with the H.264 package dropping feature.
• The minimum version required for the VDA is 2303.

To enable compressed recording, complete the following steps:

1. Log on to the server where the Session Recording agent is installed.

2. From the Startmenu, choose Session Recording Agent Properties.

3. In Session Recording Agent Properties, click the Recording tab.

4. Under Compressed recording, select the Enable compressed recording for Thinwire‑
transmitted session screens on this VDAmachine check box.
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Enable or disable lossy screen recording

July 31, 2024

Lossy screen recording lets you adjust compression options to reduce the size of recording files and
to accelerate navigating recorded sessions during playback. Lossy screen recording is suitable for use
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when:

• the size of recording files per time unit is too large, or
• there is a lag while you fast forward or rewind during recording playback.

You can now enable lossy screen recording in any of the following ways:

• Activate a system‑defined session recording policy that has lossy screen recording enabled.

• Create and activate a custom session recording policy, and make sure to select Enable lossy
screen recordingwhen creating the custom policy.

• SelectEnable lossy screen recordingwhenconfiguring anevent responsepolicy. Whenamon‑
itored event is detected later, lossy screen recording is triggered.

For more information, see Configure session recording policies and Configure event response poli‑
cies.

When the active session recording or event response policy doesn’t have lossy screen recording en‑
abled, compression options are unavailable.
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When the active session recording or event response policy has lossy screen recording enabled, com‑
pression options are available on the Lossy Screen tab of Session Recording Agent Properties.

You can adjust the compression options to your needs. We recommend you use the default values
unless there is a practical need to change the values.

For a description of compression options, see the following table:

Compression option Description Default value Remarks

Video fluency (FPS) Low: 1;Medium: 5;
High: 10

Low N/A
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Compression option Description Default value Remarks

Video image quality Low: bitrate:140
(kbps);Medium:
bitrate:280 (
kbps);High:
bitrate:420 (kbps)

Low Session Recording
uses Average Bitrate
(ABR) for video bitrate
encoding. Higher
values mean less
compression. You can
also set a custom
value between 40 kbps
and 80,000 kbps by
editing the Registry at
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent\SRGraphicsX264Bitrate.

I‑Frame interval
(seconds)

60, 120, 300, 600,
1200, 1800, 3600

600 The larger the I‑Frame
interval value, the
smaller the storage
space occupied by the
compressed video.
The smaller the
I‑Frame interval value,
the better the seeking
experience (fast
forward and rewind).

Image resolution
scaling

1.0, 0.9, 0.8, 0.7, 0.6,
0.5, 0.4

1 You can downscale the
resolution of recorded
screens to a
percentage, for
example, 0.9means
90%. If you don’t want
to change the
resolution, use the
default value 1.0. You
can also set the image
resolution scaling by
editing the Registry at
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent\SRGraphicsZoomFactor.

Cursor refresh rate
(times per second)

Low: 3;Medium: 5;
High: 10

Low N/A
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Enable fast seeking

September 7, 2025

Fast seeking allows to accelerate navigating ICA® screen recordings during playback. It significantly
improves the playback seeking experience.

Note:

Fast seeking is valid only for the sessions that are recorded after the feature is enabled inSession
Recording Agent Properties.

Enable fast seeking

To enable fast seeking, complete the following steps:

1. Open the Player tab of Session Recording Agent Properties.

2. Select Enable fast seeking and configure how often an I‑Frame is generated.

You can select a system‑defined I‑Frame interval or configure a custom I‑Frame (in seconds,
ranging from 10 to 1,800 seconds). By default, the system‑defined I‑Frame interval Medium
(60 seconds) is selected.

For a description of the system‑defined I‑Frame intervals, see the following table:

System‑defined I‑Frame interval Description

Low 300 seconds

Medium 60 seconds

High 30 seconds
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3. (Optional) If you alsowant to enable fast seeking for the SessionRecordingwebplayer, navigate
to Configuration > Preferences on the web player page and ensure that Enable fast seeking
is selected.
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Configure the connection to the Session Recording server

September 7, 2025

Configure the connection of the Session Recording player to the Session Recording
server

Before a Session Recording player can play sessions, configure it to connect to the Session Recording
server that stores the recorded sessions. Each player can be configured with the ability to connect to
multiple Session Recording servers, but can connect to only one Session Recording server at a time.
If a player is configured with the ability to connect to multiple Session Recording servers, users can
change which Session Recording server the player connects to.

1. Log on to the workstation where the Session Recording player is installed.
2. Start the Session Recording player.
3. From the Session Recording player menu bar, choose Tools > Options.
4. On the Connections tab, click Add.
5. In theHostname field, type the name or IP address of themachine hosting the Session Record‑

ing server and select theprotocol. Bydefault, SessionRecording is configured touseHTTPS/SSL
to secure communications. If SSL is not configured, select HTTP.

6. Toconfigure theSessionRecordingplayerwith theability to connect tomultipleSessionRecord‑
ing servers, repeat Steps 4 and 5 for each Session Recording server.

7. Ensure that you select the check box of the Session Recording server you want to connect to.
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Configure the connection of the Session Recording agent to the Session Recording
server

The connection is typically configured when the Session Recording agent is installed. To configure
this connection after the Session Recording agent is installed, use Session Recording Agent Proper‑
ties.

1. Log on to the server where the Session Recording agent is installed.

2. From the Startmenu, choose Session Recording Agent Properties.

3. Click the Connections tab.

4. In the Session Recording Server field, type the FQDN of the Session Recording server.

Note:

To useMessageQueuing over HTTPS (TCP is used by default), type an FQDN in the Session
Recording Server field. Otherwise, session recording fails.

5. In the Session Recording Storage Manager message queue section, select the protocol that
is used by the Session Recording StorageManager to communicate and change the default port
number if necessary.

Note:

To use Message Queuing over HTTP and HTTPS, install all the IIS recommended features.

6. In theMessage life field, accept the default 7,200 seconds (two hours) or type a new value for
thenumberof secondseachmessage is retained in thequeue if there is a communication failure.
After this time elapses, the message is deleted and the file is playable until the point where the
data is lost.

7. In the Session Recording Broker section, select the communication protocol that the Session
Recording Broker uses to communicate and change the default port number if necessary.

8. When prompted, restart the Session Recording agent service to accept the changes.

Change your communication protocol

April 1, 2026

For security reasons, Citrix® does not recommend using HTTP as a communication protocol. The
Session Recording installation is configured to use HTTPS. To use HTTP instead of HTTPS, you must
change several settings.
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Use HTTP as the communication protocol

1. Log on to themachine hosting the Session Recording server. In IIS, navigate to DefaultWeb Site,
open each application, go to SSL Settings, and uncheck Require SSL.

2. Change the protocol setting from HTTPS to HTTP in Session Recording Agent Properties on
each server where the Session Recording agent is installed:

a) Log on to each server where the Session Recording agent is installed.
b) From the Startmenu, choose Session Recording Agent Properties.
c) In Session Recording Agent Properties, choose the Connections tab.
d) In the Session Recording Broker area, selectHTTP from theProtocol drop‑down list and

clickOK to accept the change. If you are prompted to restart the service, click Yes.

3. Change the protocol setting from HTTPS to HTTP in the Session Recording Player settings:

a) Log on to each workstation where the Session Recording Player is installed.
b) From the Startmenu, choose Session Recording Player.
c) From the Session Recording Player menu bar, choose Tools > Options > Connections,

select the server, and chooseModify.
d) Select HTTP from the Protocol drop‑down list and click OK twice to accept the change

and exit the dialog box.

4. Change the protocol setting from HTTPS to HTTP in the Session Recording policy console:

a) Log on to the server where the Session Recording policy console is installed.
b) From the Startmenu, choose Session Recording Policy Console.
c) SelectHTTP from theProtocoldrop‑down list andclickOK to connect. If the connection is

successful, this setting is remembered thenext time you start the SessionRecordingpolicy
console.
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Revert to HTTPS as the communication protocol

1. Log on to themachine hosting the Session Recording server and enable secure connections for
the Session Recording Broker in IIS.

2. Change the protocol setting from HTTP to HTTPS in Session Recording Agent Properties on
each server where the Session Recording agent is installed:

a) Log on to each server where the Session Recording agent is installed.
b) From the Startmenu, choose Session Recording Agent Properties.
c) In Session Recording Agent Properties, choose the Connections tab.
d) In the Session Recording Broker area, select HTTPS from the Protocol drop‑down list

and clickOK to accept the change. If you are prompted to restart the service, click Yes.

3. Change the protocol setting from HTTP to HTTPS in the Session Recording Player settings:

a) Log on to each workstation where the Session Recording Player is installed.
b) From the Startmenu, choose Session Recording Player.
c) From the Session Recording Player menu bar, choose Tools > Options > Connections,

select the server, and chooseModify.
d) Select HTTPS from the Protocol drop‑down list and click OK twice to accept the change

and exit the dialog box.

4. Change the protocol setting from HTTP to HTTPS in the Session Recording policy console:

a) Log on to the server where the Session Recording policy console is installed.
b) From the Startmenu, choose Session Recording Policy Console.
c) SelectHTTPS from theProtocoldrop‑down list and clickOK to connect. If the connection

is successful, this setting is remembered the next time you start the Session Recording
policy console.

Configure the dual message queue

September 22, 2025

Thedualmessagequeue feature allows theSessionRecordingServer to use a secondMSMQqueue for
processing data streams from VDAs. Enabling this feature can improve performance and scalability
onmulti‑core Session Recording Servers, especially in environments with high recording traffic.

Enable the dual message queue

By default, this feature is disabled. To enable the dual message queue, complete the following
steps:
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1. Log on to the VDA where the Session Recording Agent is installed.
2. Open the Registry Editor.
3. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent.
4. Create a DWORD value named MsmqDataQueueCount and set its value data to 2.
5. Restart the Citrix Session Recording Agent service to make your changes take effect.

Disable the dual message queue

To disable the feature, either set the MsmqDataQueueCount value data to 1 or delete the registry
value. A restart of theCitrix SessionRecordingAgent service is required for the change to take effect.

Note:

To use this feature, your Session Recording Server and Agent components must be version 2507
or later. Ensure you apply the registry change on all relevant VDAs for consistent performance
enhancement.

Configure settings on the Session Recording server

June 21, 2024

This section guides you through the following settings:

• Authorize users
• Customize recording notification messages
• Specify where recordings are stored
• Specify file size for recordings
• Enable or disable digital signing
• CEIP and Google Analytics

Authorize users

September 7, 2025

To grant users the rights, you assign users to roles using the Session Recording Authorization Console
on the Session Recording server. Five roles are available:
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Important:

For security reasons, grant users only the rights they need to perform specific functions, such as
viewing recorded sessions.

• PolicyAdministrator. Grants the right to view, create, edit, delete, and enable recording poli‑
cies. By default, administrators of the machine hosting the Session Recording server are mem‑
bers of this role.

• PolicyQuery. Allows the servers hosting the Session Recording agent to request recording pol‑
icy evaluations. By default, authenticated users are members of this role.

• LoggingWriter. Grants the right to write the Administrator Logging logs. By default, local ad‑
ministrators and the Network Service group are members of this role. Changing the default
LoggingWritermembership can cause log writing failure.

• LoggingReader. Grants the right to query the Administrator Logging logs. There is no default
membership in this role.

• PrivilegedPlayer. Grants the right to place and remove access restrictions on recordings and
the right to archive and delete recordings.

• Player. Grants the right to view recorded Citrix Virtual Apps and Desktops™ and Citrix DaaS
(formerly Citrix Virtual Apps and Desktops service) sessions. There is no default membership in
this role. When you install Session Recording, no user has the right to play recorded sessions.
A user without the permission to play recorded sessions receives the following error message
when trying to play a recorded session:

To assign users to a role, do the following:

1. Log on as an administrator to the machine hosting the Session Recording server.
2. Start the Session Recording Authorization Console.
3. Select the role to which you want to assign users.
4. From themenu bar, choose Action > Assign Users and Groups.
5. Add the users and groups.
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Session Recording supports users and groups defined in the Active Directory.

Any changes made to the console take effect during the update that occurs once every minute. Also,
starting with the 1906 release, you can use the Session Recording policy console to create recording
viewing policies. For more information, see Recording viewing policies.

CEIP and Google Analytics

June 21, 2024

When you participate in the Citrix Customer Experience Improvement Program (CEIP), anonymous
configuration and usage data is collected and sent to Citrix. The data helps improve the product qual‑
ity and performance. In addition, a copy of the anonymous data can be sent to Google Analytics for
fast and efficient analysis.

CEIP setting

By default, you automatically participate in CEIPwhen you install Session Recording. The first upload
of data occurs approximately seven days after you install Session Recording. To unsubscribe from
CEIP, do the following:

1. Log on to the machine hosting the Session Recording server.

2. From the Startmenu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the CEIP tab.

4. Clear the Participate in the Customer Experience Improvement Program check box.

5. Restart the Citrix Session Recording Analytics Service for the setting to take effect.
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Google Analytics setting

When Google Analytics is enabled, the heartbeat data between Google Analytics and the Session
Recording server is collected every 5 hours. User behavior data on the web player is also sent to
Google Analytics. User behavior includes activities such as opening the web player and playing or
searching recordings in it.

GoogleAnalytics is enabledbydefault, except forEUcustomers. If the timezoneor regionyouselected
when installing Session Recording belong to the EU, you are considered an EU customer and Google
Analytics is disabled for you by default.

Registry setting that enables or disables Google Analytics:

Location: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\

Name: CeipHeartBeatDisable

Value: 1 = disabled, 0 = enabled

To disable Google Analytics, complete the following steps:
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1. Log on to the machine hosting the Session Recording server.

2. Open the Registry Editor.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\.

4. Locate or add the registry value CeipHeartBeatDisable.

5. Set the value data of CeipHeartBeatDisable to 1.

6. Restart the Citrix Session Recording Analytics Service for the setting to take effect.

To enable Google Analytics, complete the following steps:

1. Log on to the machine hosting the Session Recording server.
2. Open the Registry Editor.
3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\.
4. Remove the registry value CeipHeartBeatDisable or set its value data to 0.
5. Restart the Citrix Session Recording Analytics Service to make for the setting to take effect.

Data collected from the Session Recording server

The following table gives an example of the types of anonymous information collected. The data does
not contain any details that identify you as a customer.

Data Point Key Name Description

Machine GUID machine_guid Identifying the machine where
the data originates. With
Google Analytics enabled,
heartbeat data is sent to
Google Analytics regardless of
whether CEIP is enabled.

Operating System version OS_version Text string denoting the
machine’s operating system.
With Google Analytics enabled,
heartbeat data is sent to
Google Analytics regardless of
whether CEIP is enabled.
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Data Point Key Name Description

Session Recording server
version

SRS_version Text string denoting the
installed version of the Session
Recording server. With Google
Analytics enabled, heartbeat
data is sent to Google Analytics
regardless of whether CEIP is
enabled.

Number of application
recordings

application-recording
-number

Integer denoting the number of
application recording files. The
data is sent when both Google
Analytics and CEIP are enabled.

Number of recordings recording-number Integer denoting the number of
both application and desktop
recording files. The data is sent
when both Google Analytics
and CEIP are enabled.

Number of dynamic recordings dynamic-recording-
number

Integer denoting the number of
dynamically recorded files. The
data is sent when both Google
Analytics and CEIP are enabled.

Number of agents hosting
recorded sessions

recorded-agent-number Integer denoting the number of
VDAs hosting recorded sessions.
The data is sent when both
Google Analytics and CEIP are
enabled.

Number of agents hosting
recorded sessions containing
logged events

event-logging-enabled
-agent-number

Integer denoting the number of
VDAs hosting recorded sessions
that contain logged events. The
data is sent when both Google
Analytics and CEIP are enabled.

Number of recordings
containing logged events

event-logging-
recording-number

Integer denoting the number of
recording files that contain
logged events. The data is sent
when both Google Analytics
and CEIP are enabled.
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Data Point Key Name Description

Administrator logging
enablement

admin-logging-status Digit indicating the
enablement of administrator
logging. “1”means enabled.
“0”means disabled. The data is
sent when both Google
Analytics and CEIP are enabled.

Number of logged events collected-events-
number

Integer denoting the number of
logged events. The data is sent
when both Google Analytics
and CEIP are enabled.

Number of custom policies customized-policies-
number

Integer denoting the number of
custom session recording and
event logging policies. The
data is sent when both Google
Analytics and CEIP are enabled.

Load balancing enablement load-balancing-status Digit indicating the
enablement of load balancing.
“1”means enabled. “0”means
disabled. The data is sent when
both Google Analytics and CEIP
are enabled.

Recording viewing policy
enablement

rbac-status Digit indicating the enablement
of recording viewing policies.
“1”means enabled. “0”means
disabled. The data is sent when
both Google Analytics and CEIP
are enabled.

Customize recording notificationmessages

September 7, 2025

If the active recording policy records sessions with notifications, users receive recording notifications
after typing credentials.

• WhenAllowenduser todeny recordingof their session is enabledon theNotifications tabof
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the Session Recording Server Properties, the default notification message reads as follows:

Allow end user to deny recording of their session. This feature forces end users to explicitly
consent to the session recording disclaimer before they can continue with their session. If end
users accept thedisclaimer, their session continueswith session recording enabled. If endusers
deny the disclaimer, their session is terminated.

• When Allow end user to deny recording of their session is not enabled, the default notifica‑
tion message is Your activity with the desktop or program(s) you recently started is being
recorded. If you object to this condition, close the desktop or program(s). Users can click
OK to dismiss the window and continue their sessions.

The default notificationmessage appears in the language of the operating systemon the VDA. You can
change the default message title andmessage body as needed.

You can also create notification messages in specific languages that you choose. While doing so, you
can customize the message title and message body too. You can have only one notification message
for each language. Your users see notification messages in the languages of their preferred local set‑
tings. The language‑specific notificationmessages take precedence over the default notificationmes‑
sage.

Customize recording notificationmessages

1. Log on to the machine hosting the Session Recording server.

2. From the Startmenu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the Notifications tab.
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4. To enable explicit user consent before recording sessions, select Allow end user to deny
recording of their session.

After you select Allow end user to deny recording of their session, the default message body
changes accordingly:

© 1997–2026 Citrix Systems, Inc. All rights reserved. 156



Session Recording 2603

5. If you want to use the default notification message, change the default message title and mes‑
sage body as needed and then clickOK to complete the settings. If you want to use a language‑
specific notification message, proceed to the following steps.

6. Click Add in the Language specific messages section.

7. Choose the language for the message and type the message title and message body. You can
create only onemessage for each language.
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After accepting and activating, the new message appears in the language‑specific notification
message box.

Enable or disable digital signing

September 7, 2025

You can install certificates onmachineswhere you installed the Session Recording server and the Ses‑
sion Recording player. Doing so can enhance the security of your deployment by assigning digital
signatures to Session Recording.

By default, digital signing is disabled. After you select the certificate to sign the recordings, Session
Recording grants the read permission to the Session Recording Storage Manager Service.

Enable digital signing

1. Log on to the machine hosting the Session Recording server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Signing tab.
4. Browse to the certificate that enables secure communication among the machines where you

installed the Session Recording components.
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Disable digital signing

1. Log on to the machine hosting the Session Recording server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Signing tab.
4. Click Clear.

Event response reports

June 21, 2024

Overview

You can receive emailed event response reports on a daily or weekly basis. An event response report
contains a digest chart as the email body and a csv file as the attachment. The csv file includes a full
list of the events during the day or week that have triggered various event responses.

Note:

By selecting email notifications as the event response in your customevent response policy, you
can still be notified about each individual occurrence. You can choose regular event response
reports, individual notifications, or both.

The following are example digest charts contained in a weekly and a daily event response report:
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Weekly Daily

See the screen capture below for an example csv file that can be linked to an event response report:
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Configuration

To receive emailed event response reports on a daily or weekly basis, schedule reports through Ses‑
sion Recording Server Properties. Make sure to configure outgoing email settings on the Email tab
too.

Note:

If your Session Recording servers are configured in a load balancing manner, schedule reports
on one of the servers. Otherwise, create a schedule on each of your Session Recording servers.
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Session recording storage reports

June 21, 2024
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Overview

A session recording storage report provides weekly statistics on screen recordings of a single or mul‑
tiple load‑balanced Session Recording servers. It is emailed to you and contains digest charts similar
to the following:
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Configuration

To receive emailed session recording storage reports on a daily or weekly basis, schedule reports
through Session Recording Server Properties. Make sure to configure outgoing email settings on the
Email tab too.

Note:

If your Session Recording servers are configured in a load balancing manner, schedule reports
on one of the servers. Otherwise, create a schedule on each of your Session Recording servers.
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Specify file size for recordings

September 7, 2025

As recordings grow in size, recording files take longer to download and respond more slowly when
you use the seek slider to navigate during playback. To control file size, specify a threshold limit for a
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file. When the recording reaches this limit, Session Recording closes the file and creates an extra file
to continue recording. This action is called a rollover.

You can specify two thresholds for a rollover:

• File size. The current file closes when it reaches the size, and a new file opens. By default, the
rollover occurs when the size exceeds 50 MB. Supported values: 10‑300.

• Duration. When the duration is reached, the current file closes and a new file opens. By default,
the rollover occurs when the session records for 12 hours. Supported values: 1‑24.

Rollovers occur when the first of the two conditions above is met. For example, you specify 17 MB
for the size and 6 hours for the duration. When your recording reaches 17 MB in 3 hours, Session
Recording closes the file and opens a new one.

To prevent the creation ofmany small files, Session Recording doesn’t roll over until at least one hour
elapses regardless of the value specified for the file size. The exception to this rule is if the file size
surpasses 300 MB.

Specify themaximum file size for recordings

1. Log on to the machine hosting the Session Recording server.

2. From the Startmenu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the Rollover tab.
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4. Type an integer between 10 and 300 to specify the maximum file size in MB.

5. Type an integer between 1 and 24 to specify the maximum recording duration in hours.
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Specify recording storage locations

September 7, 2025

You can store recordings on a local drive, a SAN volume, and a location specified by a UNC network
path. You can also store recordings in Azure file shares and Amazon Simple Storage Service (Amazon
S3).

Note:

• Storing data on a NAS, based on file‑based protocols such as SMB and NFS,might have per‑
formance and security implications. Use the latest version of the protocol to avoid security
implications and perform scale testing to ensure proper performance.

• To archive files or restore deleted files, use the ICLDB command.

This article walks you through the following procedures:

• Specify recording storage locations in Session Recording Server Properties

• Store recordings in an Azure file share

• Store recordings in Amazon S3

• Store recordings in a network shared folder

Specify recording storage locations in Session Recording Server Properties

This section provides a general procedure for setting storage locations in Session Recording Server
Properties.

1. Log on to the machine hosting the Session Recording server.

2. From the Startmenu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the Storage tab.

4. Use the File storage directories list to manage the folders where recordings are stored.

After you select the folders, Session Recording grants its service with Full Control permission to
these folders.

By default, recordings are stored in the <drive>:\SessionRecordings folder of the machine
hosting the Session Recording server. You can change the folder where you store recordings,
add extra folders to load‑balance acrossmultiple volumes, ormake use ofmore space. Multiple
folders in the list indicate that recordings are load‑balanced across the folders. Load balancing
cycles through the folders.
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5. In the Restore directory for archived files field, specify a folder for restoring archived record‑
ings. You can specify only one folder for restoring archived recordings.
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By default, archived recordings are restored in the <drive>:\SessionRecordingsRestore folder
of the machine hosting the Session Recording server. You can change the folder.

Store recordings in an Azure file share

To store recordings in an Azure file share, complete the following steps:

1. In the Azure portal, create a storage account and then create an Azure file share.

For a quick start guide, see Create and manage Azure file shares with the Azure portal. The
following table recommends configurations for your consideration.

Recording File
Size MB/hour

Session
Quantity

File Share
Type

File Share
Quota (TB)

Session
Recording
Server
Quantity

Session
Recording
Server Size

< 6.37 < 1,000 HDD Standard
(StorageV2)

2 1 Standard
D4as_v4

< 6.37 1,000–2,000 SSD Premium 3 1 Standard
D4as_v4

< 6.37 2,000–3,000 SSD Premium 5 1 Standard
D4as_v4

< 6.37 3,000–4,000 SSD Premium 6 1 Standard
D4as_v4

Approx.10 < 1,000 HDD Standard
(StorageV2)

3 1 Standard
D4as_v4

Approx.10 1,000–2,500 SSD Premium 6 1 Standard
D4as_v4

Approx.10 2,500–4,000 SSD Premium 10 2 Standard
D4as_v4

The file share quota is calculated based on eight hours per day, 23working days permonth, and
a one‑month retention period for each recording file.

2. Add theAzure file share credentials to thehostwhere you installed theSessionRecording server.

a) Start a command prompt as an administrator and change the drive to the <Session
Recording Server installation path>\Bin folder.

By default, the Session Recording server is installed in C:\Program Files\Citrix\
SessionRecording\Server.
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b) Run the SsRecUtils.exe ‑AddAzureFiles <storageAccountName> <fileShareName>
<accesskey> command.

Where,

• <storageaccountname> is the name of your storage account in Azure.
• <filessharename> is the name of the file share contained within your storage
account.

• <accesskey> is your storage account key that can be used to access the file share.

There are two ways to obtain your storage account key:

• You can obtain your storage account key from the connection string that appears
when you click the Connect icon in your file share page.

• You can also obtain your storage account key by clicking Access keys in the left navi‑
gation of your storage account page.
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c) Mount the Azure file share to the host where you installed the Session Recording server.

i. Open Session Recording Server Properties.

ii. Click Add on the Storage tab.

iii. Enter theUNCpath in the formatof \\<storageaccountname>.file.core.windows.net\<filessharename>\<subfolder>.

Specify a subfolder under the file share to store your recording files. The Session
Recording server then automatically creates the subfolder for you.
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iv. ClickOK in the File Storage Directory dialog box.

v. Click Apply in the Session Recording Server Propertieswindow.

vi. ClickOK after Apply becomes grayed out.

vii. Click Yes when you’re prompted to restart the Session Recording Storage Manager
service.

Store recordings in Amazon S3

Recommendations

1. Install the Session Recording server on t2.xlarge or other AWS EC2 instances with higher speci‑
fications.
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2. Set the storage limit on Message Queues to a minimum of 4,194,304 KB (4 GB).

3. In Session Recording Agent Properties, set the lifetime of the messages on Message Queues to
14,400 seconds (4 hours).
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Note:

During the update or maintenance of the AWS Storage Gateway, recording files might not
be saved from the Session Recording server to the file share. Data losses can occur.

Steps

To store recordings in Amazon S3, complete the following steps:
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1. Create an Amazon S3 bucket. For more information, see the Amazon documentation Creating
a bucket.

2. Create and activate an Amazon S3 File Gateway. Doing so enables data transfer to and from the
Amazon S3 bucket created earlier.

For step‑by‑step instructions, see the following Amazon documentation:

• Create and activate an Amazon S3 File Gateway
• Getting an activation key for your gateway

3. Create a file share with guest access. When creating the file share, select the Amazon S3 File
Gateway that you created earlier and connect the file share to your AmazonS3bucket. Formore
information, see the Amazon documentation Create a file share.

4. Go to themachinewhere you installed theSessionRecording server and complete the following
steps:

a) Add the file share credentials to the Session Recording server. To do so, start a command
prompt as an administrator and change the drive to the <Session Recording Server
installation path>\Bin folder. By default, the Session Recording server is installed
in C:\Program Files\Citrix\SessionRecording\Server. Then run the SsRecUtils.exe
‑AddAwsS3 <GatewayIPAddress> <S3Path> <GatewayID> <Password> command.

Where,

• <GatewayIPAddress> is the IP address of your Amazon S3 File Gateway.
• <S3Path> is the name of your Amazon S3 bucket.
• <GatewayID> is the ID of your Amazon S3 File Gateway.
• <Password> is the guest password that you set when creating the file share.

All the information except for the guest password is available on the file share page similar
to the following. As for the guest password, youmust keep a careful record yourself.
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b) Set the file share as the location for storing your recordings.

i. Open Session Recording Server Properties.
ii. Click Add on the Storage tab.
iii. Enter the UNC path in the format of \\<GatewayIPAddress>\<S3Path>\<subfolder>.

Specify a subfolder under the file share to store your recording files. The Session
Recording server then automatically creates the subfolder for you.

Store recordings in a network shared folder

Note:

• For an accessible network shared folder, the Session Recording server accesses it through
SMB by default.

• Storing data on a NAS, based on file‑based protocols such as SMB and NFS,might have per‑
formance and security implications. Use the latest version of the protocol to avoid security
implications and perform scale testing to ensure proper performance.

Steps

To store recordings in a network shared folder, complete the following steps:

1. Create an account with read and write permissions for the network shared folder to be created
later. To do so, use the Windows GUI or run a PowerShell command similar to the following:

1 New-LocalUser -Name "YourUserName" -Password (ConvertTo-
SecureString -String "YourPassword" -AsPlainText -Force)

2. Create a network shared folder and ensure that the shared folder is accessible to the Session
Recording Server. To do so, use the Windows GUI or run the PowerShell commands similar to
the following:

1 New-SmbShare -Name "YourShareName" -Path "YourSharePath" -
FullAccess "YourUserName"

2
3 Grant-SmbShareAccess -Name "YourShareName" -AccessRight Change -

AccountName "YourUserName"
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3. Go to themachinewhere you installed theSessionRecording server and complete the following
steps:

a) Add the credentials for the created account to the Session Recording server. To do so, start
a command prompt as an administrator and change the drive to the <Session Record‑
ing Server installation path>\Bin folder. By default, the Session Recording server is in‑
stalled in C:\Program Files\Citrix\SessionRecording\Server. Then run the SsRecUtils.exe
‑AddSharedFolder <IPAddress> <ShareName> <Protocol> <Username> <Password>
command.

Where,

• <IPAddress> is the IP address of the machine where the shared folder resides.
• <ShareName> is the share name.
• <Protocol> is fixed to SMB.
• <Username> is the user name that you set for the shared folder.
• <Password> is the password that you set for the shared folder.

For example, if \\10.100.100.100\myshare is your shared folder, you can run a command
similar to SsRecUtils ‑AddSharedFolder 10.100.100.100 myshare SMB myusername
mypassword.

b) Set the shared folder as the location for storing your recordings.

i. Open Session Recording Server Properties.
ii. Click Add on the Storage tab.
iii. Enter the UNC path in the format of \\<IPAddress>\<ShareName>\<subfolder>.

Specify a subfolder under the shared folder to store your recording files. The Session
Recording server then automatically creates the subfolder for you.

Policies

September 7, 2025

Use the Session Recording Policy Console to create recording policies, event detection policies, event
responsepolicies, and recording viewingpolicies. Whencreating thepolicies, youcan specifyDelivery
Controllers from both the Citrix Cloud™ and on‑premises environments.

Important:

To use the Session Recording Policy Console, youmust have the Broker PowerShell Snap‑in (Bro‑
ker_PowerShellSnapIn_x64.msi) or the Citrix DaaS Remote PowerShell SDK (CitrixPoshSdk.exe)
installedmanually. Locate theBrokerPowerShell snap‑in on theCitrix Virtual Apps andDesktops
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ISO (\x64\Citrix Desktop Delivery Controller). Or, download the Citrix DaaS Re‑
mote PowerShell SDK from the Citrix DaaS (formerly Citrix Virtual Apps and Desktops service)
download page.

Tip:

You can edit the registry to prevent recording file losses in case that your Session Record‑
ing server might fail unexpectedly. Log on as an administrator to the machine where you
installed the Session Recording Agent, open the Registry Editor, and add a DWORD value
DefaultRecordActionOnError =1 under HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Agent.

Activate a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Serverwindow appears, ensure that the name of the Ses‑

sion Recording server, protocol, and port are correct. ClickOK.
4. In the Session Recording Policy Console, expand the target policy type.
5. Select the policy to activate.
6. From themenu bar, choose Activate Policy.

Modify a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Serverwindow appears, ensure that the name of the Ses‑

sion Recording server, protocol, and port are correct. ClickOK.
4. In the Session Recording Policy Console, expand the target policy type.
5. Select the policy that you want to modify. The rules for the policy appear in the right pane.
6. To add, modify, or delete a rule:

• From the menu bar, choose Add New Rule. If the policy is active, a pop‑up window ap‑
pears requesting confirmation of the action. Use the Ruleswizard to create a rule.

• Select the rule that youwant tomodify, right‑click, and chooseProperties. Use theRules
wizard to modify the rule.

• Select the rule that you want to delete, right‑click, and choose Delete Rule.
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Delete a policy

Note:

You cannot delete a system‑defined policy or a policy that is active.

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Serverwindow appears, ensure that the name of the Ses‑

sion Recording server, protocol, and port are correct. ClickOK.
4. In the Session Recording Policy Console, expand the target policy type.
5. In the left pane, select the policy to delete. If the policy is active, you must activate another

policy.
6. From themenu bar, choose Delete Policy.
7. Select Yes to confirm the action.

Configure session recording policies

April 1, 2026

You can activate system‑defined recording policies or create and activate your own custom recording
policies. System‑defined recording policies apply a single rule to entire sessions. Custom recording
policies specify which sessions are recorded.

The active recording policy determines which sessions are recorded. Only one recording policy is ac‑
tive at a time.

System‑defined recording policies

Session Recording provides the following system‑defined recording policies:
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• Donot record. Thedefault policy. If youdonot specify another policy, no sessions are recorded.

• Record entire sessions excluding audio (for everyone, with notification). This policy
records entire sessions (including screens and events but excluding audio). Users receive
recording notifications in advance.

• Record entire sessions excluding audio (for everyone, without notification). This policy
records entire sessions (including screens andevents but excludingaudio). Users donot receive
recording notifications.

• Record entire sessions excluding audio with lossy screen recording enabled (for every‑
one, with notification). This policy records entire sessions (including screens and events but
excluding audio). Lossy screen recording is enabled to reduce the size of recording files. Users
receive recording notifications in advance.

• Recordentire sessionsexcludingaudiowith lossy screen recordingenabled (for everyone,
without notification). This policy records entire sessions (including screens and events but
excluding audio). Lossy screen recording is enabled to reduce the size of recording files. Users
do not receive recording notifications.

• Recordentire sessions includingaudio (foreveryone,withnotification). Thispolicy records
entire sessions (including screens, events, and audio). Users receive recording notifications in
advance. You can now enable audio recording for non‑optimized HDX audio. The audio that is
handled on the VDA anddelivered to/from the clientwhere the CitrixWorkspace app is installed
is referred to as non‑optimized HDX audio. Unlike non‑optimized HDX audio, optimized HDX
audio has its processing offloaded to the client, as seen in the Browser Content Redirection
(BCR) and Optimization for Microsoft Teams scenarios.
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• Record entire sessions including audio (for everyone, without notification). This policy
records entire sessions (including screens, events, and audio). Users do not receive recording
notifications.

• Record only events (for everyone, with notification). This policy records only events that
your event detection policy specifies. It does not record screens or audio. Users receive record‑
ing notifications in advance.

• Recordonly events (for everyone,without notification). This policy records only events that
your event detection policy specifies. It does not record screens or audio. Users do not receive
recording notifications.

Note:

When upgrading Citrix Session Recording from version 1912 , existing policy names are retained
(e.g., Record everyone with notification, Record everyone without notification).

However, fresh installations use updated policy names.

This is expected behavior and does not affect policy functionality.

You can’t modify or delete the system‑defined recording policies.

Create a custom recording policy

Considerations

You can record sessions of specific users or groups, published applications or desktops, delivery
groups or VDA machines, and Citrix Workspace™ app client IP addresses. To obtain the lists of
published applications or desktops and delivery groups or VDA machines, you must have the read
permission as a site administrator. Configure the administrator read permission on the Delivery
Controller™ of the site.

You can also specify smart access tags to use as scopes for a custom recording policy to apply to. This
feature is available for Session Recording 2402 and later. It lets you apply policies based on the
user access context including:

• The user’s location
• IP address range
• Delivery group
• Device type
• Installed applications

A wizard within the Session Recording policy console helps you create rules. For each rule you create,
you specify a recording action and rule criteria. The recording action applies to sessions that meet
the rule criteria.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 183



Session Recording 2603

For each rule, choose one recording action:

• Enable session recording with notification. This option records entire sessions (screens and
events). Users receive recording notifications in advance. With this option selected, you can
further select to enable audio recording or lossy screen recording. Additionally, you can choose
to hide specific applications in screen recordings.

• Enable session recording without notification. This option records entire sessions (screens
and events). Users do not receive recording notifications. With this option selected, you can
further select to enable audio recording or lossy screen recording. Additionally, you can choose
to hide specific applications in screen recordings.

• Enable event only session recording with notification. Recording only specific events helps
to free up storage space. This option records throughout sessions only events that your event
detection policy specifies. It does not record screens. Users receive recording notifications in
advance.

• Enable event only session recording without notification. Recording only specific events
helps to free up storage space. This option records throughout sessions only events that your
event detection policy specifies. It does not record screens. Users do not receive recording
notifications.

• Disable session recording. This option means that no sessions are recorded.
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• Hide specific applications during screen recording. This feature lets you hide specific appli‑
cations with a layer mask during screen recording. The color for the layer mask is configurable,
which can be Black, Gray, or White.

For example, you can see that an application is hidden during the recording playback:

• Allow user‑initiated recording without interrupting admin or policy‑driven recordings.
This feature lets end users start and stop recordings on demand. Administratorinitiated
and policydriven recordings take precedence and are not interrupted by enduser triggered
recordings.

For each rule, choose at least one of the following items to create the rule criteria:
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• UsersorGroups. Creates a list of usersor groups towhich theactionof the rule applies. Session
Recording allows you to use Active Directory groups and white list users.

• Published Applications or Desktop. Creates a list of published applications or desktops to
which the action of the rule applies. In the Rules wizard, choose the Citrix Virtual Apps and
Desktops™ or Citrix DaaS (formerly Citrix Virtual Apps and Desktops service) sites on which the
applications or desktops are available.

• DeliveryGroupsorMachines. Creates a list of DeliveryGroupsormachines towhich the action
of the rule applies. In theRuleswizard, choose the location of the Delivery Groups ormachines.

• IP Address or IP Range. Creates a list of IP addresses or ranges of IP addresses to which the
action of the rule applies. On theSelect IP Address and IPRange screen, add a valid IP address
or IP range forwhich recording is enabled or disabled. The IP addressesmentioned here are the
IP addresses of the Citrix Workspace apps.

• Filter. Creates a list of smart access tags to which the action of the rule applies. You can config‑
ure contextual access (smart access) using smart access policies on Citrix NetScaler.
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Note:

The Session Recording policy console supports configuring multiple criteria within a single rule.
When a rule applies, both the “AND”and the “OR”logical operators are used to compute the fi‑
nal action. Generally speaking, the “OR”operator is used between items within a criterion, and
the “AND”operator is used between separate criteria. If the result is true, the Session Recording
policy engine takes the rule’s action. Otherwise, it goes to the next rule and repeats the process.

When you createmore than one rule in a recording policy, some sessions might match the criteria for
more than one rule. In these cases, the rule with the highest priority is applied to the sessions.

The recording action of a rule determines its priority:

• Rules with the Disable session recording action have the highest priority.
• Rules with the Enable session recording with notification action have the second‑to‑highest
priority.

• Rules with the Enable session recording without notification action have the second‑to‑
lowest priority.

• Ruleswith theEnableeventonly session recordingwithnotificationactionhave themedium
priority.

• Ruleswith theEnable event only session recordingwithout notification action have the low‑
est priority.

Some sessionsmight notmeet any rule criteria in a recording policy. For these sessions, the action of
the policy fallback rule applies. The action of the fallback rule is always Disable session recording.
You can’t modify or delete the fallback rule.

Steps

To create a custom recording policy:

1. Log on as an authorized Policy Administrator to the server where the Session Recording policy
console is installed.

2. Start the Session Recording policy console and selectRecording Policies in the left pane. From
themenu bar, choose Add New Policy.

3. Right‑click theNew policy and select Add Rule.

4. In the rules wizard, select a recording option and then clickNext.
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When you select Enable session recording with notification or Enable session recording
without notification, you can further select to enable audio recording or lossy screen record‑
ing.

5. Select the rule criteria ‑ You can choose one or more rule criteria:

• Users or Groups
• Published Applications or Desktop
• Delivery Groups or Machines
• IP Address or IP Range
• Filter

6. Edit the rule criteria ‑ To edit, click the underlined values. The values are underlined based on
the criteria that you chose in the previous step.

Note:

If you choose the Published Applications or Desktop underlined value, the Site Address
is the IP address, a URL, or a machine name if the Controller is on a local network. The
Name of Application list shows the display name.

When choosing Published Applications or Desktop or Delivery Groups or Machines, specify
the Delivery Controller for your Session Recording policy console to communicate with.
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The Session Recording policy console is the only channel to communicate with Delivery Con‑
trollers from the Citrix Cloud™ and on‑premises environments.

For example, when choosing Delivery Groups or Machines, click the corresponding hyperlink
in the preceding screenshot and click Add to add queries to the Controller.
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For a description of use cases that cover the on‑premises and the Citrix Cloud Delivery Con‑
trollers, see the following table:

Use Case Action Required

On‑Premises Delivery Controller
a) Install Broker_PowerShellSnapIn_x64.msi.

2. Clear the Citrix Cloud Controller check
box.

Citrix Cloud Delivery Controller
a) Install the Citrix DaaS™ Remote

PowerShell SDK. 2. Validate the Citrix
Cloud account credentials. 3. Select the
Citrix Cloud Controller check box.

Switch from an on‑premises Delivery Controller
to a Citrix Cloud Delivery Controller

a) Uninstall
Broker_PowerShellSnapIn_x64.msi and
restart the machine. 2. Install the Citrix
DaaS Remote PowerShell SDK. 3. Validate
the Citrix Cloud account credentials. 4.
Select the Citrix Cloud Controller check
box.

Switch from a Citrix Cloud Delivery Controller to
an on‑premises Delivery Controller

a) Uninstall the Citrix DaaS Remote
PowerShell SDK and restart the machine.
2. Install
Broker_PowerShellSnapIn_x64.msi. 3.
Clear the Citrix Cloud Controller check
box.

Validating the Citrix Cloud credentials

To query Delivery Controllers hosted in the Citrix Cloud, manually validate your Citrix Cloud
credentials on the machine where the Session Recording policy console is installed. Failure
to comply can cause an error and your Session Recording policy console might not work as
expected.

To do the manual validation:

a) Log on to the Citrix Cloud console and locate Identity and AccessManagement > API Ac‑
cess. Create an API access Secure Client for obtaining an authentication profile that can
bypass the Citrix Cloud authentication prompts. Download your Secure Client, rename,
and save it in a safe location. The file name is defaulted to secureclient.csv.
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b) Open a PowerShell session and run the following command to have the authentication
profile (obtained in the preceding step) take effect.

1 asnp citrix.*
2 Set-XDCredentials -CustomerId "citrixdemo" -SecureClientFile "

c:\temp\secureclient.csv" -ProfileType CloudAPI – StoreAs "
default"

Set CustomerId and SecureClientFile as required. The preceding command creates a
default authentication profile for the customer citrixdemo to bypass authentication
prompts in the current and all subsequent PowerShell sessions.

7. Follow the wizard to finish the configuration.

Note: Limitation regarding prelaunched application sessions:

• If the active policy tries to match an application name, it can’t match applications that are
opened in a prelaunched session. As a result, the prelaunched session can’t be recorded.

• If the active policy records every application and session prelaunch is enabled, a record‑
ing notification appears when a user logs on to Citrix Workspace app for Windows. The
prelaunched (empty) session and any applications to be launched in that session going for‑
ward are recorded.

As a workaround, publish applications in separate Delivery Groups according to their recording
policies. Do not use an application name as a recording condition. This approach ensures that
prelaunched sessions can be recorded. However, notifications still appear.

Use Active Directory groups

Session Recording allows you to use Active Directory groups when creating policies. Using Active Di‑
rectory groups instead of individual users simplifies the creation and management of rules and poli‑
cies. For example, if users in your company’s finance department are contained in an Active Directory
group named Finance, you can create a rule that applies to all the group members by selecting the
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Finance group in the
Ruleswizard.

White list users

You can create Session Recording policies ensuring that the sessions of some users in your organiza‑
tion are never recorded. This case is called
white listing these users. White listing is useful for users who handle privacy‑related information or
when your organization does not want to record the sessions of a certain class of employees.

For example, if all managers in your company aremembers of an Active Directory group named Exec‑
utive, you can ensure that sessions of these users are never recorded by creating a rule that disables
session recording for the Executive group. While the policy containing this rule is active, no sessions
ofmembers of the Executive group are recorded. The sessions of othermembers of your organization
are sessions recorded based on other rules in the active policy.

Configure the Director to use the Session Recording server

You can use the Director console to create and activate the recording policies.

1. For an HTTPS connection, install the certificate to trust the Session Recording server in the
Trusted Root Certificates of the Director server.

2. To configure the Director server to use the Session Recording server, run the C:\inetpub\
wwwroot\Director\tools\DirectorConfig.exe /configsessionrecording
command.

3. Type the IP address or FQDN of the Session Recording server and the port number and con‑
nection type (HTTP/HTTPS) that the Session Recording agent uses to connect to the Session
Recording Broker on the Director server.

Understand rollover behavior

When you activate a policy, the previously active policy remains in effect until the session being
recorded ends or the session recording file rolls over. Files roll over when they’ve reached the
maximum size or recording duration. For more information about the rollover thresholds, see
Specify file size for recordings.

The following table details what happens when you apply a new recording policy while a session is
being recorded and a rollover occurs:
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If the previous recording policy
was And the new recording policy is

After a rollover, the recording
policy will be

Do not record Any other policy No change. The new policy
takes effect only when the user
logs on to a new session.

Record without notification Do not record The recording stops.

Record without notification Record with notification Recording continues and a
notification message appears.

Record with notification Do not record The recording stops.

Record with notification Record without notification Recording continues. No
message appears the next time
a user logs on.

Configure recording viewing policies

June 21, 2024

Session Recording supports role‑based access control. You can create recording viewing policies in
the Session Recording policy console and addmultiple rules to each policy. Each rule helps you select
a user or user group as the recording viewer and set whose recordings are visible to the viewer.

Create a custom recording viewing policy

Before you can create recording viewing policies, enable the feature as follows:

1. Log on to the machine hosting the Session Recording server.

2. From the Startmenu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the RBAC tab.

4. Select the Allow to configure recording viewing policies check box.
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To create a custom recording viewing policy:

Note: Different from recording policies and event detection policies, a recording viewing policy (in‑
cluding all rules added within) is active immediately when it is created. You do not have to activate
it.

1. Log on as an authorized Policy Administrator to the server where the Session Recording policy
console is installed.

2. Start the Session Recording policy console. By default, there is no recording viewing policy.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 194



Session Recording 2603

Note: TomakeRecordingViewingPolicies available, enable the feature inSessionRecording
Server Properties first.

3. SelectRecordingViewingPolicies in the leftpane. Fromthemenubar, chooseAddNewPolicy
to create a recording viewing policy.

4. (Optional) Right‑click the new policy and rename it.

5. Right‑click the new policy and select Add rule.
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6. Click Add.

7. In the Select Users or Groups dialog, select a user or user group as the recording viewer.

Note:

Aviewermust be assigned thePlayer role to view recorded sessions. Formore information,
see Authorize users.
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Note:

In each rule, you can select only one user or user group as the recording viewer. If you
select multiple users or user groups, only your most recent selection takes effect and ap‑
pears in the text box.
When you specify a recording viewer, ensure that you have assigned the viewer to the
Player role. A user without the permission to play recorded sessions receives an errormes‑
sage when trying to play a recorded session. For more information, see Authorize users.

8. ClickOK and thenNext. The dialog for setting rule criteria appears.

9. Select and edit the rule criteria to specify whose recordings are visible to the viewer you speci‑
fied earlier:

• Users or Groups
• Published Applications or Desktop
• Delivery Groups or Machines
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Note:

The “OR”logical operator is used both between items within a rule criterion and between
separate rule criteria.

If you leave the rule criteria unspecified, the viewer specified earlier has no recordings to
view.

10. Follow the wizard to complete the configuration.

For example:
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Configure event detection policies

September 7, 2025

Session Recording supports centralized configuration of event detection policies. You can create poli‑
cies in the Session Recording policy console to log various events.

Events that can be detected

Session Recording detects target events and tags those events in recordings for later search and play‑
back. You can search for events of interest from large amounts of recordings and locate those events
during playback.
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System‑defined events

Session Recording candetect and log the following system‑defined events that occur during recorded
sessions:

• Insertion of USBmass storage devices

• Application starts and ends

• App failures

• App installs and uninstalls

• File renaming, creation, deletion, andmoving operations within sessions

• File transfers between session hosts (VDAs) and client devices (including mapped client drives
and generic redirectedmass storage devices)

• Web browsing activities

• Topmost window events

• Clipboard activities

• Windows registry modifications

• User account modifications

• RDP connections

• Performance data (data points related to the recorded session)

• Popup window events

• Printing activities

For example:

• Events in an event‑only recording in the web player:
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• Events in a screen recording in the web player:

• Events in the Session Recording player:
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For more events in the Session Recording player, see the event descriptions later in this article.

Note:

Applicationsbuilt byPowerBuildermight exit unexpectedlywhen thereareactivepoliciesdetect‑
ing web browsing activities and topmost window events. To avoid the issue, use PowerBuilder
2019 R3 to build your applications.

Insertion ofUSBmass storagedevices Session Recording can detect the insertion of a Client Drive
Mapping (CDM) mapped or generic redirected USB mass storage device in a client where Citrix Work‑
space™ app for Windows or for Mac is installed. Session Recording tags these events in the record‑
ing.

Note:

To use an inserted USB mass storage device and detect the insertion events, set the Client USB
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device redirection policy to Allowed in Citrix Studio.

Currently, only the insertion of USBmass storage devices (USB Class 08) can be detected.

Application starts and ends Session Recording supports detection of both application starts and
ends. When you add a process to the Appmonitoring list, apps driven by the added process and its
child processes aremonitored. Child processes of a parent process that starts before Session Record‑
ing runs can also be captured.

Session Recording adds the process names, cmd.exe, powershell.exe, and wsl.exe, to the
App monitoring list by default. If you select Log app start events and Log app end events for an
event detection policy, the starts and ends of the Command Prompt, PowerShell, and Windows Sub‑
system for Linux (WSL) apps are logged nomatter whether you manually add their process names to
the Appmonitoring list. The default process names are not visible on the Appmonitoring list.

In addition, Session Recording provides a full command line for each app start event logged.
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Application failures Session Recording detects app exits and unresponsive apps if you select Log
app failures when creating your event detection policy. The Log app failures rule applies to all
apps.

App installs and uninstalls The Log app installs and uninstalls rule applies to all apps.
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User accountmodifications Session Recording can detect account creation, enablement, disable‑
ment, deletion, name changes, and passwordmodification attempts.

RDPconnections SessionRecording candetect RDP connections initiated from the VDAhosting the
recorded session.

File renaming, creation, deletion, andmoving operations within sessions and file transfers be‑
tween session hosts (VDAs) and client devices Session Recording can detect renaming, creation,
deletion, and moving operations on target files and folders that you specify in the File monitoring
list. Session Recording can also detect file transfers between session hosts (VDAs) and client devices
(includingmapped client drives and generic redirectedmass storage devices). Selecting the Log sen‑
sitive file eventsoption triggers the detection of file transfers, nomatterwhether you specify the File
monitoring list.
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Note:

To enable file drag and drop and capture the drag and drop events, set theDrag andDrop policy
to Enabled in Citrix Studio.

Web browsing activities Session Recording can detect user activities on supported browsers and
tag the events in the recording. The browser name, URL, and page title are logged. For an example,
see the following screen capture.

When you move your cursor away from a webpage that has focus, your browsing of this webpage is
taggedwithout showing thebrowser name. This feature canbeused to estimatehow longauser stays
on a webpage. For an example, see the following screen capture.

List of supported browsers:

• Google Chrome
• Microsoft Edge Chromium
• Mozilla Firefox

Note:

This feature requires Session Recording Version 1906 or later.

Topmost window events Session Recording can detect the events when the window of an app is
on top of all others. The process name, title, and process number are logged.
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Clipboard activities Session Recording can detect copy operations of text, images, and files using
the clipboard. The process name and file path are logged for a file copy. The process name and title
are logged for a text copy. The process name is logged for an image copy.

Note: Content of copied text is not logged by default. To log text content, go to the Session
Recording agent and set HKEY_LOCAL_MACHINE\SOFTWARE\ Citrix\SmartAuditor\
Agent\CaptureClipboardContent to 1(the default value is 0).
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Windows registrymodifications Starting with Version 2109, Session Recording can detect and log
the following registry modifications while recording sessions:

Registry modification Corresponding event

Adding a key Registry Create

Adding a value Registry Set Value

Renaming a key Registry Rename

Renaming a value Registry Delete Value and Registry Set Value

Changing an existing value Registry Set Value

Deleting a key Registry Delete

Deleting a value Registry Delete Value

For example:

To enable this registrymonitoring functionality, select theLog registrymodificationsoption for your
event detection policy.

Performance data (data points related to the recorded session) When creating your event de‑
tection policy, select Log performance data to enable the session data overlay feature. The feature
introduces a screenoverlay during sessionplayback in thewebplayer. It is a semi‑transparent overlay
that you can relocate and hide. The overlay features the following data points related to the recorded
session:

• Round trip time
• Network (send)
• Network (receive)
• CPU usage
• Memory usage
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Popupwindow events When users open or close a confidential file or access a folder, a popupwin‑
dowmight appear, showing a prompt or asking for a password. Session Recording can nowmonitor
such popup window events while recording sessions. Popup windows in web browsers are not moni‑
tored.

Attributes of a popup window event are recorded, including the process name and content of the
prompt.

Printing activities Session Recording monitors printing activities that occur during recorded ses‑
sions and tags them as events in recordings for later search and playback.

For an example printing activity event in the Session Recording web player, see the following screen
capture:

Note:

Printing activity events file information are not displayed in the Session Recording player.
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On the session replay interface, you can view printing events and click printed files in the right pane
to access detailed file information.

Custom events

TheSessionRecordingagentprovides the IUserApiCOM interface that third‑partyapplicationscanuse
to add application‑specific event data into recorded sessions. Based on the event customization, Ses‑
sion Recording can block sensitive information and log the session pause and session resume events
accordingly.

Sensitive information blocking Session Recording lets you skip certain periods when recording
the screen and blocks sensitive information in these periods during session playback. To use this
feature, use Session Recording 2012 and later.
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To use this feature, complete the following steps:

1. In Session Recording Agent Properties, select the Allow third party applications to record
custom data on this VDAmachine check box and click Apply.
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2. Grant users permission to invoke the Session Recording Event API (IUserApi COM interface).

Session Recording adds access control to the event API COM interface startingwith version 7.15.
Only authorized users are allowed to invoke the functionality to insert event metadata into a
recording.

Logon users with local administrator privileges are granted with this permission by default. To
grant other users this permission, use the Windows DCOM configuration tool:

a) On the Session Recording agent, run comcnfg.exe to open the Windows DCOM configura‑
tion tool.
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If you are granting permission to users who are notmembers of the domain administrator
group and the Session Recording agent is running on Windows Server 2019 or later, or
Windows 10 or later, proceed to step b. Otherwise, skip step b and go to step c directly.

b) Select Console Root > Component Services > Computers > My Computer from the left
navigation.

Right‑clickMy Computer and select Properties.
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Select the COM Security tab, and then click Edit Default to add users with Local Activa‑
tion permission in the Launch and Activation Permissions section.
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c) Select Console Root > Component Services > Computers >My Computer > DCOMCon‑
fig from the left navigation.

Right‑click Citrix Session Recording Agent and choose Properties.
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d) Select theSecurity tab, and then clickEdit to add userswith Local Activationpermission
in the Launch and Activation Permissions section.
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Note:

DCOM configuration takes effect immediately. There is no need to restart any services or
the machine.

3. Start a Citrix virtual session.

4. Start PowerShell and change the current drive to the <Session Recording agent installation
path>\Bin folder to import the SRUserEventHelperSnapin.dll module.

5. Run the Session-Pause and Session-Resume cmdlets to set parameters for triggering
sensitive information blocking.

Parameter Description Required or Optional

-APP The app name that calls the
Session‑Pause and
Session‑Resume cmdlets.

Required
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Parameter Description Required or Optional

-Reason The reason that content is
blocked. If you leave this
parameter unspecified, the
default setting shows, stating
Content Blocked and
Sensitive information exists
and is blocked. If you set this
parameter, the reason you
specify shows when you
navigate to the blocked period
during session playback. This
parameter is available for both
the Session‑Pause and
Session‑Resume cmdlets.

Optional

-AheadSeconds This parameter is available for
the Session‑Pause cmdlet only.
It lets you configure the
amount of time of the screen
recording you want to bypass
before sensitive information is
detected. The default value is 1
s.

Optional

For example, you can run Session‑Pause similar to the following:
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Search for and play back recordings with tagged events

Search for recordings with tagged events The Session Recording player allows you to perform
advanced searches for recordings with tagged events.

1. In the Session Recording player, click Advanced Search on the tool bar or choose Tools > Ad‑
vanced Search.

2. Define your search criteria in the Advanced Search dialog box.

The Events tab allows you to search for tagged events in sessions by Event text or Event type or
both. You can use the Events, Common, Data/Time, and Other filters in combination to search for
recordings that meet your criteria.

Note:

• The Event type list itemizes all event types. You can select an event type to search. Select‑
ing Any Citrix‑defined event means to search for all recordings with any type of events
logged by Citrix Session Recording.

• The Event text filter supports partial match. Wildcards are not supported.
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• The Event text filter is case‑insensitive whenmatching.
• For the types of events, the words App Start, App End, Client drive mapping,
and File Rename do not participate in matching when you search by Event text.
Therefore, when you type App Start, App End, Client drive mapping, or
File Rename in the Event text box, no result can be found.

You can use events to navigate through a recorded session, or skip to the points where the events are
tagged.

System‑defined event detection policy

The system‑defined event detection policy is Do not detect. It’s inactive by default. When it’s active,
no events are logged.

You cannot modify or delete the system‑defined event detection policy.

Create a custom event detection policy

Considerations

You can specify which events to log. A wizard within the Session Recording policy console helps you
create rules. For each rule you create, you select the events to log and specify which sessions the rule
applies to through the rule criteria settings.

For each rule, choose at least one of the following items to create the rule criteria:

• Users or Groups. Creates a list of users or groups to which the rule applies.
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• Published Applications or Desktop. Creates a list of published applications or desktops to
which the rule applies.

• Delivery Groups or Machines. Creates a list of Delivery Groups or machines to which the rule
applies.

• IP Address or IPRange. Creates a list of IP addresses or ranges of IP addresses towhich the rule
applies. The IP addresses mentioned here are the IP addresses of the Citrix Workspace apps.

• Filter. Creates a list of smart access tags towhich the rule applies. You can configure contextual
access (smart access) using smart access policies on Citrix NetScaler.

Contextual access (smart access) is available for Session Recording 2402 and later. It lets
you apply policies based on the user access context including:

• The user’s location
• IP address range
• Delivery group
• Device type
• Installed applications

Steps

To create a custom event detection policy:

1. Log on as an authorized Policy Administrator to the server where the Session Recording policy
console is installed.

2. Start the Session Recording policy console.
By default, there is no active event detection policy.

3. Select Event Detection Policies in the left pane. From the menu bar, choose Add New Policy
to create an event detection policy.

4. (Optional) Right‑click the new event detection policy and rename it.
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5. Right‑click the new event detection policy and select Add Rule.

a) Specify one ormore target events tomonitor by selecting the check box next to each event
type. Scroll down the window to view all available event types.
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• Log CDM mapped USB events: Logs the insertion of a Client Drive Mapping (CDM)
mapped mass storage device in a client where Citrix Workspace app for Windows or
for Mac is installed.

• Log generic USB redirection: Logs the insertion of a generic redirectedmass storage
device in a client where Citrix Workspace app for Windows or for Mac is installed.

• Log app start events: Logs the starts of target applications.

• Log app end events: Logs the ends of target applications.

Note:

The Logappendevents check box is grayed out before you select Logapp start
events.

• Appmonitoring list: When you selectLogapp start events and Logappendevents,
use the Appmonitoring list to specify target applications tomonitor and to avoid an
excessive number of events from flooding the recordings.

Note:

• To capture the start and end of an application, add the process name of the
application in the App monitoring list. For example, to capture the start of
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Remote Desktop Connection, add the process name mstsc.exe to the App
monitoring list. When you add a process to the Appmonitoring list, applica‑
tions driven by the added process and its child processes are monitored. Ses‑
sion Recording adds the process names, cmd.exe, powershell.exe, and
wsl.exe, to the Appmonitoring list by default. If you select Log app start
events and Log app end events for an event detection policy, the starts and
endsof theCommandPrompt, PowerShell, andWindowsSubsystem for Linux
(WSL) apps are logged regardless of whether you manually add their process
names to the App monitoring list. The default process names aren’t visible
on the Appmonitoring list.

• Separate process names with a semicolon (;).
• Only the exact match is supported. Wildcards aren’t supported.
• Process names you add are case‑insensitive.
• To avoid an excessive number of events from flooding the recordings, do not
add any system process names (for example, explorer.exe) and web browsers
in the registry.

• Log file operations: Logs operations on target files in the File monitoring list and
logs file transfers between session hosts (VDAs) and client devices (includingmapped
client drives and generic redirected mass storage devices). Selecting this option trig‑
gers the logging of file transfers, no matter whether the File monitoring list is speci‑
fied.

• File events presented in the web player

• File events presented in the Session Recording Player

• File monitoring list: When you select Log file operations, use the File monitoring
list to specify target files tomonitor. You can specify folders to capture all files within
them. No file is specified by default, which means no file is captured by default.
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Note:

• To capture renaming, creation, deletion, or moving operations on a file, add
the path string of the file folder (not the file name or the root path of the
file folder) in the File monitoring list. For example, to capture renaming,
creation, deletion, and moving operations on the sharing.ppt file in C:\
User\File, add the path string C:\User\File in the File monitoring
list.

• Both local file paths and remote shared folder paths are supported. For exam‑
ple, to capture operations on the RemoteDocument.txt file in the \\remote
.address\Documents folder, add the path string \\remote.address
\Documents in the File monitoring list.

• Separate monitored paths with a semicolon (;).
• Only exact matches are supported. Wildcards aren’t supported.
• Path strings are case‑insensitive.

Limitations:

• Copying files or folders from a monitored folder to an unmonitored folder isn’t
captured.

• When the length of a file or folder path including the file or folder name exceeds
260 characters, operations on the file or folder aren’t captured.

• Pay attention to thedatabase size. Toprevent largenumbers of events frombeing
captured, back up or delete the “Event”table regularly.

• When large numbers of events are captured in a short time, the player displays
and the database stores only one event for each type to avoid storage expansion.

• Log web browsing activities: Logs user activities on supported browsers and tags
the browser name, URL, and page title in the recording.

List of supported browsers:

• Google Chrome
• Microsoft Edge Chromium
• Mozilla Firefox

• Log topmostwindowevents: Logs the topmostwindowevents and tags the process
name, title, and process number in the recording.
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• Log clipboard activities: Logs copy operations of text, images, and files using the
clipboard. The process name and file path are logged for a file copy. The process
name and title are logged for a text copy. The process name is logged for an image
copy.

• Log registrymodifications: Logs the followingWindows registrymodifications: add
a key or value, rename a key or value, change an existing value, and delete a key or
value.

• Registry monitoring list: When you select Log registry modifications, type
the absolute paths of the registries you want to monitor and separate the paths
with a semicolon (;). Start a path with HKEY_USERS, HKEY_LOCAL_MACHINE,
or HKEY_CLASSES_ROOT. For example, you can type HKEY_LOCAL_MACHINE\
SOFTWARE\Microsoft\Windows;HKEY_CLASSES_ROOT\GuestStateVDev
. If you leave this list unspecified, no registry modification is captured.

• Log app failures: Logs unexpected app exits and unresponsive apps. This rule ap‑
plies to all apps.

• Log user account modifications: Logs the following user account modifications:
account creation, enablement, disablement, deletion, lockout, name changes, and
passwordmodification attempts.

• Log RDP connections: Logs RDP connections initiated from the VDA hosting the
recorded session.

• Log app installs and uninstalls: Logs app installs and uninstalls during the recorded
session. This rule applies to all apps.

• Log performance data: Enables the session data overlay feature. Select this check
box to view data points related to the recorded session.
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• Log popup windows: Logs popup windows that might appear when users open or
close a confidential file or access a folder.

• Log printing activities: Logs printing activities that occur during recorded sessions.
Session Recording captures details about printed content, including file name, file
size, author, printer name, timestamp, andmore. You can choose to savea copyof the
printed files along with the recordings for future reference and auditing. This feature
allows for greater oversight and auditing of printing activity within recorded sessions.

b) Select and edit the rule criteria.

Similar to creating a custom recording policy, you can choose one or more rule criteria:

• Users or Groups
• Published Applications or Desktop
• Delivery Groups or Machines
• IP Address or IP Range
• Filter

To obtain the lists of published applications or desktops and delivery groups or VDA ma‑
chines, youmust have the read permission as a site administrator. Configure the adminis‑
trator read permission on the Delivery Controller™ of the site.

Formore information, see the instructions in the Create a custom recording policy section.

Note:

Somesessionsmightnotmeet any rule criteria in aneventdetectionpolicy. For these
sessions, the action of the fallback rule applies, which is always Do not detect. You
cannot modify or delete the fallback rule.

c) Follow the wizard to complete the configuration.
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After a session that matches an event detection policy starts, the session ID and its event registry val‑
ues appear in the Session Recording agent. For example:
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Compatibility with registry configurations

When Session Recording is newly installed or upgraded, no active event detection policy is avail‑
able by default. In this case, each Session Recording agent respects the registry values under
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents to deter‑
mine whether to log specific events. For a description of the registry values, see the following
table:

Registry Value Description

EnableSessionEvents 1: enables event detection
globally; 0: disables event
detection globally (default
value data).

EnableAccountChangeEvents 1: enables detecting user
account modifications; 0:
disables detecting user account
modifications (default value
data).

EnableAppChangeEvents 1: enables detecting app
installs and uninstalls; 0:
disables detecting app installs
and uninstalls (default value
data).

EnableAppFaultEvents 1: enables detecting app
failures; 0: disables detecting
app failures (default value
data).

EnableAppLaunchEvents 1: enables detecting only app
starts; 2: enables detecting
both app starts and ends; 0:
disables detecting app starts
and ends (default value data).

AppMonitorList Specifies target apps to
monitor. No app is specified by
default, which means no app is
captured by default.
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Registry Value Description

EnableCDMUSBDriveEvents 1: enables detecting the
insertion of CDMmapped USB
mass storage devices; 0:
disables detecting the insertion
of CDMmapped USBmass
storage devices (default value
data).

EnableClipboardEvents 1: enables detecting clipboard
activities; 0: disables detecting
clipboard activities (default
value data).

EnableFileOperationMonitorEvents1: enables detecting file
operations; 0: disables
detecting file operations
(default value data).

FileOperationMonitorList Specifies target folders to
monitor. No folder is specified
by default, which means no file
operation is captured by
default.

EnableGenericUSBDriveEvents 1: enables detecting the
insertion of generic redirected
USBmass storage devices; 0:
disables detecting the insertion
of generic redirected USBmass
storage devices (default value
data).

EnablePerfDataEvents 1: enables the session data
overlay feature; 0: disables the
session data overlay feature
(default value data).

EnablePopupWindowEvents 1: enables detecting popup
window events; 0: disables
detecting popup window
events (default value data).
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Registry Value Description

EnableRDPConnectionEvents 1: enables detecting RDP
connections; 0: disables
detecting RDP connections
(default value data).

EnableRegistryOperationMonitorEvents1: enables detecting Windows
registry modifications; 0:
disables detecting Windows
registry modifications (default
value data).

RegistryOperationMonitorList Specifies target registries to
monitor. No registry is
specified by default, which
means no registry modification
is captured by default.

EnableWebBrowsingActivities 1: enables detecting web
browsing activities; 0: disables
detecting web browsing
activities (default value data).

EnablePrintingEvents 1: enables detecting printing
activities; 0: disables detecting
printing activities (default
value data).

Here are some compatible scenarios:

• If your Session Recording is newly installed or upgraded from a release earlier than 1811 that
doesn’t support event detection (logging), the related registry values on each Session Record‑
ing agent are thedefault. Because there is no active event detectionpolicy bydefault, no events
are logged.

• If your Session Recording is upgraded from a release earlier than 1811 that supports event de‑
tection but has the feature disabled before your upgrade, the related registry values on each
Session Recording agent remain the default. Because there is no active event detection policy
by default, no events are logged.

• If your Session Recording is upgraded from a release earlier than 1811 that supports event de‑
tection and has the feature partially or fully enabled before your upgrade, the related registry
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values on each Session Recording agent remain the same. Because there is no active event de‑
tection policy by default, the event detection behavior remains the same.

• If your Session Recording is upgraded from 1811, the event detection (logging) policies config‑
ured in the policy console remain in use.

Caution:

Activating the system‑defined or a custom event detection policy means to ignore the relevant
registry settings on each Session Recording agent. If you do so, you can’t use registry settings
for event detection any more.

Configure event response policies

April 1, 2026

You can sendanemail alertwhena session start is detected and take the following actions in response
to logged events in recorded sessions:

• Send email alerts
• Start screen recording immediately (with or without lossy screen recording enabled)
• Lock session
• Log off session
• Disconnect session

Note:

If the Lock session action doesn’t work as expected, check the following registry keys on the
VDA and ensure that there is no registry value under them or the value data is set to 0.

• HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System
• HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\System

The only system‑defined event response policy is Do not respond. You can create custom event re‑
sponse policies as needed. Only one event response policy can be active at a time.

For an example email alert, see the following screen capture:
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Tip:

Clicking the playback URL opens the playback page of the recorded session in the web player.
Clicking here opens the All recordings page in the web player.

Session Recording sends email alerts in the operating system language of your Session Recording
server. However, if the operating system language of your Session Recording server is not one of the
following languages that Session Recording supports, email alerts are sent in English by default:

• English
• French
• German
• Spanish
• Japanese
• Simplified Chinese

To customize a language to sendemail alerts in, find the email template calledtemplate.en.html
under<Session Recording server installation path>\Bin\templates, and then
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change the plain text in the template to your preferred language. For example:

System‑defined event response policy

Session Recording provides one system‑defined event response policy:

• Do not respond. By default, no action is taken in response to logged events in your recordings.

Create a custom event response policy

1. Log on as an authorized policy administrator to the server where the Session Recording policy
console is installed.

2. Start the Session Recording policy console. By default, there is no active event response policy.
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3. Select Event Response Policies in the left pane. From themenu bar, choose Add New Policy.

4. (Optional) Right‑click the new event response policy and rename it.

5. Right‑click the new event response policy and select Add Rule.

6. Select Email alert when a session start is detected and Use event triggers to specify how
to respondwhen a session event is detected based on your needs.

7. (Optional) Set email recipients and the email sender properties.

a) Type the email addresses for the alert recipients in the Ruleswizard.

b) Configure outgoing email settings in the Session Recording Server Properties.
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Note:

If you select more than two options in the Email title section, a warning dialog ap‑
pears, saying that theemail subjectmightbe too long. After youselectAllowsending
email notifications and clickApply, Session Recording sends an email to verify your
email settings. If any setting is incorrect, for example, an incorrect password or port,
Session Recording returns an error message with the error details.

Your email settings need about five minutes to take effect. To have your email set‑
tings take effect immediately or fix the issue that emails are not sent according to the
settings, restart the Storage Manager (CitrixSsRecStorageManager) service.
Also, restart the Storage Manager service if you upgrade to the current release from
Version 2006 and earlier.

c) Edit the registry for accessing the web player.

To make the playback URLs in your alert emails work as expected, browse to the registry
key at HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server and
do the following:

• Set the value data of LinkHost to the URL of the domain that you use to access the
web player. For example, to access a web player at https://example.com/
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webplayer/#/player/, set the value data of LinkHost to https://example
.com.

• Add a value EmailThreshold, and set its value data to a number in the range of 1
through 100. The value data determines the maximum number of alert emails that
an email sending account sends within a second. This setting helps slow down the
number of emails that are being sent and thus reduces the CPU usage. If you leave
the value data unspecified or set it to a number out of range, the value data falls back
to 25.

Note:

• Your email server might treat an email sending account as a spam bot and thus
prevent it from sending emails. Before an account is allowed to send emails, an
email client such as Outlookmight request you to verify that the account is used
by a human user.

• There is a limit for sending emails within a given period. For example, when the
daily limit is reached, youcannot sendemailsuntil the startof thenextday. In this
case, ensure that the limit is more than the number of sessions being recorded
within the period.

8. (Optional) Configure event triggers and responses.

After you select Trigger response actions when a session event is detected, the Configure
event triggers and responses button becomes available. Click it to specify logged events that
can trigger the following response actions:

• Send email alerts
• Start screen recording immediately
• Lock session
• Log off session
• Disconnect session

Note:

If your system language is German, French, or Spanish, ensure that the horizontal reso‑
lution of your machine is equal to or larger than 1,700 pixels. Otherwise, text truncation
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occurs and thus the columns of the Event Triggers table are not displayed completely.

Youmust select the event types that the active event detection policy logs. Click Confirm
when you are finished.

Select event types from the drop‑down list and set event rules through the two dimensions
that are combined using the logical AND operator. You can set up to seven event triggers for
each policy rule. You can also define your event triggers in the Description column or leave
the column empty. Your defined description of an event trigger is provided in the alert emails
if you have Send email selected and events of the type are logged. If you have Start screen
recording selected, dynamic screen recording automatically starts when certain events occur
during an event‑only recording.

In the Pause event response after session start (sec) section, specify howmany seconds (up
to 300) you want to pause event response after a session starts.

You can enable lossy screen recording and set the time spans for dynamic screen recording:

• Screen recording time span afterwedetect an event: You can configure howmanymin‑
utes youwant to record the screen after events are detected. If you leave the value unspec‑
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ified, screen recording continues until the recorded sessions end.

• Screen recording time span before we detect an event: You can configure how many
seconds of the screen recording youwant to keep before events are detected. This feature
is available for both virtual desktop and app sessions. The value ranges from 1 to 120.
Setting the value to any of 1 through 10makes the value 10 effective. If you leave the value
unspecified, the feature does not take effect. The actual length of the screen recording
that Session Recording keeps might be a little longer than your configuration.

• If you specify any of the following actions in response to logged events in recorded ses‑
sions, you can notify users of the actions by filling the Time interval between a session
operation notice and its execution field:

• Lock session
• Log off session
• Disconnect session

Note:

The field value is 0 by default, whichmeans users are not notified when you lock, log
off, or disconnect them from their virtual sessions. To notify users, set an appropriate
field value.

For an example notice, see the following screen capture:

• Enable Lossy screen recording: Lossy screen recording lets you adjust compression op‑
tions to reduce the size of recording files and to accelerate navigating recorded sessions
during playback. For more information, see Enable or disable lossy screen recording.

For a complete list of supported event types, see the following table.

Event type Dimension Option

App Start

App name Includes, Equals, Matches
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Event type Dimension Option

Full command line Includes, Equals, Matches

App End

App name Includes, Equals, Matches

Top Most

App name Includes, Equals, Matches

Windows title Includes, Equals, Matches

Web Browsing

URL Includes, Equals, Matches

Tab title Includes, Equals, Matches

Browser name Includes, Equals, Matches

File Create

Path Includes, Equals, Matches

File size (MB) Greater than, Between, Smaller
than

File Rename

Path Includes, Equals, Matches

Name Includes, Equals, Matches

File Move

Source path Includes, Equals, Matches

Destination path Includes, Equals, Matches

File size (MB) Greater than, Between, Smaller
than

File Delete

Path Includes, Equals, Matches

File size (MB) Greater than, Between, Smaller
than

CDM USB

Drive letter Equals

Generic USB

Device name Includes, Equals, Matches
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Event type Dimension Option

Idle

Idle duration (Mins) Greater than

File Transfer

File source Equals (“host”or “client”)

File size (MB) Greater than

File name Includes, Equals, Matches

Registry Create

Key name Includes, Equals, Matches

Registry Delete

Key name Includes, Equals, Matches

Registry Set Value

Key name Includes, Equals, Matches

Value name Includes, Equals, Matches

Registry Delete Value

Key name Includes, Equals, Matches

Value name Includes, Equals, Matches

Registry Rename

Key name Includes, Equals, Matches

User Account Modification

User name Includes, Equals, Matches

Unexpected App Exit

App name Includes, Equals, Matches

App Not Responding

App name Includes, Equals, Matches

New App Installed

App name Includes, Equals, Matches

App Uninstalled

App name Includes, Equals, Matches

RDP Connection
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Event type Dimension Option

IP address Includes, Equals, Matches

PopupWindow

Process name Includes, Matches

Window content Includes, Equals, Matches

Performance Data

CPU usage (%) Greater than

Memory usage (%) Greater than

Net send (MB) Greater than

Net receive (MB) Greater than

RTT (ms) Greater than

Clipboard Operation

Data type Equals (Text, File, Bitmap)

Process name Includes, Equals, Matches

Content Includes, Equals, Matches

9. ClickNext to select and edit the rule criteria.
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• Users or Groups. Creates a list of users or groups to which the rule applies.

• Published Applications or Desktop. Creates a list of published applications or desktops
to which the rule applies.

• Delivery Groups or Machines. Creates a list of Delivery Groups or machines to which the
rule applies.

• IP Address or IP Range. Creates a list of IP addresses or ranges of IP addresses to which
the rule applies. The IP addresses mentioned here are the IP addresses of the Citrix Work‑
space™ apps.

• Filter. Creates a list of smart access tags to which the rule applies. You can configure
contextual access (smart access) using smart access policies on Citrix NetScaler.

Contextual access (smart access) is available for Session Recording 2402 and later. It
lets you apply policies based on the user access context including:

• The user’s location
• IP address range
• Delivery group
• Device type
• Installed applications

Note:

When a session or an eventmeetsmore than one rule in a single event response policy, the
oldest rule takes effect.

10. Follow the wizard to complete the configuration.

11. Activate the new event response policy.

High availability and load balancing

June 21, 2024

This section guides you through the following settings:
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• Load balance Session Recording servers
• Configure database high availability

Load balance Session Recording servers

September 7, 2025

Session Recording supports load balancing across Session Recording servers. This article summa‑
rizes the load balancing configuration using the Citrix ADC as an example. Formore information, see
Configure load balancing in an existing deployment and Deploy and load balance Session Recording
in Azure.

You can synchronize load balancing configurations among all Session Recording servers.

Note:

The load balancing feature requires Version 7.16 or later of the Session Recording server and
Session Recording agent.

Changes to Session Recording in support of load balancing:

• All Session Recording servers share one folder to store recording files.
• All Session Recording servers share one Session Recording Database.
• (Recommended) Install only one Session Recording policy console and all Session Recording
servers share this console.

Configure load balancing

To use this feature, perform the following steps on Citrix ADC and on the various Session Recording
components:

Configure load balancing (Citrix ADC part)

Configure load balancing servers Add the Session Recording servers to the load balancing
servers in Citrix ADC.

Configure load balancing services

1. Add a load balancing service for each needed protocol on each Session Recording server.
2. (Recommended) Select the relevant protocol monitor to bind each service monitor.
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Configure load balancing virtual servers

1. Create virtual servers with the same Citrix ADC VIP address based on the needed protocols and
bind the virtual servers to the relevant load balancing services.

2. Configure persistence on each virtual server.
3. (Recommended) Choose LEASTBANDWITH or LEASTPACKETS as the load balancing method

rather than the default method (LEASTCONNECTION).
4. Create a certificate to make the HTTPS virtual server UP.

Configure load balancing (Session Recording part)

On each server where you installed the Session Recording server, do the following

1. (Recommended) Type the same Session Recording Database name during the Session Record‑
ing server installation.

2. If you choose the Administrator Logging feature, we recommend you type the same Administra‑
tor Logging Database name when you install each Session Recording server.

3. Share the Read/Write permission of the file storage folder with all Session Recording serverma‑
chine accounts. After that, change to use the file storage folder as the shared folder in Ses‑
sion Recording Server Properties. For more information, see Specify where recordings are
restored.

4. Add a value to the Session Recording server registry key at HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server.
Value name: EnableLB
Value data: 1 (DWORD, meaning enable)

5. If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager
message queue, create a host record for the Citrix ADC VIP address and add redirections in
C:\Windows\System32\msmq\Mapping\sample_map. After that, restart the Message
Queuing service.

The redirection is similar to:

1 <redirections xmlns="msmq-queue-redirections.xml">
2 <redirection>
3 <from>http://<ADCHost>/msmq/private$/

CitrixSmAudData</from>
4 <to>http://<LocalFqdn>/msmq/private$/

CitrixSmAudData</to>
5 </redirection>
6 <redirection>
7 <from>https://<ADCHost>/msmq/private$/

CitrixSmAudData</from>
8 <to>https://<LocalFqdn>/msmq/private$/

CitrixSmAudData</to>
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9 </redirection>
10 </redirections>

Where <ADCHost> is the created FQDN of the Citrix ADC VIP address, and <LocalFqdn> is the
FQDN of the local host.

6. (Recommended) After configuring one Session Recording server registry, you can use the
<Session Recording Server installation path>\Scripts\SrServerConfigurationSync.ps1
script to export configurations from this server registry and import the registry to the other
Session Recording server registries. You can also use the SrServerConfigurationSync.ps1
script to add redirection mapping for message queuing.

a) On one Session Recording server, after configuring the EnableLB registry value, start a
command prompt as an administrator and run the powershell.exe ‑file SrServerCon‑
figurationSync.ps1 –Action Export,AddRedirection –ADCHost <ADCHost> command,
where <ADCHost> is the created FQDN of the Citrix ADC VIP address.

b) After the script runs, an exported registry file namedSrServerConfig.reg is generated and
an sr_lb_map.xml file is added to the C:\Windows\System32\msmq\Mapping path.

c) On other Session Recording servers, copy SrServerConfig.reg generated in the preced‑
ing step, start a command prompt as an administrator, and run the powershell.exe ‑
file SrServerConfigurationSync.ps1 –Action Import,AddRedirection –ADCHost <AD‑
CHost> command, where <ADCHost> is the created FQDN of the Citrix ADC VIP address.

d) After the script runs, the EnableLB value is added to the other Session Recording server
registrykeysandansr_lb_map.xml file is added to theC:\Windows\System32\msmq\Mapping
path.

On the machine where you installed the Session Recording agent, do the following in Session
Recording Agent Properties

• If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager mes‑
sage queue, type the FQDN of the Citrix ADC VIP address in the Session Recording Server text
box.

• If you choose the default TCP protocol for the Session Recording Storage Manager message
queue, type the Citrix ADC VIP address or FQDN in the Session Recording Server text box.

On the machine where you installed the Session Recording Player, do the following Add the
Citrix ADC VIP address or its FQDN as the connected Session Recording server.

On the SQL Server where you installed the Session Recording Database, do the following Add
all the Session Recording server machine accounts to the shared Session Recording Database and
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assign themwith the db_owner permission.

Configure database high availability

September 7, 2025

Session Recording does not function as expected if the Session Recording database is stopped or in a
state of failure. If the Session Recording Administrator Logging database is stopped or experiencing
failure, the administrator logging feature becomes unavailable and this prevents you from being able
to modify policies or change server properties when mandatory blocking is enabled. Therefore, it is
advisable to implement a high availability (HA) mode for the databases.

Session Recording supports the following solutions for database high availability based on the Mi‑
crosoft SQL Server. Databases can automatically fail over when the hardware or software of a princi‑
pal or primary SQL Server fails.

• Always On availability groups

The Always On availability groups feature is a high availability and disaster‑recovery solution
that provides anenterprise‑level alternative todatabasemirroring. Itmaximizes the availability
of a set of user databases for an enterprise. It requires that the SQL Server instances reside on
the Windows Server Failover Clustering (WSFC) nodes. For more information, see Always On
availability groups: a high‑availability and disaster‑recovery solution.

• SQL Server clustering

The Microsoft SQL clustering technology allows one server to automatically take over the tasks
and responsibilities of the server that has failed. However, setting up this solution is compli‑
cated and the automatic failover is typically slower than alternatives such as SQL Server data‑
base mirroring. For more information, see Always On Failover Cluster Instances (SQL Server).

• SQL Server database mirroring

Database mirroring ensures that an automatic failover occurs in seconds if the active database
server fails. This solution ismoreexpensive than theother twosolutionsbecause full SQLServer
licenses are required on each database server. You cannot use the SQL Server Express edition
in a mirrored environment. For more information, see Database Mirroring (SQL Server).

Methods for configuring Session Recording with database high availability

To configure Session Recording with database high availability, do either of the following:
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• Install the Session Recording Server components first and then configure database high avail‑
ability for the created databases.
You can install the Session Recording Administration componentswith databases configured to
be installed on the prepared SQL Server instance. Then, configure database high availability for
the created databases.

• For Always On availability groups and clustering, change the SQL Server instance
name to the name of the availability group listener or SQL Server network through
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\SmAudDatabaseInstance
.

• Fordatabasemirroring, add the failoverpartners fordatabases throughHKEY_LOCAL_MACHINE
\SOFTWARE\Citrix\SmartAuditor\Server\DatabaseFailoverPartner
and HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\
LoggingDatabaseFailoverPartner.

• Configure database high availability for empty databases first and then install the Session
Recording Administration components.
You can create two empty databases as the Session Recording Database and the Administrator
Logging Database in the expected primary SQL Server instance and configure high availability.
Then enter the SQL Server instance name when installing the Session Recording Server
components:

• Touse theAlwaysOnavailability groups solution, enter thenameof your availability group
listener.

• To use the database mirroring solution, enter the name of your principal SQL Server.
• To use the clustering solution, enter the network name of your SQL Server.

View recordings

December 4, 2024

You can use the Session Recording player or the Session Recording web player to view, search, and
bookmark recorded sessions.

If sessions are recorded with the live playback feature enabled, you can view sessions that are in
progress, with a delay of 1‑2 seconds.

Sessions that have a longer duration or larger file size than the limits configured appear in more than
one session file.
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Note:

Grant users the right to access the recorded sessions of Virtual Delivery Agents (VDAs).

Session Recording player

June 21, 2024

The Session Recording player is a user interface that you access from a workstation to play
recorded session files. This section provides instructions for you to:

• Launch the Session Recording player
• Enable or disable live session playback
• Enable or disable playback protection
• Search for recordings
• Open and play recordings
• Cache recordings
• Highlight idle periods
• Use events and bookmarks

Launch the Session Recording Player

September 7, 2025

Launch the Session Recording player

Note:

• If a recording contains blocked content, Session Recording skips it. However, if you navi‑
gate to the blocked period, your playback shows a black screen and a message indicating
that that content is blocked. To use this feature, use Session Recording 2012 and later.

• If you are using the Session Recording player 2009 and earlier to play back a recording, the
following error message appears. The web player is not impacted.
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• If playback justification logging is enabled, each time you play a recording, a dialog box
appears, asking you to enter a playback justification. For more information, see Playback
logging.

1. Log on to the workstation where the Session Recording player is installed.

2. From the Start menu, choose Session Recording Player. The Session Recording player ap‑
pears.

Tip:

• To customize columns to display, right‑click the table header.

• TheAudioRecording column indicateswhether audio in the recorded session is avail‑
able during playback.

• The EventOnly column indicates a screen recording or an event‑only recording.

The following screen capture shows an example of an event‑only recording being
played in the Session Recording Player. All events are present in the Events and
Bookmarks panel and show as yellow dots in the lower part of the Session Recording
Player.
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• To show all recording files of a recorded session, right‑click a recording on the list and
choose Follow up.

Display or hide window elements

The Session Recording player has window elements that toggle on and off.
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1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View.
4. Choose the elements that you want to display. Selecting an element causes it to appear imme‑

diately. A check mark indicates that the element is selected.

Connect to the desired Session Recording Server

You can set up your Session Recording player to connect to multiple Session Recording servers and
then select a Session Recording server that it connects to. The Session Recording player can connect
to only one Session Recording Server at a time.

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools > Options > Connections.
4. Select the Session Recording server to which you want to connect.

Enable or disable live session playback

September 7, 2025

If sessions are recorded with the live playback feature enabled, you can view a session after or while
it is being recorded. Viewing a session that is being recorded is similar to seeing actions happening
live. However, there is actually a delay of 1‑2 seconds when the data propagates from the VDA.

Some functionality is not available when you view live playback sessions:

• You can’t assign a digital signature or view the certificate until the recording is completed.
• Playback protection can’t be applied until recording is complete. If playback protection is en‑
abled, you can view live playback sessions. But they are not encrypted until the session is com‑
pleted.

• You can’t cache a file until the recording is completed.

By default, live session playback is enabled.

1. Log on to the computer hosting the Session Recording server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Playback tab.
4. Select or clear the Allow live session playback check box.
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Enable or disable playback protection

June 21, 2024

As a security precaution, Session Recording automatically encrypts recorded files that are down‑
loaded for viewing in the player. Encrypted files can’t be copied or played on another workstation
or by another user. Encrypted files are identified with an .icle extension. Unencrypted files are
identifiedwith an.icl extension. The files remain encryptedwhile they reside in%localAppData
%\Citrix\SessionRecording\Player\Cache on the player until an authorized user opens
them.

We recommend that you use HTTPS to protect the transfer of data.

By default, playback protection is enabled.

1. Log on to the machine hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Playback tab.
4. Select or clear the Encrypt session recording files downloaded for playback check box.

Search for recordings

September 7, 2025

The Session Recording player allows you to perform quick and advanced searches and to specify op‑
tions that apply to all searches. Results of searches appear in the search results area of the Session
Recording player.

Note:

The player installation typically lets you set up a connection between the Session Recording
player and a Session Recording server. If you fail to set up the connection, you are prompted
to do so the first time you perform a search for files.

To display all available recorded sessions, up to the maximum number of sessions that might
appear in a search, perform a search without specifying any search parameters.

Perform a quick search

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
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3. Define your search criteria:

• Enter a search criterion in the Search field.
• Move the mouse pointer over the Search label to display a list of parameters to use as a
guideline.

• Click the arrow to the right of the Search field to display the text for the last 64 searches
you performed.

• Use the drop‑down list to the right of the Search field to select a period or duration speci‑
fying when the session was recorded.

4. Click the binocular icon to the right of the drop‑down list to start the search.

Perform an advanced search

Advanced searches might take up to 20 seconds to return results containing more than 150,000 enti‑
ties. Citrix® recommendsusingmoreaccurate search conditions suchas adate rangeoruser to reduce
the result number.

1. Log on to the workstation where the Session Recording player is installed.

2. From the Startmenu, choose Session Recording Player.

3. In the Session Recording Player window, click Advanced Search on the tool bar or choose
Tools > Advanced Search.

4. Define your search criteria on the tabs of the Advanced Search dialog box:

• Common allows you to search by domain or account authority, site, group, VDA for multi‑
session OS, application, or file ID.

• Date/Time allows you to search date, day of week, and time of day.
• Events allows you to search for Citrix‑defined and custom events that are inserted to the
sessions.

• Other allows you to search by session name, client name, client address, and recording
duration. It also allows you to specify, for this search, the maximum number of search
results displayed and whether archived files are included in the search.
When you specify search criteria, the query you are creating appears in the pane at the
bottom of the dialog box.

5. Click Search to start the search.

You can save and retrieve advanced search queries. Click Save in the Advanced Search dialog
box to save the current query. ClickOpen in theAdvancedSearchdialogbox to retrieve a saved
query. Queries are saved as files with an .isq extension.
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Set search options

The Session Recording player search options allow you to limit the maximum number of session
recordings that appear in search results and to specify whether search results include archived
session files.

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools > Options > Search.
4. In theMaximum result to display field, type the number of search results you want to display.

A maximum of 500 results can be displayed.
5. To set whether archived files are included in searches, select or clear Include archived files.

Place access restrictions on recordings

June 21, 2024

You place access restrictions on target recordings in addition to role‑based access control through
recording viewing policies. Restricted recordings are accessible only to users and user groups that
are assigned the PrivilegedPlayer role through the Session Recording Authorization Console.

Note:

Placing access restrictions on live recordings is not supported.
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The following section walks you through the process of placing and removing access restrictions on
target recordings.

1. Log on to the machine where the Session Recording player is installed.

2. From the Startmenu, choose Session Recording Player.

3. Select Search Results in theWorkspace pane.

4. In the Search Results area, select one or more target recordings.

5. Right‑click and select Place access restrictions.

Users and user groups, assigned either the Player or the PrivilegedPlayer role, are allowed
to place access restrictions on recordings. The Restrictedmenu is available only for users and
user groups assigned the PrivilegedPlayer role.

View for the PrivilegedPlayer role:
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View for the Player role:

6. Click Yes.

7. Verify that the selected recordings on which you placed access restrictions are moved from the
Search Results area to the Restricted area.
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8. In theRestricted area, remove access restrictions as needed. With access restrictions removed,
recordings are moved back to the Search Results area.

Open and play recordings

September 7, 2025

Open recordings

You can open session recordings in the Session Recording player in three ways:

• Perform a search using the Session Recording player. Recorded sessions that meet the search
criteria appear in the search results area.

• Access recorded session files directly from your local disk drive or a shared drive.
• Access recorded session files from a Favorites folder.
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When you open a file that was recorded without a digital signature, a warning message appears. It
says that the origin and integrity of the file were not verified. If you are confident of the integrity of
the file, click Yes in the warning window to open the file.

If playback justification logging is enabled, each time you play a recording, a dialog box appears, ask‑
ing you to enter a playback justification. For more information, see Playback logging.

The Session Recording player checks the Citrix Workspace™ app version before playing back a
recorded session. If the player doesn’t support the Citrix Workspace app version, an error is returned.
To eliminate the error, select Skip Citrix Workspace app version check in Session Recording
Server Properties.
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Note:

The Administrator Logging feature of Session Recording allows you to log the downloads of
recordings in the Session Recording player. For more information, see Administrator Logging.

Open a recording in the search results area

1. Log on to the machine where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Perform a search.
4. If the search results area is not visible, select Search Results in the Workspace pane.
5. In the search results area, select the session you want to play.
6. Do any of the following:

• Double‑click the session.
• Right‑click and select Play.
• From the Session Recording Playermenu bar, choose Play > Play.

Open a recording by accessing the file

The name of a recording file begins with i_, followed by a unique alphanumeric file ID and then the
.icl or .icle extension. The .icl extension denotes the recordings without playback protection
applied. The .icle extension denotes the recordings with playback protection applied. Recorded
session files are saved in a folder that incorporates the date the sessions were recorded. For example,
the file for a session recorded on December 22, 2014, is saved in the folder path 2014\12\22.

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Do any of the following:

• From theSessionRecordingPlayermenubar, choose File >Open and browse for the file.
• Using Windows Explorer, navigate to the file and drag the file to the Playerwindow.
• Using Windows Explorer, navigate to and double‑click the file.
• If you created Favorites in theWorkspace pane, selectFavorites andopen the file from the
Favorites area in the same way you open files from the search results area.

Use favorites

Creating theFavorites folders allows you toquickly access recordings that you view frequently. These
Favorites folders reference recorded session files that are stored on yourworkstation or on a network
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drive. You can import and export these files to other workstations and share these folders with other
Session Recording player users.

Note:

Only userswith access rights to the SessionRecordingplayer candownload the recorded session
files associatedwith theFavorites folders. Contact your SessionRecording administrator for the
access rights.

To create a Favorites subfolder:

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. In the Session Recording Playerwindow, select the Favorites folder in your Workspace pane.
4. From the menu bar, choose File > Folder > New Folder. A new folder appears under the Fa‑

vorites folder.
5. Type the folder name, then press Enter or click anywhere to accept the new name.

Use the other options that appear in the File > Foldermenu to delete, rename, move, copy, import,
and export the folders.

Play recordings

After you open a recorded session in the Session Recording player, you can navigate through the
recorded sessions using these methods:

• Use the player controls to play, stop, pause, and increase or decrease playback speed.
• Use the seek slider to move forward or backward.

You can also navigate through the recorded session by going to the inserted markers and custom
events.

Note:

• During playback of a recorded session, a secondmouse pointer might appear. The second
pointer appears at the point in the recording when the user navigated within Internet Ex‑
plorer and clicked an image that was originally larger than the screen but was scaled down
automatically by Internet Explorer. While only one pointer appears during the session, two
might appear during playback.

• This version of Session Recording doesn’t support SpeedScreen Multimedia Acceleration
and the Flash quality adjustment policy setting. When this option is enabled, playback dis‑
plays a black square.
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• Whenyou recorda sessionwitha resolutionhigher thanorequal to4096x4096, theremight
be fragments in the recording appearance.

Use the player controls

You can click the player controls in the lower part of the player window or access them by choosing
Play from the Session Recording Playermenu bar.

Player Control Function

Plays the selected session file.

Pauses playback.

Stops playback. If you click Stop, then Play, the
recording restarts at the beginning of the file.

Halves the current playback speed down to a
minimum of one‑quarter of the normal speed.

Doubles the current playback speed up to a
maximum of 32 times the normal speed.

Use the seek slider

Use the seek slider in the lower part of the player window to jump to a different position within the
recorded session. You can drag the seek slider to the point in the recording you want to view or click
anywhere on the slider bar to move to that location.

You can also use the following keyboard keys to control the seek slider:

Keyboard Key Function

Home Seeks to the beginning.

End Seeks to the end.

Right Arrow Seeks forward five seconds.

Left Arrow Seeks backward five seconds.

Move the mouse wheel one notch down Seeks forward 15 seconds.

Move the mouse wheel one notch up Seeks backward 15 seconds.

Ctrl + Right Arrow Seeks forward 30 seconds.
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Keyboard Key Function

Ctrl + Left Arrow Seeks backward 30 seconds.

Page Down Seeks forward oneminute.

Page Up Seeks backward oneminute.

Ctrl + Move the mouse wheel one notch down Seeks forward 90 seconds.

Ctrl + Move the mouse wheel one notch up Seeks backward 90 seconds.

Ctrl + Page Down Seeks forward six minutes.

Ctrl + Page Up Seeks backward six minutes.

To adjust the speed of the seek slider: From the Session Recording Playermenu bar, choose Tools >
Options>Playeranddrag the slider to increaseordecrease the seek response time. A faster response
time requiresmorememory. The responsemight be slowdepending on the size of the recordings and
your machine’s hardware.

Change the playback speed

You can set a playback speed in exponential increments from one‑quarter normal playback speed to
32 times normal playback speed.

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Play > Play Speed.
4. Choose a speed option.

The speed adjusts immediately. Text indicating the exponential rate appears briefly in green in the
lower part of the player window.

Highlight the idle periods of recorded sessions

Idle periods of a recorded session are the portions inwhich no action takes place. The Session Record‑
ing player can highlight the idle periods of recorded sessions during playback. The option is On by
default. For more information, see Highlight idle periods.

Skip over spaces where no action occurred

Fast review mode allows you to set the player to skip the portions of recorded sessions where no
action takes place. This setting saves time for playback viewing. However, it doesn’t skip animated
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sequences such as animatedmouse pointers, flashing cursors, or displayed clocks with second hand
movements.

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Play > Fast ReviewMode.

The option toggles on and off. Each time you choose it, its status appears briefly in green in the player
window.

Change the playback display

You can do the folloing to change how recorded sessions appear in the player window:

• Pan and scale the image.
• Show playback in full screen
• Display the player window in a separate window
• Display a red border around the recorded session to differentiate it from the player window
background.

Display the player window in full screen

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View > Player Full Screen.
4. To return to the original size, press Esc or F11.

Display the player window in a separate window

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View > Player in Separate Window. A

new window appears, containing the player window. You can drag and resize the window.
4. To embed the player window in the main window, choose View > Player in Separate Window,

or press F10.

Scale the session playback to fit the Player window

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Play > Panning and Scaling > Scale to

Fit.
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• Scale to Fit (Fast Rendering) shrinks images while providing good quality. Images are
drawn quicker than using the High Quality option but the images and texts are not sharp.
Use this option if you are experiencing performance issues when using the High Quality
mode.

• Scale to Fit (High Quality) shrinks images while providing high quality. Using this option
can cause the images to be drawnmore slowly than the Fast Rendering option.

Pan the image

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choosePlay > Panning and Scaling > Panning.

The pointer changes to a hand. And a small representation of the screen appears in the top right
of the player window.

4. Drag the image. The small representation indicates where you are in the image.
5. To stop panning, choose one of the scaling options.

Display a red border around Session Recording

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools > Options > Player.
4. Select the Show border around session recording check box.

If the Show border around session recording check box is not selected, you can temporarily
view the red border by clicking and holding down the left mouse button while the pointer is in
the player window.

Cache recordings

September 7, 2025

Each time you open a recorded session file, the Session Recording player downloads the file from the
location where the recordings are stored. If you download the same files frequently, you can save
download time by caching the files on your workstation. Cached files are stored on your workstation
in this folder:

userprofile\AppData\Local\Citrix\SessionRecording\Player\Cache

You can specify howmuch disk space is used for the cache. When the recordings fill the specified disk
space, Session Recording deletes the oldest, least used recordings to make room for new recordings.
You can empty the cache at any time to free up disk space.
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Enable caching

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools > Options > Cache.
4. Select the Cache downloaded files on local machine check box.
5. To limit the amount of disk space used for caching, select the Limit amount of disk space to

use check box and specify the number of MB to be used for cache.
6. ClickOK.

Empty caches

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools > Options > Cache.
4. Select the Cache downloaded files on local machine check box.
5. In the Session Recording player, choose Tools > Options > Cache.
6. Click Purge Cache andOK to confirm the action.

Highlight idle periods

September 7, 2025

Idle periods of a recorded session are the portions inwhich no action takes place. The Session Record‑
ing player can highlight the idle periods of recorded sessions during playback. The option is On by
default.

Note: Idle periods are not highlighted when playing back live sessions with the Session Recording
player.

To highlight the idle periods of recorded sessions, do the following:

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View > Idle Periods and select or clear

the check box.
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Use events and bookmarks

September 7, 2025

You can use events and bookmarks to help you navigate through recorded sessions.

Citrix‑defined events are inserted to sessions while the sessions are recorded. You can also use the
EventAPI anda third‑party application to insert customevents. Events are savedaspart of the session
file. You cannot delete or alter them using the Session Recording player.

Bookmarks are markers that you insert in a recorded session during session playback using the
Session Recording player. After insertion, bookmarks are associated with the recorded session
until you delete them. However, they are not saved as part of the session file but stored as sep‑
arate .iclb files in the Bookmarks cache folder on the Session Recording player, for example,
C:\Users\SpecificUser\AppData\Local\Citrix\SessionRecording\Player\Bookmarks, with the same
file name as the .icl recording file. To play back a recording using bookmarks on a different player,
copy the .iclb files to the Bookmarks cache folder on that player. By default, each bookmark is
labeled with the text “Bookmark,”but you can change it to any text annotation up to 128 characters
long.

Events appear as yellow dots and bookmarks appear as blue squares in the lower part of the player
window. Moving the mouse over the dots and squares displays the text label associated with them.
You can also display the events and bookmarks in the Events and Bookmarks list of the Session
Recording player. They appear in this list with their text labels and the times in the recorded session
at which they appear, in chronological order.

You can use events and bookmarks to help you navigate through recorded sessions. By going to an
event or bookmark, you can skip to the point in the recorded session where the event or bookmark is
inserted.

Display events and bookmarks in the list

The Events and Bookmarks list displays the events and bookmarks inserted in the recorded session
that is currently playing. It can show events only, bookmarks only, or both.

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Move the mouse pointer to the Events and Bookmarks list area and right‑click to display the

menu.
4. Choose Show Events Only, Show Bookmarks Only, or Show All.
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Insert a bookmark

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Begin playing the recorded session to which you want to add a bookmark.
4. Move the seek slider to the position where you want to insert the bookmark.
5. Move the mouse pointer to the player window area and right‑click to display the menu.
6. Add a bookmark with the default Bookmark label or create an annotation:

• To add a bookmark with the default Bookmark label, choose Add Bookmark.
• To add a bookmark with a descriptive text label that you create, choose Add Annotation.
Type the text label that you want to assign to the bookmark, up to 128 characters. Click
OK.

Add or change an annotation

After a bookmark is created, you can add an annotation to it or change its annotation.

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Begin playing the recorded session containing the bookmark.
4. Ensure that the Events and Bookmarks list is displaying bookmarks.
5. Select the bookmark in the Events and Bookmarks list and right‑click to display the menu.
6. Choose Edit Annotation.
7. In the window that appears, type the new annotation and clickOK.

Delete a bookmark

1. Log on to the workstation where the Session Recording player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Begin playing the recorded session containing the bookmark.
4. Ensure that the Events and Bookmarks list is displaying bookmarks.
5. Select the bookmark in the Events and Bookmarks list and right‑click to display the menu.
6. Choose Delete.

Go to an event or bookmark

Going to an event or bookmark causes the Session Recording player to go to the point in the recorded
session where the event or bookmark is inserted.

1. Log on to the workstation where the Session Recording player is installed.
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2. From the Startmenu, choose Session Recording Player.
3. Begin playing a session recording containing events or bookmarks.
4. Go to an event or bookmark:

• In the lower part of the player window, click the dot or square representing the event or
bookmark to go to the event or bookmark.

• In the Events and Bookmarks list, double‑click the event or bookmark to go to it. To go
to the next event or bookmark, select any event or bookmark from the list, right‑click to
display the menu, and choose Seek to Bookmark.

Session Recording web player

June 21, 2024

The web player lets you use a web browser to view and play back recorded sessions. Using the web
player, you can:

• Search for recordings by using filters.

• View and play back both live and completed recordings with tagged events listed in the right
pane.

• configure cachememory for storing recordings during playback.

• Highlight idle periods.

• Leave comments about a recording and set a severity for each comment.

• Share URLs of recordings.

• View graphical event statistics for each recording.

• View data points related to each recorded session.

Access the web player

June 21, 2024

The URL of the web player website is http(s)://<FQDN of Session Recording server
>/WebPlayer. To ensure the use of HTTPS, add an SSL binding to the website in IIS and update the
SsRecWebSocketServer.config configuration file.
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Note:

• When logging on to the web player website, domain users do not need to enter credentials
while non‑domain users must.

• Supported browsers include Google Chrome, Microsoft Edge, and Firefox.

• To have the web player function properly, make sure you enable WebGL in Firefox.

This article guides you through the process of installing and enabling the web player and the process
of configuring HTTPS.

Install the web player

Install the web player on the Session Recording server only. Double‑click SessionRecordingWeb‑
Player.msi and follow the instructions to complete your installation. For more information about
installing Session Recording, see Install, upgrade, and uninstall.

Starting from Version 2103, Session Recording migrates the WebSocket server to IIS. With the web
player installed, the SessionRecordingRestApiService, SessionRecordingWebStreaming, and
WebPlayer applications appear in IIS.

A fresh installation of Session Recording 2103 and later connects your web browser to theWebSocket
server hosted in IIS when you access the web player website. The WebSocket server hosted in IIS is
versioned 2.0, as indicated by the registry valueWebSocketServerVersion under the registry key at
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
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Anupgrade installation fromanearlier version to SessionRecording 2103 and later connects yourweb
browser to thePython‑basedWebSocket server. To connect to theWebSocket server hosted in IIS, run
the <Session Recording server installation path>\Bin\SsRecUtils.exe ‑enablestreamingservice
command. To connect back to the Python‑based WebSocket server, run the <Session Recording
server installation path>\Bin\SsRecUtils.exe ‑ disablestreamingservice command. The Python‑
based WebSocket server is versioned 1.0.

Enable the web player

The web player is enabled by default.

• To disable the web player, start a Windows command prompt and run the <Session
Recording Server installation path>\Bin\SsRecUtils.exe –disablewebplayer
command.

• To enable the web player, start a Windows command prompt and run the <Session
Recording Server installation path>\Bin\SsRecUtils.exe -enablewebplayer
command.

Configure HTTPS

The URL of the web player website is http(s)://<FQDN of Session Recording server
>/WebPlayer. To ensure the use of HTTPS, add an SSL binding to the website in IIS and update the
SsRecWebSocketServer.config configuration file.
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Note:

When logging on to theweb player website, domain users do not need to enter credentials while
non‑domain users must.

To use HTTPS to access the web player website, complete the following steps:

1. Add an SSL binding in IIS.

a) Obtain an SSL certificate in PEM format from a trusted Certificate Authority (CA).

Note:

Most popular browsers such as Google Chrome and Firefox no longer support the
common name in a Certificate Signing Request (CSR). They enforce Subject Alterna‑
tive Name (SAN) in all publicly trusted certificates. To use theweb player over HTTPS,
take the following actions accordingly:

• When a single Session Recording Server is in use, update the certificate of the
Session Recording Server to a SAN certificate.

• When load balancing is in use, ensure that a SAN certificate is available both on
Citrix ADC and on each Session Recording Server.

b) On IIS, right‑click the website and select Add Bindings. The Site Bindings dialog box ap‑
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pears.

c) Click Add in the upper right corner. The Add Site Binding dialog box appears.

d) Select https from the Type list and select your SSL certificate.

e) ClickOK.

2. Update the SsRecWebSocketServer.config configuration file.

a) Locate and open the SsRecWebSocketServer.config configuration file.

The SsRecWebSocketServer.config configuration file is typically located in the <
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Session Recording Server installation path>\Bin\ folder.

b) Enable TLS by editing TLSEnable=1 and ignore the ServerPort, SSLCert, and SSLKey
fields.

c) Save your changes.

Hide or show content on the web player home page

September 14, 2024

After you log on, the web player home pagemight hide or show content based onwhether the follow‑
ing option is selected in Session Recording Server Properties.

• With the option selected, the web player home page hides all content. Recordings can be ac‑
cessed only by way of their URLs. Recording URLs are provided in email alerts that are sent to
specified recipients. For information about email alerts, see Configure event response policies.
You can also share recording URLs through the Share Current Playback control on recording
playback pages. See descriptions later in this article.
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• With the option unselected, the web player home page shows content similar to the following
screen capture. Click All Recordings in the left navigation to refresh the page and display new
recordings if there are any. Scroll down the webpage to select recordings to view or use filters
to customize your search results. For live recordings, the Duration column shows Live and the
play button appears green.

Note:

Starting with 2411, the Diagnostic Logging menu is available in the left navigation. For
more information, see View diagnostic logging.

To show all recording files of a recorded session, select a recording on the list and click the Follow up
icon. The Follow up icon is available only when a recording is selected.
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For a description of the recording items, see the following table.

Item Description

Start time The recording start time. Click the up and down
arrows to list recordings in chronological order.

User The user whose session was recorded. Click the
up and down arrows to concentrate recordings
of a user on the list and arrange users in
alphabetical order.

Host The host name of the VDA where the recorded
session was hosted. Click the up and down
arrows to arrange the VDA host names in
alphabetical order.

Client The name of the client device where the session
was running. Click the up and down arrows to
arrange the client host names in alphabetical
order.

Events The quantity of events in the recording. Click the
up and down arrows to arrange recordings on
the list by event quantity.

Events Only Indicates a screen recording or an event‑only
recording. An event‑only recording played in the
web player contains an event statistics pie chart
and histogram. The pie chart and histogram
hold static throughout playback.

Recording Server The Session Recording Server that processes
recording data sent from VDAs.

Duration The time length of the recording. Click the up
and down arrows to arrange recordings on the
list by time length.
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Search for recordings

June 21, 2024

Search for recordings by using filters

You can search for recordings byusing filters in thewebplayer. The available filters includehost name,
client name, user name, application, client IP address, event text, event type, and time.

For example, after you select the host name filter, the following dialog box appears. Type in the host
name (of the VDAwhere recorded sessions are hosted) and click Search to filter out irrelevant record‑
ings and display only the relevant ones.

You can change to a different filter by clicking the currently selected Host name, as shown in the
following screen capture. All filters are listed after you click Host name. Select a different filter as
needed.

You can also click the + symbol to add filters.
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For example, you can add the Time filter as shown in the following screen.

The Time filter consists of recording start date, start time, and duration.

Show all recordings of a session

There are two ways to show all recordings of a session in the Session Recording web player:

Method 1:

Select a recording and click the Follow up button to show all recordings of the recorded session.

Method 2:

Select a recording to play and click View playlist in the upper right corner of the playback page.

Place access restrictions on recordings

June 21, 2024

You place access restrictions on target recordings in addition to role‑based access control through
recording viewing policies. Restricted recordings are accessible only to users and user groups that
are assigned the PrivilegedPlayer role through the Session Recording Authorization Console.

Note:
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Placing access restrictions on live recordings is not supported.

The following section walks you through the process of placing and removing access restrictions on
target recordings.

1. Enter the URL of your web player website in the address bar of a supported browser.

The URL format is http(s)://<FQDN of Session Recording server>/WebPlayer.

Supported browsers include Google Chrome, Microsoft Edge, and Firefox.

2. In the left navigation of the web player page, expand the Recordingsmenu.

3. On the All Recordings page, select one or more target recordings.

4. Click the Place access restrictions icon on top of the recording list.

Users and user groups, assigned either the Player or the PrivilegedPlayer role, are allowed
to place access restrictions on recordings. The Restrictedmenu is available only for users and
user groups assigned the PrivilegedPlayer role.

View for the PrivilegedPlayer role:
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View for the Player role:

5. Click Confirm.

6. Verify that the selected recordings on which you placed access restrictions are moved from the
All Recordings page to the Restricted page.

The Restricted by column shows who placed access restrictions on the relevant recordings.
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7. On the Restricted page, remove access restrictions as needed. With access restrictions
removed, recordings are moved back to the All Recordings page.

Open and play recordings

April 1, 2026

You can play live and completed recordings in theweb player. On the recordings page, each recording
has a play button on the right side, next to the Duration item.
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Tip:

For the Player role, the Recordingsmenu in the left navigation shows only the All Recordings
submenu.

For the PrivilegedPlayer role, the Recordings menu shows both the All Recordings and the
Restricted submenus.

Starting with 2411, the Diagnostic Logging menu is available in the left navigation. For more
information, see View diagnostic logging.

Click the play button. The playback page appears. Playback starts after memory caching.

Playback of a screen recording:

Playback of an event‑only recording:

An event‑only recording played in theweb player contains an event statistics pie chart and histogram.
The pie chart and histogram hold static throughout playback. You can navigate to a specific event
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fromwithin the right pane.

Tip:

• Clicking the session progress time lets you switch to the absolute date and time the session
was recorded.

• For an event‑only recording, the play icon in the upper left corner is unavailable.

For a description of the player controls, see the following table:

Player Control Description

Plays the selected recording file.

Pauses playback.

Mutes/unmutes audio playback and adjusts the
volume using the slider.

You can drag the progress bar during playback.
Idle periods of recorded sessions are highlighted
during playback.

Seeks backward 7 seconds.

Indicates the current position of the recording
playback and the total recording duration. The
time format is HH:MM:SS.
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Player Control Description

Lets you click and leave a comment about the
recording being played.

Lets you click and copy the URL of the current
recording to the clipboard.

Shows the overlay that features data points
related to the recorded session.

Hides the session data overlay.

Indicates the current speed of playback. Click
the icon to switch between options including
X0.5, X1, X2, and X4.
Displays the playback in full screen.

Displays the playback within the webpage.

Zoom in on the current playback area.

In the right pane of the playback page, the Events andComments filters, quick search box, and some
recording data are available, for example:
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• The date and time on the web player machine. In this example, AUG 20, 2021 and 18:50:50.

• The duration of the recording in playback. In this example, 01:37:00.

• The number of events in the recording. In this example, 359 EVENTS.

• The name of the user whose session was recorded.

• The host name of the VDA where the recorded session was hosted.

• The name of the client device where the session was running.

• Options for sorting search results: Select All, Events, or Comments to sort search results.

• Event filters. You can select more than one filter to search for events in the current recording.

Click the icon to expand the display of events. For example:
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• Event list. Clicking an event on the list takes you to the position of the event in the recording.

• Quick search box. The search events quick search box helps to quickly narrow down a list of
events in the current recording.

Configure preferences

June 21, 2024

To configure preferences for your web player, navigate to Configuration > Preferences on the web
player page.

You can configure the following preferences for your web player:

• Player cache. Drag the slider to set the cache size you want the player to use for playback.
• Optimized graphics engine. We have optimized the graphics engine to improve the perfor‑
mance of theweb player. The optimized engine is enabled by default. If you encounter compat‑
ibility or other issues with the optimized engine, you can disable it by clearing the check box.
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Increase the transport packet size for the web player

September 7, 2025

1. Locate theWeb configuration fileunder<Session Recording installation path>/
WebSocketServer.

2. Open theWeb configuration file.

3. Edit the BlockSizeMultiple value.

The default value is 1 (4 KB). We recommend you set the value to 8 (32 KB).

Highlight idle periods

February 10, 2025

Session Recording can record periods of inactivity (idle periods) and visually represent them in the
web player.

Tip:

Idle events are not visible in the Session Recording player because idle events are saved in the
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Session Recording database but not in the relevant recording files (.icl files).

The idle event feature is enabled by default. To customize the idle event feature, set the following reg‑
istry keys atHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents
.

Registry key Default value Description

EnableIdleEvent 1 To disable the idle event
feature, set the value to 0. To
enable the idle event feature,
set the value to 1.

IdleEventThrottle 30 seconds If there is no user activity
(including graphics changes
and keyboard/mouse inputs)
longer than the time threshold
set by the registry key, an idle
event is recorded. The idle
period is highlighted when the
recorded session plays back on
the Session Recording web
player.

IdleEventActiveThrottle 2 seconds Only a specified number of
graphics changes within a
specified amount of time
qualify as user activities. By
default, at least three packets
within 2 seconds can qualify as
user activities.

IdleEventActivePktNumThrottle 3 packets Only a specified number of
graphics changes within a
specified amount of time
qualify as user activities. By
default, at least three packets
within 2 seconds can qualify as
user activities.

IdleEventActivePktSizeThrottle 300 bytes Graphics packets smaller than
the key value are ignored and
the relevant time duration is
regarded as idle.
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Use events and comments

June 21, 2024

In the right pane of the playback page, the Events and Comments filters are available. You can use
events and comments to help you navigate through recorded sessions in the web player.

Comment on recordings

When a recorded session is being played, you can click the Comments player control to leave com‑
ments and set comment severities. Severities include Normal, Medium, and Severe. Severe and
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Medium comments are indicated with red and orange dots, respectively. During session playback,
you can view all comments about a recording. To delete a comment that you left, refresh your web‑
page, expand the comment, and then click Delete.

Clicking a comment lets you jump to the locationwhere the commentwas given. You can viewall your
comments on theMy comments page.

Note:

Tomake the comment feature work as expected, clear theWebDAV Publishing check box in the
Add Roles and Featureswizard of Server Manager on the Session Recording Server.
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Share recordings as links

June 21, 2024

Overview

You can share recordings as links so that other users can access the recordings directly, without the
need to search amongmany recordings. You can share recordings as restricted and unrestricted links.
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If you share a recording as a restricted link, only userswhoalreadyhaveplaybackpermission can view
the recordingusing the link. If you share a recording as anunrestricted link, anyone in your ADdomain
can view the recording using the link.

To facilitate managing unrestricted links, Session Recording lets you:

• Set a validity period for each of the links.
• (Optional) Enter a justification when generating the links.
• Get an overview of which recordings have been shared as unrestricted links.
• View all unrestricted links of a specific recording.
• Knowwhich users have accessed an unrestricted link.
• Revoke unrestricted links that haven’t expired.
• Clear invalid links that have expired or revoked.

Note:

• To share recordings as unrestricted links and to manage unrestricted links, you must be
assigned the PrivilegedPlayer role.

• To view a recording using an unrestricted link, users must enter a justification.

Share recordings as restricted links

To share recordings as restricted links, complete the following steps:

1. In the web player, open and play the recording that you want to share.

2. Click Share on the playback page of the recording. The Generate recording link dialog ap‑
pears.

3. Select Restricted from the General access drop‑down.
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4. Click Copy link.

After you click Copy link, either of the following messages appears, indicating a successful or
failed operation respectively:

• The URL to the shared recording has been copied to the clipboard

• Sharing the recording URL failed

5. Apply secure sharing at the server level.

To ensure secure sharing, set the following registry values under HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server:

Registry value Description Default value Remarks

LinkExpire Time span beyond
which a generated URL
link expires. Counted
as timeticks in the unit
of 10 microseconds.

1,728,000,000,000 (The
default value equals 2
days.)

‑

LinkSalt A security method to
encrypt the preceding
URL expiration time

Kk2od974 Change the default
value to an arbitrary
string that preferably
ends with digits.

6. Share the generated URL link with users who already have playback permission.

Pasting the link in the address bar lets you jump to the location where the link was copied.

Share recordings as unrestricted links

Note:

To share recordings as unrestricted links, youmust be assigned the PrivilegedPlayer role.

To share recordings as unrestricted links, complete the following steps:

1. In the web player, open and play the recording that you want to share.

2. Click Share on the playback page of the recording. The Generate recording link dialog ap‑
pears.

3. SelectUnrestricted from the General access drop‑down.
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4. (Optional) Enter your justification for sharing the recording.

5. Set an expiration period for the link to be generated.

6. Click Copy link.

After you click Copy link, either of the following messages appears, indicating a successful or
failed operation respectively:

• The URL to the shared recording has been copied to the clipboard

• Sharing the recording URL failed

7. Share the generated URL link with anyone in your AD domain.

Pasting the link in the address bar lets you jump to the location where the URL link was copied.

Note:

• To view a recording using an unrestricted link, users must enter a justification.
• The actions of generating and accessing unrestricted links are logged under the play‑
back logging sector of administrator logging.

Manage unrestricted links

Note:

Tomanage unrestricted links, youmust be assigned the PrivilegedPlayer role.

Viewwhich recordings have been shared as unrestricted links

To get an overview of which recordings have been shared as unrestricted links, clickManage Links in
the upper right corner of the All Recordings page.
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After you clickManage Links, only recordings that have been shared as unrestricted links are listed.

View andmanage unrestricted links of a specific recording

1. Open theManage unrestricted links page.

Method 1: By clicking the link icon in the Action column on the All Recordings page

Method 2: By clickingManage Links in the Generate recording link dialog

© 1997–2026 Citrix Systems, Inc. All rights reserved. 296



Session Recording 2603

2. On theManageunrestricted linkspage, expandeach rowtoviewdetails about theunrestricted
links that are generated for the specific recording.

3. (Optional) To revoke a link, select it and then click Revoke that appears.
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After you click Revoke, you are prompted to confirm the action.

4. (Optional) To remove the links that have expired or revoked, click Clear invalid links.

View graphical event statistics for each recording

June 21, 2024

Event data visualization is available in the web player for each recording. It provides graphical event
statistics for you to quickly comprehend the events inserted in recordings.

To view graphical event statistics, complete the following steps:

1. Open and play a recording.

2. In the upper left corner of the playback page, click the statistics icon.
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3. Switch between the Screen time, File transfers, Commands, Printing, and Events tabs to
view statistics from different perspectives.

• Screen time

The Screen time tab lets you know the cumulative time an application window is in focus
(active window).

There is a horizontal time bar next to each application. Click the bar to view the start time
and duration each time an application becomes and stays in focus, respectively. You can
narrow down your search range by specifying a duration range other than the default All
option. For example:
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• File transfers

The File transfers tab provides graphical statistics about bidirectional file transfers be‑
tween the VDA hosting the recorded session and the client device where the session runs.
You can customize the visualization by using the following settings:

• Time granularity: Per 1minute, Per 10minutes, Per hour
• File transfer destination: All transfers, Transfer from host to client, Transfer from
client to host

• Number or size (Bytes or MB) of transferred files

The X axis represents the absolute time in the 24‑hour system.
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• Commands

The Commands tab shows CMD and PowerShell commands that are run during the
recorded session. You can customize the data display by typing your custom search in
Custom search or selecting a saved search from Saved search. The “OR”logical operator
is used to compute the final action.

• Printing

ThePrinting tab provides graphical statistics of printing activities in the recorded session.

• Events

The Events tab shows the proportions and numbers of all types of events in the recorded
session.
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View data points related to each recorded session

June 21, 2024

Duringplayback, you can click theShowstats control to view, onanoverlay, the followingdatapoints
related to the recorded session:

• Round trip time
• Network (send)
• Network (receive)
• CPU usage
• Memory usage
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Note:

• Session Recording collects round‑trip time every 15 seconds and the rest of the data points
every second.

• Theoretically, SessionRecording refreshesdataon round‑trip timeevery five seconds. How‑
ever, round trip time data actually refreshes every 15 seconds because of the collection
cycle.

• Session recording refreshes the rest of the data points every 5 seconds and presents their
average values on the overlay.

The overlay is semi‑transparent. You can relocate and hide it.

• To relocate the overlay, hover your mouse over the eight dots and then do a drag and drop.
• To hide the overlay, clickHide stats.

You can enable the overlay by selecting Log performance data when creating your event detection
policy. For more information, see Configure event detection policies.

View diagnostic logging

October 23, 2024
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Overview

Various diagnostic logs includingmessage queue quota exceedance can be detected on the VDAs and
sent to the Session Recording server for display in the Session Recording web player.

Message queue quota exceedance

In any of the scenarios outlined below, there’s a chance of exceeding the maximum size of the Mi‑
crosoft Message Queuing (MSMQ) directory on a VDA, resulting in packet drops or pushback.

• On the VDA side, the incoming rate of Message Queuing messages exceeds the outgoing rate.
• The network connection between the VDA and the Session Recording server is poor and thus
messages are stuck in the queue on the VDA side.

• The queue quota on the Session Recording server side is used up andmessages are stuck in the
queue on the VDA side.

View diagnostic logging

1. Open the Session Recording web player, and click Diagnostic Logging in the left navigation.
The Diagnostic Logging page appears.

For example:

All VDAs with diagnostic logs are presented and sorted by their total log counts. You can also
view the time the latest log is generated on each VDA and click Refresh to check for more in‑
coming logs.

2. Click a target VDA to view its diagnostic logs.

By default, logs are grouped by type. For example:
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You can disable log grouping by type and list all logs in chronological order instead.

For example:

3. Use the time filter to select and view logs generated during the specified time frame.

4. To check for any incoming logs, click Clear all logs to hide the currently displayed logs, and
then click Refresh.

Configure diagnostic logging

Diagnostic logging is enabled by default. You can disable and re‑enable the feature by using the fol‑
lowing registry value on the target VDA:

HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent\DiagnosticLoggingEnabled
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Value data: 1 = enabled, 0 = disabled

You can also set how long these logs can be retained on the Session Recording database. To do so, go
to the Logging tab of Session Recording Server Properties and configure the Retention period for
diagnostic logs. The default value is 30 days.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 306



Session Recording 2603

© 1997–2026 Citrix Systems, Inc. All rights reserved. 307



Session Recording 2603

Manage recordings

September 7, 2025

ICA log database (ICLDB) is a database command‑line utility used to manipulate the session record‑
ing database records. This utility is installed, during the Session Recording installation, to the
<Session Recording Server installation path>\Bin folder on the server hosting
the Session Recording server.

Note:

If you want to use ICLDB to manage session recording files stored in Azure file shares, run the
SsRecUtils.exe -MountAzureFiles command. SsRecUtils.exe and ICLDB are in the
same folder.

Quick reference chart

The following table lists the commands and options that are available for the ICLDB utility. Type the
commands using the following format:

ICLDB [VERSION | LOCATE | DORMANT | IMPORT | ARCHIVE | REMOVE |
REMOVEALL | REPAIR] command-options [/L] [/F] [/S] [/?]

Note:

More extensive instructions are available in the help associated with the utility. To access the
help, froma command prompt, type the\Program Files\Citrix\SessionRecording
\Server\Bin folder, and type
icldb /?. To access help for specific commands, type
icldb <specific command> /?.
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Command Description

ARCHIVE Archives the session recording files that you
specify. You can specify a target session
recording file to archive by using the FILEID
parameter. You can also specify target session
recording files by using the RETENTION
parameter and the FILTER or RULES parameter.
In the second case, the RETENTION parameter is
mandatory. It lets youmanipulate session
recording files older than the retention period
specified. A valid retention period is 2 days at
least. Therefore, set RETENTION to 2 or a greater
value that suits your needs. The FILTER and
RULES parameters are optional. The FILTER
parameter lets you filter file paths by using the *
and ?wildcards. The RULES parameter sets
advanced filters by combining multiple filters
strictly in accordance with the
/RULES:FIELD-In-["CONDITION","
CONDITION"];FIELD-NotIn-["
CONDITION","CONDITION"]; format. For
more information, see The RULES parameter for
ICLDB ARCHIVE and ICLDB REMOVE commands
following this table. The RULES parameter and
the FILTER parameter cannot be used together. If
you add the FILTER or RULES parameter, only
session recording files meeting both RETENTION
and FILTER or RULES are manipulated. You can
archive both recordings and events in the
recordings. The events are archived in the
ArchivedEvent database table. Example ICLDB
ARCHIVE command:
ICLDB ARCHIVE /RETENTION:<days>
[/LISTFILES] [/MOVETO:<dir>] [/
NOTE:<note>] [/FILTER:<file path
filter>] [/RULES:<advanced
filters>] [/L] [/F] [/S] [/?]
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Command Description

DORMANT Displays or counts the live recording files that
are considered dormant or unresponsive. A live
recording is considered unresponsive or
dormant when no new data is written to the
recording file after a specified period of time has
elapsed. You can specify a target session
recording file by using the FILEID parameter. You
can also check whether session recording files
are becoming dormant for the entire database,
or only recordings made within the specified
number of days, hours, or minutes. Among the
time parameters (DAYS, HOURS, and MINUTES),
only one can be specified at a time. You can
manually close unresponsive or dormant live
recordings by appending the CLOSEFILES
parameter. You can also set a time threshold on
the Storage tab of Session Recording Server
Properties to close unresponsive or dormant
live recordings automatically when the
threshold is exceeded. For more information,
see Close unresponsive or dormant live
recordings later in this article.
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Command Description

IMPORT Imports session recording files to the Session
Recording database. Use this command to
rebuild the database if you lose database
records. Also, use this command tomerge
databases (if you have two databases, you can
import the files from one of the databases). The
2303 release introduces the RELOCATE
parameter to the IMPORT command. Without
the RELOCATE parameter, the IMPORT
command parses session recording files in their
entirety, which takes time. With the RELOCATE
parameter, the IMPORT command simply
locates the database records of session
recording files and updates their file paths
directly. Example ICLDB IMPORT command:
ICLDB IMPORT [/LISTFILES] [/
RECURSIVE] [/RELOCATE] [/L] [/F]
[/S] [/?] [<file>] [<directory>]

LOCATE Locates and displays the full path to a session
recording file using the file ID as the criteria. Use
this command when you are looking for the
storage location of a session recording file. It is
also one way to verify if the database is
up‑to‑date with a specific file. Example ICLDB
LOCATE command: ICLDB LOCATE /FILEID
:<id> [/L] [/F] [/S] [/?]
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Command Description

REMOVE Removes the references to session recording
files from the database. Use this command (with
caution) to clean up the database. You can also
remove the associated physical files. When using
the REMOVE command, you can either specify a
target session recording file by using the FILEID
parameter or specify target session recording
files using the RETENTION parameter and the
FILTER or RULES parameter. In the second case,
the RETENTION parameter is mandatory. It lets
youmanipulate session recording files older
than the retention period specified. A valid
retention period is 2 days at least. Therefore, set
RETENTION to 2 or a greater value that suits your
needs. The FILTER and RULES parameters are
optional. The FILTER parameter lets you filter file
paths by using the * and ?wildcards. The RULES
parameter sets advanced filters by combining
multiple filters strictly in accordance with the
/RULES:FIELD-In-["CONDITION","
CONDITION"];FIELD-NotIn-["
CONDITION","CONDITION"]; format. For
more information, see The RULES parameter for
ICLDB ARCHIVE and ICLDB REMOVE commands
following this table. The RULES parameter and
the FILTER parameter cannot be used together. If
you add the FILTER or RULES parameter, only
session recording files meeting both RETENTION
and FILTER or RULES are manipulated. Example
ICLDB REMOVE command: ICLDB REMOVE /
RETENTION:<days> [/LISTFILES] [/
DELETEFILES] [/FILTER:<file path
filter>] [/RULES:<advanced
filters>] [/L] [/F] [/S] [/?]
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Command Description

REMOVEALL Removes all references to session recording files
from the Session Recording database and
returns the database to its original state. The
actual physical files are not deleted; however,
you cannot search for these files in the Session
Recording player. Use this command (with
caution) to clean up the database. Deleted
references can be reversed only by restoring
from your backup.

VERSION Displays the Session Recording database
schema version.

REPAIR Repairs recording files that are corrupted due to
missing data in the file headers. Repaired files
can be found at%App‑
Data%\Citrix\SessionRecording\Restore.

/L Logs the results and errors to the Windows event
log.

/F Forces the command to run without prompts.

/S Suppresses the copyright message.

/? Displays help for the commands.

The RULES parameter for ICLDB ARCHIVE and ICLDB REMOVE commands

The RULES parameter sets advanced filters by combining multiple filters strictly in accordance with
the /RULES:FIELD-In-["CONDITION","CONDITION"];FIELD-NotIn-["CONDITION"
,"CONDITION"]; format, where:

• “FIELD”sets a filter with a field, which can be “path”, “user”, “group”, “deliverygroup”, “ap‑
plication”, “server”, “client”, or any other column in the database table called dbo.ICLFile.

• “In”means that at least one of the filter conditions in the brackets must be met for a recording
file to be an operation object.

• “NotIn”means that recording files that meet any of the filter conditions in the brackets are ex‑
cluded from the operation.

• “CONDITION”sets a filter condition with a record (or row) in the database table called
dbo.ICLFile.
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• User and group records must be entered in the format of <domain>.<name>.

• Path records can be filtered by using Windows wildcards.

• You must enclose each “CONDITION”item in double quotes ("") and separate two “CONDI‑
TION”items with a comma (,).

• Do not add spaces when entering “CONDITION”items unless a “CONDITION”item itself con‑
tains spaces.

• If a “CONDITION”item contains one ormore commas, enclose the “CONDITION”item in double
quotes that are followed by escaped double quotes """""".

• Multiple filters can be used in various combinations. End each filter with a semicolon (;).

• The “AND”logical operator is used to compute the multiple filters. There is no limit to the num‑
ber of filters, but the total length of RULESmust not exceed 2,048 bytes.

Examples:

• /RULES:group-In-["BUILTIN.Guests"];
• /RULES:path-In-["S:\SessionRecordings\2023*"];group-NotIn-["
Mydomain.Suspicious","Mydomain.Persistence"];

• /RULES:deliverygroup-In-["RdsDesktopAndAppGroup"];user-In-["
Mydomain.AdminA","""Mydomain.Admin,,,B"""];

• /RULES:EndReasonID-In-["1","2"];

Archive session recording files

Tomaintainanadequate levelof sparediskcapacity in the recordingstorage locations, archive session
recording files regularly. Depending on the amount of available disk space and the typical size of
recording files, archiving intervals differ. Session recording filesmust be older than twodays from the
start date before a session recording file can be archived. This rule is to prevent any live recordings
from being archived before they become complete.

Twomethods are available when you archive session recordings. The database record for a recording
file canbeupdated to have a status of archivedwhile the file remains in the recording storage location.
This method can be used to reduce the search results in the player. The other method is to update
the database record for a recording file to the archived status and move the file from the recording
storage location to another location for backup to alternativemedia. Whenmoving session recording
files, the ICLDB utility moves them to the specified directory where the original file folder structure of
year/month/day no longer exists.

The session recording record in the Session Recording database contains two fields associated with
archiving—the archive time and archive note. The archive time represents the current date and time
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that a recording was archived. The archive note is an optional text note that can be added during
archiving. The two fields indicate that a recording has been archived and the time of archiving.

In the Session Recording player, archived session recordings show a status of Archived and the date
and time of archiving. Session recordings that have been archived might still be played if the files
have not beenmoved. If a session recording file was moved during archiving, a file not found error is
displayed. The session recording file must be restored before the session can be played. To restore
a session recording file, provide the File ID and Archive Time of the recording file. Restoring archived
files is discussed further in the following Restore session recording files section.

The ARCHIVE command of the ICLDB utility has several parameters that are described as follows:

• /FILEID:<id> ‑ Lets you specify a target session recording file. You can check the ID of a session
recording file in the SessionRecordingplayer (Windows). A recording file namecanalsobeused
as the file ID.

• /RETENTION:<days> ‑ The retention period in days for session recordings. Recordings older
than the number of days specified are marked as archived in the Session Recording database.
The retention period must be an integer number greater than or equal to 2 days.

• /FILTER:<filter>: Lets you filter file paths by using the* and?wildcards. The FILTER parameter
is optional. If you add the FILTER parameter, only those session recording files meeting both
RETENTION and FILTER are archived.

• /RULES:<advanced filters>: Sets advanced filters by combining multiple filters strictly in
accordance with the /RULES:FIELD-In-["CONDITION","CONDITION"];FIELD-
NotIn-["CONDITION","CONDITION"]; format. The RULES parameter and the FILTER
parameter cannot be used together. For more information, see the preceding The RULES
parameter for ICLDB ARCHIVE and ICLDB REMOVE commands section in this article.

• /LISTFILES –Lists the full pathand file nameof session recording files as theyarebeingarchived.
This parameter is optional.

• /MOVETO:<directory> ‑ Thedirectory towhich youphysicallymove archived session recording
files. The specified directory must exist. This parameter is optional. If no directory is specified,
the files remain in their original storage location.

• /NOTE:<note> ‑ A text note that is added to the database record for each session recording
archived. Ensure that the note is enclosed with double quotes. This parameter is optional.

• /L –Logs the results and errors to theWindows event log of the number of session recording files
archived. This parameter is optional.

• /F –Forces the archive command to run without prompts. This parameter is optional.
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To archive session recordings in the Session Recording database and physically move session
recording files

1. Log on to the server where the Session Recording server is installed as a local administrator.

2. Start a command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording server
installation path (<Session Recording server Installation Path>\Bin).

4. Run the ICLDB ARCHIVE /RETENTION:<days> [/LISTFILES] [/MOVETO:<dir
>] [/NOTE:<note>] [/FILTER:<file path filter>] [/RULES:<advanced
filters>] [/L] [/F] [/S] [/?] command. The parameters in brackets are optional.
Remove the brackets when running the command. The RULES parameter and the FILTER
parameter cannot be used together. days is the retention period for session recording files,
directory is the directory where archived session recording files are moved to, and note is the
text note that is added to the database record for each session recording file being archived.
Enter Y to confirm the archive.

To only archive session recordings in the Session Recording database

1. Log on to the server where the Session Recording server is installed as a local administrator.

2. Start a command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording server
installation path (<Session Recording server installation path>\Bin).

4. Run the ICLDB ARCHIVE /RETENTION:<days> [/LISTFILES] [/NOTE:<note>]
[/FILTER:<file path filter>] [/RULES:<advanced filters>] [/L] [/

F] [/S] [/?] command. The parameters in brackets are optional. Remove the brackets
when running the command. The RULES parameter and the FILTER parameter cannot be used
together. days is the retention period for session recordings and note is the text note that is
added to the database record for each session recording being archived. Enter Y to confirm the
archive.

Restore session recording files

To view a recording file archived in the Session Recording database and moved from the recording
storage location, restore it. Archived session recordings that were notmoved from the recording stor‑
age location during archiving are still accessible in the player.

Two methods are available for restoring session recording files that have been moved. Copy the re‑
quired session recording file to the restore directory for archived files. Or, import the required session
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recording file back to the Session Recording database by using the ICLDB utility. We recommend the
firstmethod for restoring archived session recording files. Remove archived files copied to the restore
directory for archived files when you no longer need them.

TheSessionRecordingBroker uses theRestoredirectory for archived fileswhena session recording
file is not found in its original storage location. This case occurs when the player requests a session
recording file for playback. The Session Recording Broker first attempts to find the session recording
file in the original storage location. If the file is not found in the original storage location, the Session
Recording Broker then checks the Restore directory for archived files. If the file is present in the
restore directory, the Session Recording Broker sends the file to the player for playback. If the file is
not found, the Session Recording Broker sends a file not found error to the player.

Importing an archived recording file updates the Session Recording databasewith the session record‑
ing information from the file, including a new storage path. Importing an archived session recording
file doesn’t move the file back to the original storage location when the session was recorded.

Note: An imported session recording file has the archive time and archive note cleared in the Ses‑
sion Recording database. The next time the ICLDB ARCHIVE command is run, the imported session
recording file might become archived again.

The ICLDB IMPORT command is useful to import a large number of archived recording files. It can
repair or update incorrect and missing session recording data in the Session Recording database. It
is also useful to move session recording files from one storage location to another on the Session
Recording server. You can use the ICLDB IMPORT command to repopulate the Session Recording
database with session recordings after running the ICLDB REMOVEALL command.

The IMPORT command of the ICLDB utility has several parameters that you can use for restoring
archived recording files:

• /LISTFILES –Lists the full path and file name of session recording files while they are being im‑
ported. This parameter is optional.

• /RECURSIVE –Searches all subdirectories for session recording files. This parameter is optional.

• /RELOCATE –Without the RELOCATE parameter, the IMPORT command parses session record‑
ing files in their entirety, which takes time. With the RELOCATE parameter, the IMPORT com‑
mand simply locates the database records of session recording files and updates their file paths
directly.

• /L –Logs the results and errors to the Windows event log the number of session recording files
imported. This parameter is optional.

• /F –Forces the IMPORT command to run without prompts. This parameter is optional.
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Note:

The IMPORT command of the ICLDB utility also provides an optional parameter, RELOCATE, that
you can use for relocating recording files. Formore information, see the Relocate session record‑
ing files section in this article.

Restore session recording files by using the restore directory for archived files

1. Log on as a local administrator to the server where the Session Recording server is installed.

2. In Session Recording Player Properties, determine the File ID and Archive Time of the archived
session recording file.

3. Locate the session recording file in your backups using the File ID specified in SessionRecording
Player Properties. Each session recording has a file name of i_<FileID>.icl, where FileID
is the ID of the session recording file.

4. Copy the session recording file from your backup to the restore directory for archived files. To
determine the restore directory for archived files:

a) From the Startmenu, choose Start > All Programs > Citrix® > Session Recording Server
Properties.

b) In Session Recording Server Properties, select the Storage tab. The current restore di‑
rectory appears in the Restore directory for archived files field.

Restore session recording files by using the ICLDB IMPORT command

1. Log on as a local administrator to the server where the Session Recording server is installed.

2. Start a command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording server
installation path (<Session Recording server installation path>\Bin).

4. Either:

• Run the ICLDB IMPORT /LISTFILES /RECURSIVE /L <directory> com‑
mand where directory is the name of one or more directories, separated by a space
containing session recording files. Enter Y to confirm the import.

• Run theICLDB IMPORT /LISTFILES /L <file> commandwhere file is the name
of one or more session recording files, separated by a space. Wildcards might be used to
specify session recording files. Enter Y to confirm the import.
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Relocate session recording files

You can move session recording files to different storage paths for the load balancing or other pur‑
poses. To ensure that the files can still be played, you must update their new paths to the Session
Recording database. To do so, use the ICLDB IMPORT command. To accelerate the import process,
append the RELOCATE parameter to the ICLDB IMPORT command.

Note:

TheRELOCATEparameter is optional. Without the RELOCATEparameter, the ICLDB IMPORT com‑
mand parses session recording files in their entirety, which takes time. With the RELOCATE pa‑
rameter, the ICLDB IMPORT command simply locates the database records of session recording
files and updates their file paths directly.

The following steps illustrate how to use the RELOCATE parameter to update new file paths to the
Session Recording database.

1. Move session recording files to different storage paths as needed.

2. Log on as a local administrator to the server where the Session Recording server is installed.

3. Start a command prompt.

4. Change from the current working directory to the Bin directory of the Session Recording server
installation path (<Session Recording server installation path>\Bin).

5. Either:

• Run the ICLDB IMPORT /LISTFILES /RECURSIVE /RELOCATE /L <
directory> command where directory is the name of one or more directories,
separated by a space containing session recording files. Enter Y to confirm the import.

• Run the ICLDB IMPORT /LISTFILES /RELOCATE /L <file> command where
file is the name of one or more session recording files, separated by a space. Wildcards
might be used to specify session recording files. Enter Y to confirm the import.

Note:

• The RELOCATE parameter assumes that there are already records of the session recording
files in the Session Recording database.

• Thesession recording filesmustbeplayablebeforebeingmoved. Otherwise, theRELOCATE
parameter does not help.

• The new storage paths of the session recording files must be recognizable by the Session
Recording server. You can try themon the Storage tab of Session Recording Server Prop‑
erties.
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Close unresponsive or dormant live recordings

By default, a live recording is considered unresponsive or dormant if no new data was written to
the recording file for 24 hours. You can configure this time threshold on the Storage tab of Session
Recording Server Properties to close unresponsive or dormant live recordings automatically when
this threshold is exceeded. The minimum value that you can set is 12 (hours).

You can also manually close unresponsive or dormant live recordings by using the ICLDB DORMANT
command, for example:

1 ICLDB DORMANT [/DAYS:<days> | /HOURS:<hours> | /MINUTES:<minutes> | /
FILEID:<id>] [/LISTFILES] [/CLOSEFILES] [/L] [/F] [/S] [/?]

The FILEID parameter lets you specify a target session recording file and the CLOSEFILES parameter
lets youmanually close unresponsive or dormant live recordings that you specify.

Tip:

You can check the ID of a session recording file in the Session Recording player (Windows). A
recording file name can also be used as the file ID.

Session recording file export

February 16, 2026

The session recording file export feature provides a secure and verifiable method for exporting ses‑
sion recordings to meet critical needs such as digital evidence, fraud investigations, and regulatory
compliance. It allows authorized administrators to export selected session recordings into a universal
MP4 format.
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Key capabilities of this feature include:

• Role‑BasedAccessControl: Ensures that only authorizedusers canperformexport operations.
• Mandatory Justification: Requires a reason for each export, enhancing the traceability of op‑
erations.

• Comprehensive Activity Logging: All export activities are recorded in detail for auditing pur‑
poses.

Prerequisites

Before youbegin the configuration, pleaseensure your environmentmeets all of the following require‑
ments:

• The Session Recording Agent, Session Recording Server, and Session RecordingWeb Player are
all installed or have been upgraded to version 2511 or later.

• Session recordingmedia task service version 2511 or later is installed. Refer to the official setup
guide.

How to use recording file export
How to export Session Recording files

Note:

Onlyadministratorswhohavebeenassignedboth theLoggingReaderandPrivilegedPlayer
roles can perform export operations. You can assign roles to users in the Session Recording
Authorization Console.

1. Log in to the Session Recording Web Player and navigate to the All Recordings page.

2. Select one or more recordings that you need to export.

3. Click the Export button located above the list.
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4. Check the export files under the following folder on the machine running media task service:
%ProgramData%\Citrix\SessionRecording\SRTask\Cache.

How tomonitor export tasks and audit logs

• To view export status:

1. Click Tasks in the left navigation pane.
2. This page displays the real‑time status of all export tasks, including “In Progress,”“Com‑

pleted,”“Pending,”or “Failed.”

• To audit export activities:

1. In the left navigation pane, expand Admin Logging and click Playback Logging.
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2. Here you can view the export records for all recordings (Action will be Export recording),
along with details such as the user who performed the action and the timestamp.

Session recordingmedia task service

February 16, 2026

The Session Recording Media Task Service handles backend operations such as exporting session
recordings andperforming AI‑based analysis tasks. It can be installed either on the Session Recording
Server itself or on a separate high‑performance server within the same domain.

Prerequisites

For optimal performance, the server hosting the task service should have:

• 8‑core CPU

• 16 GB RAM

Installation and configuration

Follow the steps below to install and configure the Task.
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Step 1: Install the Session Recordingmedia task service

1. Run the installer SessionRecordingTaskClient.msi which is included in the Session
Recording installer package.

2. On the Session Recording Server Configuration screen, enter the name of your Session Record‑
ing Server or for load‑balanced environments, the load balancer address. Specify the protocol
(HTTPS/HTTP) and port (443/80), then click the Test button to verify the connection.

Note:

When deploying in a load‑balanced environment, enable session persistence on your load
balancer and select SOURCEIP (or equivalent) as the persistence type.

• For Citrix NetScaler/ADC, see Persistence settings.

• For Azure Load Balancer, see Session Persistence.

3. On the Destination Folder screen, confirm or change the installation path, and then complete
the installation.
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Step 2: Enable themedia task service on the server

1. On the Session Recording Server, open Session Recording Server Properties.

2. Switch to theWeb Player tab.

3. Check the Enable the Session Recording media task service checkbox.

4. Click Apply. This action allows the service to perform backend tasks, such as exporting record‑
ings.
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Step 3: Assign permissions for themedia task service

1. On the Session Recording Server, open the Session Recording Authorization Console.

2. From themenu bar, select Player > Assign Users and Groups.

3. Add theFullyQualifiedDomainName (FQDN)of thecomputerwhere the SessionRecordingTask
Service is installed.
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Note:

If theMedia Task Service is installed on the samemachine as the Session Recording Server,
youmust also add the SYSTEMaccount to the Player role.

Step 4 (Optional): Configure a custom export directory

Configure a custom path for exporting recordings by changing the registry key value for: Computer
\HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SRTaskService\
SROutputDir
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AI‑powered insights for session recording

April 1, 2026

Overview

The AI‑powered insights feature enhances the value of session recordings by leveraging Multimodal
Large Language Models. This capability enables automated analysis of session recordings, providing
actionable summaries, key highlights, and statistical insights to support both security auditing and
productivity monitoring.

Prerequisites

To enable and use AI‑powered insights, ensure the following requirements are met:

• Citrix Session recording server version 2603 or later is installed.
• Session recordingmedia task service version 2603 or later is installed. Refer to the official setup
guide. Enable the media task service in Session Recording Server Properties:
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Configuration

Session recording is properly configured and operational.

• Session recording web console (formerly Web Player) must use HTTPS.

• Access to an OpenAI‑compatible API endpoint (e.g., Azure OpenAI) is available for AI analysis.

• Grant PriviledgedPlayer role in Session Recording Authorization Console.

Get Started

Follow below steps to configure and use AI‑powered insights:

Configure AI‑Powered Insights in Site Settings

1. Open the Session RecordingWeb Console and navigate to Site management.

2. In the Site Settings panel, locate the AI‑powered insights section.
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3. Provide the following parameters:

• Endpoint URL: The API endpoint of your AI model (e.g., https://example.azure.com/open
ai/v1/).

• API Key: The authentication key for your AI service.

Note:

If you want to use Google Gemini series model from Vertex AI, refer to the following
guidance:

• The endpoint URL, e.g., “https://aiplatform.googleapis.com”.

• Model name, e.g., “gemini‑2.5‑flash”.

• Check the “use local credentials”checkbox and leave the API key as empty.

• Go to themachine where you installed the Session Recordingmedia task service
andmodify the registry:

• Change thevalueofHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SRTaskService\SRAIModelAPIType
to 3.

• AddastringvalueHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SRTaskService\SRAIModelProjectId
, set the value to your project id in Vertex AI.
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• AddastringvalueHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SRTaskService\SRAIModelLocation
, set the value to your Vertex AI region.
E.g., “global”for Global endpoint, other regions e.g. “us‑east5”(refer to
https://docs.cloud.google.com/vertex‑ai/generative‑ai/docs/learn/locations#google_model_endpoint_locations)

• Add an environment variable GOOGLE_APPLICATION_CREDENTIALS at
System level, set its value to the path of your Vertex AI private key file.

4. (Optional) Configure Advanced Settings:

• Maximum number of analysis tasks per media server: Defines how many AI analysis
tasks can run simultaneously on a single media server (e.g., set to 2).

• Sample rate: Determines how frequently video frames are analyzed.
• Frame difference threshold: Sets the percentage of pixel changes required to consider a
frame as “changed.”

• Batch size: The number of frames sent to the AI model per batch.

5. Click Apply changes to save the configuration.

Note:

Session Recording will not collect your data that is sent to AI models.

Configure Prompt Templates

1. Go to the Resource library.

2. Under Prompt templates for AI‑powered insights, define or customize prompt templates to
guide AI analysis.

3. Templates can be tailored for different goals (e.g., Productivity, Security).
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Productivity Prompt Template

When creating or editing a productivity prompt template, configure:

• General context: Explains the overall purpose of the template.

• User context

• Job function: Enter the user’s role (e.g., Accountant, Software Engineer).

• Describe the role and typical daily tasks: Provide a short description of the responsibil‑
ities (e.g., Responsible for financial reconciliation, preparing reports, and reviewing com‑
pliance with accounting standards).

• Productivity parameters

• Productivity apps: List applications considered productive for this role.

• Detect inactivity: Enable and set a threshold (in seconds).

• Distraction Apps: Define app types considered non‑productive (e.g., Instant messaging
apps , Social networks).
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Security prompt template

When creating or editing a security prompt template, configure:

• General context: Explains the overall purpose of the template.

• User context

• Job function: Enter the user’s role.

• Describe the role and typical daily tasks: Provide a short description of the responsibil‑
ities.

• Security parameters

• Sensitive datatypes: Categories beyond keywords (e.g., Source code, Financial data).

• Sensitive Keywords: Define keywords indicating sensitive data (For example, password,
credit card).

• Set exposure threshold: Minimum duration (in seconds) sensitive data must remain vis‑
ible on screen before being flagged.

• Sensitive data apps: Apps where sensitive data is likely to appear (e.g., Microsoft Excel,
Dynamics 365).

• Risky app types: High‑risk categories (e.g., Social networks, Personal cloud drives).
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Security Templates and Sensitive Data Definitions

Session Recording utilizes pre‑defined security templates to identify sensitive information within
recorded sessions. The AI model analyzes screen content based on the following standard cate‑
gories.

Pre‑defined Sensitive Data Categories The system detects five primary categories of sensitive
data by default:

1. PII (Personally Identifiable Information)

Detects personal data points that can identify an individual, including:

• Identity & Demographics: Name, ID Number, Social Security Number (SSN), Passport
Number, Driver’s License Number, Vehicle Class, Gender, Religion, Race, Nationality.

• Contact Information: Phone Number, Email Address, Home Address, Zip Code.

• Dates: Date of Birth, Date of Issue, Date of Expiry.

• Employment: Job Title, Company, Business Contact Information.

2. Financial Information

Detects banking and payment‑related data, including:

• Card Data: Card Number, Cardholder Name, Expiry Date, CVV Code.

• Account Details: Account Number, Tax ID, Payee Information.
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• Transaction Details: Transaction Records, Amounts, Financial Amounts, Payment Date,
Invoice Number.

• Document Context: Document Title, Signature Area, Company Information.

3. PHI (Protected Health Information)

Detects medical and health‑related records, including:

• Patient Identity: Patient Name, Medical Record Number, Insured Person’s Name, Insur‑
ance Policy Number.

• Medical Details: Diagnosis Results, Medication Name, Dosage Information.

• Documentation: Document Title, Doctor’s Signature.

4. Source Code

Detects programming code snippets, scripts, and syntax typical of software development.

5. API Keys

Detects strings and patterns resembling Application Programming Interface authentication
keys and tokens.

6. IP (Internet Protocol address)

Detects strings and patterns resembling IPs in both IPv4 and IPv6 formats, The specific IP string
will be shown in the reports.

Note on AI Contextual Analysis:

In addition to keywordmatching, theAImodel leverages contextual information to improve judg‑
ment accuracy. This helps distinguish between sensitive data and non‑sensitive text that may
share similar formats.

Customizing Definitions If your organization requires specific adjustments to these definitions
(e.g., specific internal terminology or excluding certain fields), you can provide custom detection
rules in an additional context field.

Select Recordings for Analysis

1. Navigate to Recordings in the Session Recording Console.

2. Use filters or search to locate the session(s) for analysis.

3. Select one or more video recordings, then click Analyze.

4. In the dialog:
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• Select a prompt template from the Resource Library or Create new.
• Choose Analyze the entire session if the session is rollover.
• (Optional) Provide additional context before submitting.

• Click Submit to start the analysis task.

Monitor Task Progress

1. Go to Activity feed > Tasks to track analysis status (Pending, In Progress, Completed, Failed).

2. Each task includes recording file details.

Review AI‑Powered Insights

1. Navigate to the Insights page to view completed analyses.

2. Use filters (Site, User, VDA) and search bar for quick access.
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3. Each session card displays:

• AI‑generated summary.
• Analysis type and status.
• A View Report link for detailed insights.

Detailed Reports

Productivity Analysis Report

Includes:

• Summary: Proportion of time spent on productive vs. non‑productive activities.

• Highlights: Key time blocks, with clickable timestamps.

• Statistics:

• Overview Chart: Breakdown of active work, idle time, and distractions.

• Breakdown by App: Time spent in productivity app vs. distraction app.

• Hourly Pattern: Shows productivity trends throughout the day.
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Security Analysis Report

Includes:

• Summary: Overview of session’s security posture, highlighting risky behaviors and sensitive
data exposure.

• Highlights: Key security events with clickable timestamps.

• Statistics:

• Sensitive Data Exposure:

• by data types or keyword: Shows which sensitive terms appearedmost often.

• by app: Highlights apps where sensitive data appeared.

• Timeline View: Lists sensitive keywords with timestamps and associated apps.
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Limitations

• Virtual App Support: Insights may be limited for virtual application sessions.
• Short Sessions:

• Sessions shorter than 15 minutes generate only a basic summary.
• Sessions shorter than 30 minutes omit statistical charts.

Legal and Privacy Disclaimer

The AI Insights in Session Recording feature and its provided prompt templates aswell as the outputs,
reports and/or information that may be generated from utilizing this feature (“AI Insights”) are not
intended to provide, legal, security, regulatory and/or technical advice or judgement to you in any
form and all information created and derived from utilizing AI Insights is provided “As‑Is”, with no
warranties or representations, whether express or implied, regarding the AI Insights, including, with‑
out limitation, that the information is accurate, error‑free or meets any conditions of merchantability
or fitness for a particular purpose.

Customer is solely responsible for the legal and regulatory compliance of processing any personal
data or sensitive information throughutilizing this feature, includingbut not limited tobalancing your
internaldataclassificationobligations, globaldataand/orAI regulatory complianceaswell as industry
related compliance obligations related to your business or customer market. Customer is advised to
consult their own designated subject matter expert before utilizing AI‑Insights.

Customers acknowledges and understands that utilizing AI Insights involves transmitting all VDA ses‑
sion data to their configured AI model endpoint. This data may include Personal Data or sensitive
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and/or confidential information captured during VDA session recordings. All VDA session data gener‑
ated, as well as the AI Insights output, is considered Customer Content.

Manage and query administrator logging

June 21, 2024

Query the administrator logging data

Requirements

• An administrator assigned to both the LoggingReader and the Player roles can view adminis‑
trator logging. To assign users to the roles, go to the Session Recording Authorization Console.

• The administrator logging page is integrated with the web player. The web player must be in‑
stalled for querying administrator logging. Otherwise, 404 (page not found) errors can occur.

• The language set for the web player browser must match the language you selected when you
installed the Session Recording Administration components.

• Ensure that your SessionRecordingLoggingWebApplication site in IIS and the web player have
the same SSL settings. Otherwise, 403 errors occur when you request to access the administra‑
tor logging data.
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Steps

You can query administrator logging data about a Session Recording server both from the machine
that hosts the server and from other machines:

On themachine hosting the target Session Recording server

1. From the Startmenu, choose Session Recording Administrator Logging.

2. Type the credentials of a LoggingReader user.

The administrator logging webpage integrated with the web player appears.

On othermachines

1. Open a web browser and visit the webpage for administrator logging.

• For HTTPS: https://servername/WebPlayer/#/logging/config and
https://servername/WebPlayer/#/logging/record, where servername
is the name of the machine hosting the Session Recording server.

• For HTTP: http://servername/WebPlayer/#/logging/config and http
://servername/WebPlayer/#/logging/record, where servername is the
name of the machine hosting the Session Recording server.

2. Type the credentials of a LoggingReader user.

Logging data overview

Administrator logging data consists of:

• Configuration logging
• Recording reason logging
• Playback logging.
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Configuration logging

This part logs the following administrator activities:

• Policy change ‑ Changes to policies on the Session Recording policy console or Citrix Director

• Server configuration change ‑ Changes in Session Recording Server Properties

• Log reading ‑ Unauthorized attempts to access the administrator logging data

To log administrator activities, enable administrator logging on your Session Recording servers. For
more information, see Disable or enable administrator logging. To enhance security, you can also
configure an administrator logging service account.

Tip:

You can enable administrator logging both through the Session Recording service and through
Session Recording Server Properties.

Recordingreason logging

This part logs which policies have triggered recordings.

To enable recording reason logging, enable both administrator logging and recording reason logging
on your Session Recording servers. If administrator logging is disabled, enabling recording reason
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logging does not take effect. For information about enabling recording reason logging, see Disable or
enable the recording reason logging.

Playback logging

This part logs playback‑related actions. For more information about each log record, click the plus
sign (+) in the Action Details column.

To logplayback justifications, enablebothadministrator logging andplayback justification loggingon
your Session Recording servers. If administrator logging is disabled, enabling playback justification
logging does not take effect.
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With playback justification logging enabled, each time you play a recording, a dialog box appears,
asking you to enter a playback justification. For example, see the following screen captures:

Justification required for playback in the web player:
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Justification required for playback in the Session Recording player:

On the condition that playback justification logging is enabled on a Session Recording server, mind
the following tips for using playback justifications:

• If you use a player that connects to a Session Recording server, a justification is required, even
for recording files that you downloaded to a local path.

• A single session can generate multiple recordings because of file rollover. When you play back
such a recorded session, youmust enter a justification for each of its recordings.
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Disable or enable administrator logging

After installation, you can disable or enable the Session Recording administrator logging feature in
Session Recording Server Properties.

1. As an administrator, log on to the machine where Session Recording administrator logging is
installed.

2. From the Startmenu, choose Session Recording Server Properties.
3. Click the Logging tab.

WhenSessionRecordingadministrator logging isdisabled, nonewactivitiesare logged. Youcanquery
the existing logs from the web‑based UI.

Whenmandatory blocking is enabled, the following activities are blocked if the logging fails. A sys‑
tem event is also logged with an Event ID 6001:

• Changes to recording policies on the Session Recording Policy Console or Citrix Director.
• Changes in Session Recording Server Properties.

The mandatory blocking setting does not impact the recording of sessions.

Configure an administrator logging service account

Bydefault, administrator logging is running as aweb application in Internet Information Services (IIS),
and its identity is Network Service. To enhance the security level, you can change the identity of this
web application to a service account or a specific domain account.

1. As an administrator, log on to the machine hosting the Session Recording server.

2. In IIS Manager, click Application Pools.

3. In Application Pools, right‑click SessionRecordingLoggingAppPool and choose Advanced
Settings.

4. Change the attribute identity to the specific account that you want to use.

5. Grant the db_owner permission to the account for the database CitrixSessionRecordingLog‑
ging on the Microsoft SQL Server.

6. Grant the readpermission to theaccount for the registrykeyatHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to re‑
install your operating system. Citrix cannot guarantee that problems resulting from the
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incorrect use of the Registry Editor can be solved. Use the Registry Editor at your own risk.
Be sure to back up the registry before you edit it.

Disable or enable the recording reason logging

By default, administrator logging logs every recording reason after the policy query completes. This
behavior might generate many logs. To improve the performance and save the storage, disable this
kind of logging in the registry.

1. As an administrator, log on to the machine hosting the Session Recording server.

2. Open the Registry Editor.

3. Browse toHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.

4. Set the value of EnableRecordingActionLogging to:

0: disable the recording reason logging
1: enable the recording reason logging

Monitor Session Recording agents

September 7, 2025

All VDAs with Session Recording agents installed are monitored. You can run SsRecUtils.exe on the
Session Recording server to:

• Check the counts of VDAs with and without Session Recording agents installed.
• View the connection status of all Session Recording agents.

To check the counts of VDAs with andwithout Session Recording agents installed

1. Start a command prompt as an administrator and change the drive to the <\SessionRecording
server installation path>\Bin folder.

2. Run a command similar to the following:

1 SsRecUtils.exe /GroupVDAs -AdminAddress AWDDC1-1PQNR

The AdminAddress parameter specifies the FQDN of your Delivery Controller. It allows you to
view the counts of VDAs in your site and the counts of VDAs installed with Session Recording
agents. For an example output, see the following screen capture:
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To View the connection status of all Session Recording agents

1. Start a command prompt as an administrator and change the drive to the <\SessionRecording
server installation path>\Bin folder.

2. Run a command similar to the following:

1 SsRecUtils.exe /ListVDAs -AdminAddress AWDDC1-1PQNR -DeliverGroup
BVT_DG [-InstalledSRAgent True -MachineName AWVDA-1PQNR -
MaxRecordCount 1000 -OffSet 0]

This command displays a detailed list of VDAs, sorted in ascending order based onwhen their Session
Recording agent was registered (oldest to newest).

Where,

• AdminAddress (mandatory) specifies the FQDN of your Delivery Controller. It allows you to list
VDAs in your site.

• DeliverGroup (mandatory) specifies a delivery group.

• InstalledSRAgent (optional, default: True) controls which VDAs to list. True: List only VDAs
installed with the Session Recording agent. False: List only VDAs without the agent.

• MachineName (optional) specifies the machine name of a target VDA.

• MaxRecordCount (optional, default: 1000) limits the number of output records.

• Offset (optional, default: 0) specifies the starting point for data retrieval, skipping the firstOff‑
set items.

For example command outputs, see the following screen captures:

• Example output when InstalledSRAgent is set to True:
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• Example output when InstalledSRAgent is set to False:

Manage basic deployment agents

April 2, 2026

You can use Session Recording to manage basic deployment agents. This feature provides a light‑
weight method to deploy Session Recording. You can use this deployment method for utilizing Ses‑
sion Recording basic functionalities–record active sessions to MP4 files without deploying the back‑
end components such as Session Recording Servers, player, databases, and consoles.

Installation

TheSessionRecordingAgent is installed alongwith theCitrix Virtual Delivery Agent (VDA) bydefault.
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• New installation: When installing or upgrading to VDA version 2511 or later, the Session Record‑
ing Agent is installed and works in deployment mode.

• Existing installation: If you already have a Session Recording agent installed, you can switch to
the basic deployment mode by upgrading the agent to version 2511 or later and changing the
Session Recording Server Address to localhost in the Session Recording Agent properties.
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Use the basic deployment agent

In the basic deployment mode, recordings can be triggered manually by end users or administrators
using the Citrix Virtual Desktop Assistant or PowerShell commands. They can also be triggered by
hotkeys or dynamic recording.

Start or stop recording by using Citrix Virtual Desktop Assistant

Citrix Virtual Desktop Assistant is installed by default in CVAD. It includes a built‑in Session Recording
page that allows customers to manually record their active virtual desktop sessions. This feature en‑
ables customers to capture screen activity as MP4 video clips for troubleshooting, collaboration, and
session review.

For more information, see, Citrix Virtual Desktop Assistant application.

Start or stop recording by using PowerShell commands

Both end users and administrators can use PowerShell commands to manage recordings.
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Import the SessionRecordingmodule Before running any commands, ensure the necessarymod‑
ule is imported.

Open PowerShell and Import the module by running:

Import-Module -DisableNameChecking 'C:\Program Files\Citrix\SessionRecording
\Agent\Bin\EndUserInitiatedSRSnapin.dll'

Available Commands The following table lists three PowerShell commands that provide for end
user triggered session
recording.

Command Description

Start‑SessionRecording Starts recording the active session in which the
command is executed. To record a specific active
session, use the -SessionId <ID>
parameter (requires local administrator
privileges). For more information, run
Get-Help Start-SessionRecording to
see the command online help.

Stop‑SessionRecording Stops recording the active session in which the
command is executed. To stop recording a
specific active session, use the
-SessionId <ID> parameter (requires local
administrator privileges). Note: Users can only
stop recordings they initiated. They cannot stop
recordings triggered by dynamic or policy‑based
recording. For more information, run
Get-Help Stop-SessionRecording to
see the command online help.

Get‑SessionRecordingStatus Retrieves the recording status of the active
session in which the command is executed. To
get the status of a specific active session, use the
-SessionId <ID> parameter. For more
information, run Get-Help Get-
SessionRecording Status to see the
command online help.
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Example 1: End‑user triggered recording

Endusers can trigger recordings for their current active session to capture operationsdynamically (for
example, for troubleshooting purposes).

The user can perform the following steps inside the session:

1. Launch PowerShell from the session desktop.

2. Import the module as described in the previous section.

3. Use theGet-SessionRecording Status command to check the recording status, ensure
the session is not already being recorded.

4. Use the Start-SessionRecording command to start recording the session.

5. Use the Get-SessionRecordingStatus command to check the recording status, ensure
the session is being recorded. The status is supposed to be Recording.

6. Reproduce the issue or perform the operations that need to be documented.

7. Use the Stop-SessionRecording command to stop recording once the operations are
complete.

8. Find the recording file and proceed with the follow‑up troubleshooting. By default, the stor‑
age path is under: % USE RPROFILE %\Videos\SessionRecordings, this can be cus‑
tomized by Configurating the basic deployment agent settings.

Note:

The recording will automatically stop when the session duration reaches 30minutes, or the file
size reaches 60 MB.

Example 2: Administrator‑triggered recording

Administrators can trigger recordings for specific active sessions on the machine (for example, to as‑
sist a user with troubleshooting).

The administrator can perform the following steps on the machine hosting the session:

1. Launch PowerShell as an administrator.

2. Import the module as described in the previous section.

3. Get the SessionID of the target user session by using query session command.
query session | Select-String "Active"
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4. Use the Get-SessionRecordingStatus -SessionId <SessionID> command to
check the recording status, ensure the session is not already being recorded. The status is
supposed to
be shown as below:

5. Use the Start-SessionRecording -SessionId <SessionID> command to start
recording the session.

6. Use the Get-SessionRecordingStatus -SessionId <SessionID> command to
check the recording status, ensure the session is being recorded. The status is supposed to be
Recording.

7. Instruct the user to reproduce the issue or perform the operations that need to be documented.

8. Use theStop-SessionRecording -SessionId <SessionID> to stop recording once
the operations are complete.

9. Find the recording file under the target user profile, such as:
C:\Users\user0\Videos\SessionRecordings and proceed with the follow‑up trou‑
bleshooting.

Start or stop recording by using Hotkey

End users can also control recording using shortcut keys (Hotkeys). By default, this feature is dis‑
abled.

Enable Hotkeys To enable hotkey functionality, on the VDAmachine:

Set-SessionRecordingConfiguration -PerMachine -EnableHotkeys $true

This command requires a local administrator account to execute.

The setting is applied permachine and will take effect for subsequent active sessions.

Default Hotkeys

Once enabled, the default hotkeys are:

• Start recording: CTRL + SHIFT + F8
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• Stop recording: CTRL + SHIFT + F9

Note:

By default, the storage path is under: %USERPROFILE%\Videos\SessionRecordings,
this can be customized by Configurating the basic deployment agent settings.

The recording will automatically stop when the session duration reaches 30minutes, or the file
size reaches 60 MB.

Customize Hotkeys

If the default hotkeys conflict with other applications, you can customize them using the following
command:

Set-SessionRecordingConfiguration -PerMachine -StartHotKey <hotkey> -
StopHotKey <hotkey>

Hotkey rules:

• Only F1–F12 or capital letters (A–Z) can be used as the last key.
• You only define the last key in the combination. The CTRL + SHIFT prefix is mandatory and
automatically applied.

Example: To set the start hotkey to CTRL + SHIFT + F1, you would enter F1 as the <hotkey>.

Start or stop recording by using Dynamic Recording

You can also trigger recordings using Dynamic Session Recording policies. For more information, see
Dynamic Session Recording.

Note:

By default, the storage path is under: %USERPROFILE%\Videos\SessionRecordings,
this can be customized by Configurating the basic deployment agent settings.

The recording will automatically stop when the session duration reaches 30minutes, or the file
size reaches 60 MB.

Configurating the basic deployment agent settings

You can customize the settings for the basic deployment agent using PowerShell commands. These
settings are applied at the machine or user level.
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Prerequisites

Before configuring the settings, youmust import thenecessarymodule into thePowerShell session.

1. Open PowerShell and navigate to the agent installation folder: <SessionRecordingAgent
installation path>\Bin folder.

For example: cd "C:\Program Files\Citrix\SessionRecording\Agent\Bin
\"

2. Import the module by running:

import-module -DisableNameChecking.\EndUserInitiatedSRSnapin.dll

PowerShell configuration commands

The following table lists the PowerShell commands for managing session recording configuration:

Command Description

Set‑SessionRecordingConfiguration Sets session recording configuration values at
the machine or user level. For more information,
run Get-Help
SetSessionRecordingConfiguration

Get‑SessionRecordingConfiguration Gets the effective session recording
configuration or queries raw values from specific
registry scopes (Machine, User, or Session). For
more information, run Get-Help
GetSessionRecordingConfiguration

Clear‑SessionRecordingConfiguration Clears session recording configuration values at
the machine or user level, reverting them to
machine‑level or default values. For more
information, run Get-Help
ClearSessionRecordingConfiguration
.

Configuration settings

The settings available for the basic deployment mode are listed as follows. You can use the Set-
SessionRecordingConfiguration cmdlet to configure them.
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Add the -PerMachine switch parameter to apply the configuration at the machine. This requires
administratorprivileges. If specified, the settings apply to themachine level. If omitted, settings apply
to the user level.

Property Type Setting Scope Default Note

‑
AllowUserTrigger

Boolean Allow
endusertrig‑
gered
recording

Machine True Controls
whether users
canmanually
start/stop
recordings

‑StoragePath String Recording
storage path

Machine, User,
Session

%USERPRO
FILE%\Videos\Session
Recordings

The directory
where
recording files
are saved.
This directory
can be located
on a local
drive, a UNC
network path,
or a mounted
drive.

‑
MaximumDurationInMinutes

Int Maximum
recording
duration

Machine, User,
Session

30 The session
automatically
stops
recording
after this
duration (in
minutes).

‑
MaximumSizeInMegabytes

Int Maximum file
size

Machine, User,
Session

60 The session
automatically
stops
recording
after reaching
this size (in
MB).
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Property Type Setting Scope Default Note

‑
EnablePreRecording

Boolean Enable
prerecording

Machine False Enable
pre‑recording
before
recording
trigger.

‑
EnablePreRecording

Boolean Enable
prerecording

Machine False Enable
pre‑recording
before
recording
trigger.

‑
PreRecordingDurationInSeconds

Int Prerecording
duration

Machine 30 The duration
of the
pre‑recording
buffer in
seconds.

‑
EnableHotkeys

Boolean Enable
hotkeys

Machine False Enables
hotkeys for
start/stop
recording

‑StartHotkey String Start
recording
hotkey

Machine F8 Default maps
to CTRL +
SHIFT + F8.

‑StopHotkey String Stop
recording
hotkey

Machine F9 Default maps
to CTRL +
SHIFT + F9.

‑ScreenId Int The screen ID
to record

Machine, User,
Session

0 Use 0 for all
screens.

Note:

If you customize these settings at multiple levels, the priority order is: Session > User > Machine.

Example Configuration

These examples illustrate how different users set configurations and how the agent determines the
final, effective setting.
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Example 1: Administrator Disabling User‑Triggered Recording A local administrator (e.g. Local‑
Admin) can set a machine‑wide policy to disable the ability for all standard users to start recordings
manually.

Set-SessionRecordingConfiguration -PerMachine -AllowUserTrigger
$false

Explanation: This command requires administrative privileges (-PerMachine) and prevents any
user on this VDA from using Start-SessionRecording, regardless of their user‑level settings.

Example 2: Administrator Setting Machine‑Wide Defaults The LocalAdmin sets the default stor‑
age location, maximum duration, andmaximum size for all users on the VDA.

Set-SessionRecordingConfiguration -PerMachine -StoragePath
"D:\SessionRecordings"-MaximumDurationInMinutes 120 -
MaximumSizeInMegabytes 500

Explanation: This sets the configuration at theMachine level. For a standarduser (e.g. User0), record‑
ingswill nowdefault to D:\SessionRecordings and stop after 120minutes or 500MB,whichever comes
first.

Example3: StandardUserOverridingMachineDefaults The standarduser (User0) prefers to save
their files locally to the C: drive, overriding the administrator’s Machine‑level setting.

Set-SessionRecordingConfiguration -StoragePath
"C:\Users\User0\ SessionRecordings" -MaximumDurationInMinutes 60

Explanation: Since this command is run without the -PerMachine switch, it applies at the User
level. Because User‑level settings have a higher priority than Machine‑level settings, User0’s record‑
ings will now be saved to C:\Users\User0\ SessionRecordings and stop after 60 minutes.

Example 4: Session‑Specific Override During a specific recording, User0 needs to temporarily
save the file to a network share (\\fileshare\temp) and limit the duration to 15 minutes, overriding
both User and Machine settings.

Start-SessionRecording -StoragePath "\\fileshare\temp"- MaximumDurationInMinutes
15

Explanation: Parameterspasseddirectly toStart-SessionRecording to createa session‑level
override, which has the absolute highest priority and is only valid for that single recording instance.
The next recording session will revert to the User or Machine configuration.
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Checking Configuration

Use the Get-SessionRecordingConfiguration commandlet to view the currently config‑
ured values and the final effective setting:

Get-SessionRecordingConfiguration

Explanation: This command shows the result of applying the hierarchy (Session > User > Machine),
providing the settings currently in use for the user running the command.

Clearing Configuration

Use the Clear-SessionRecordingConfiguration commandlet to remove custom settings,
allowing the agent to fall back to the next‑highest priority configuration.

• Clear specific user settings:

If User0 wants to stop saving files to C:\Users\User0\SessionRecordings and revert custom set‑
tings to the default setting, they would run:

Clear-SessionRecordingConfiguration -StoragePath - MaximumDurationInMinutes

Explanation: This clears the StoragePath and MaximumDurationInMinutes values from the
User scope.

• Clear all machine‑level configurations (Requires Administrator Privileges):

Clear-SessionRecordingConfiguration -PerMachine -ClearAll

Explanation: This command requires administrative privileges (-PerMachine) and clears all cus‑
tom configurations set at the Machine level.

Switch the agent deployment type

The Session Recording agent supports two distinct deployment modes:

• Basic deploymentmode: This provides a lightweight method to record active sessions locally
as MP4 files without deploying backend components. This mode is active when the Session
Recording Server address is set to localhost.

• Standarddeploymentmode: This is the traditional, centrallymanageddeploymentwhere the
agent connects to a Session Recording Server. This mode offers high scalability and advanced
features. This mode is active when the Session Recording Server address is set to the Fully
Qualified Domain Name (FQDN) of the server.
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Theoperationalmode isdeterminedby theSessionRecordingServervalueconfigured in theSession
Recording Agent Properties or the Windows registry.

Method 1: Using the Session Recording Agent Properties

You can switch modes manually on a specific VDA.

1. Log on to the VDA where the Session Recording agent is installed.

2. From the Startmenu, choose Session Recording Agent Properties.

3. Click the Connections tab.

4. Modify the value in the Session Recording Server field:

a) Basic deploymentmode: Enter localhost.
b) Standard deploymentmode: Enter the FQDN of your Session Recording Server.

5. ClickOK to save the changes.

Method 2: Using the Windows Registry or Group Policy

For large‑scale deployments, you can configure the setting directly in the Windows Registry, typically
deployed via Group Policy Object (GPO).

• Registry Key: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent\

• Value Name: SmAudServerName

• Value Data:

• For basic deploymentmode: Set the value to localhost.
• For standard deployment mode: Set the value to the FQDN of your Session Recording
Server.

Note:

Key considerations for mode switching

• The Session Recording agent reads the configuration value only at the start of a ses‑
sion. Any change to the deployment mode will take effect on the next new session
launched on the VDA.

• It is strongly recommended that you do not switch modes while there are active or
in‑progress recording sessions. Wait for all active recordings to stop to prevent data
consistency issues.
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Manage recording files

Session Recording provides a local tool, SRAgentTool.exe, to help you manage recording files. The
tool offers the following capabilities:

• Recover corrupted MP4 recordings: Repairs MP4 files that are unplayable due to abnormal situ‑
ations, such as an unexpected graphics process crash.

• Verify MP4 recording integrity: Checks whether a recording file has been tampered with to en‑
sure its authenticity.

Youcanaccess the tool in the followingdirectory: <Session RecordingAgent installation
path>\Bin.

View usage instructions

To view the help information and usage instructions for the tool, run the following command in Pow‑
erShell or Command Prompt:

.\SRAgentTool.exe --help

Or

.\SRAgentTool.exe -h

Recover corrupted recordings

If a recording file cannot be played, use the recovery command to attempt a repair.
Command:

.\SRAgentTool.exe --recover <path_to_mp4>

Output:

• Success: The tool displays Recover success and shows the path of the newly recovered file
(typically suffixed with _recover.mp4).
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• Norecoveryneeded: If the file is alreadyplayable, the tool displaysThe file canplaynormally,
need not recover.

Verify recording integrity

To verify that a recording file has not beenmodified, use the validation command to check its SHA512
signature.

Command: .\SRAgentTool.exe --valid <path_to_mp4>

Output:

• Valid: The sha512 signature matches successfully.

• Tampered: The sha512 signature does not match.

• Invalid File: The file is not legal mp4 file.

Best practices

June 21, 2024

You can consult the following best practices documentation for deploying Session Recording and con‑
figuring load balancing:

• Configure load balancing in an existing deployment
• Deploy and load‑balance Session Recording in Azure
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Configure load balancing in an existing deployment

December 26, 2025

You can add load balancing nodes using Citrix ADC in an existing Session Recording deployment. The
following servers are used as an example. You can also deploy and load‑balance Session Recording
in Azure.

• Session Recording

Host Name Server Role OS IP Address

SRServer1 Session Recording
server

Windows Server 10.63.32.55

LBDC Domain controller Windows Server 10.63.32.82

TSVDA Session Recording
agent

Windows Server 10.63.32.215

SRSQL Session Recording
database and the file
server

Windows Server 10.63.32.91

All SessionRecording components and thedomain controller share adomain, for example,lb.
com. The domain administrator account, for example, lb\administrator, is used for server logon.

• Citrix ADC

Host Name Server Role
Management IP
Address (NSIP)

Subnet IP Address
(SNIP)

Netscaler Citrix ADC VPX instance 10.63.32.40 10.63.32.109

For more information, see Deploy a Citrix ADC VPX instance.

Step 1: Create shared folders on the file server

1. Log on to the file server by using a domain administrator account, for example, lb\
administrator.

2. Create a folder to store recordings and name the folder SessionRecording, for example, C
:\SessionRecording. Share theRead/Writepermissionof the folderwithaSessionRecord‑
ing server. Using SRServer1 as an example, type LB\SRSERVER1$. The dollar sign $ is re‑
quired.
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3. Create a subfolderwithin theSessionRecording folder and name the subfoldershare, for
example, C:\SessionRecording\share.
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4. Createanother folder to restorearchived recordingsandnamethe folderSessionRecordingsRestored
, for example, C:\ SessionRecordingsRestored. Share the Read/Write permission
of the folder with a Session Recording server. Using SRServer1 as an example, type
LB\SRSERVER1$. The dollar sign $ is required.

5. Create a subfolder within the SessionRecordingsRestored folder and name the
subfolder share, for example, C:\ SessionRecordingsRestored\share.

Step 2: Configure an existing Session Recording server to support load balancing

This step describes how to configure an existing Session Recording server to support load balancing.
Step 7details the procedure of addingmore SessionRecording servers to your existing deployment.

1. Log on to a Session Recording server by using a domain administrator account.

2. Open Session Recording Server Properties.
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3. Add the Universal Naming Convention (UNC) paths created in Step 1 to store and restore
recording files, in this example, \\SRSQL\SessionRecording\share and \\SRSQL\
SessionRecordingRestored\share. SRSQL is the host name of the file server.

Note:

The Session Recording player cannot play files under a path that contains a drive letter or
a dollar sign ($). The exception is that you install the player and the Session Recording
server on the samemachine.
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4. Add a value to the Session Recording server registry key at HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server.

Value name: EnableLB
Value data: 1 (D_WORD, meaning enable)
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5. Restart the Citrix Session Recording Storage Manager service.

Step 3: Configure load balancing in Citrix ADC

There are twoways to configure load balancing in Citrix ADC ‑ TCP passthrough and SSL offloading.

Configure load balancing through TCP passthrough

The following topologies show how to configure load balancing through TCP passthrough.

• If you are using the Python‑based WebSocket server (Version 1.0):
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• If you are using the WebSocket server hosted in IIS (Version 2.0):

To configure load balancing through TCP passthrough, complete the following steps:

1. Log on to your Citrix ADC VPX instance.

2. Navigate to Configuration > System > Settings > Configure Basic Features.
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3. Select Load Balancing and clickOK.

4. Add load balancing servers.

Navigate to Traffic Management > Load Balancing > Servers and click Add.
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Type the nameand IP address of a SessionRecording server and then clickCreate. For example:

Click the save icon in the upper right corner to save your changes.
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5. For WebSocket server Version 1.0, add load balancing services of ports 80, 1801, 22334, and
443 for each Session Recording server. For WebSocket server Version 2.0, add load balancing
services of ports 80, 1801, and 443 for each Session Recording server.

Navigate to Traffic Management > Load Balancing > Services and click Add.

Type a name for each load balancing service that you add. Choose Existing Server, select the
IP address of your target Session Recording server, select TCP as the server protocol, and type
a port number. ClickOK.
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Bind the TCP protocol monitor to each load balancing service.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 374



Session Recording 2603

Click the save icon in the upper right corner to save your changes.

Tip:

The load balancing service of port 22334 is required only for WebSocket server Version
1.0.

6. Add load balancing virtual servers.

For WebSocket server Version 1.0, complete the following steps to add load balancing virtual
servers of ports 80, 443, 1801, and 22334. For WebSocket server Version 2.0, add load balanc‑
ing virtual servers of ports 80, 443, and 1801. For example:
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Navigate to Traffic Management > Load Balancing > Virtual Servers and click Add.

Add each virtual server with the Citrix ADC VIP address based on the TCP protocol.
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Bind each virtual server to the load balancing service of the same port. For example:
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Choose a load balancing method.
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Configure persistence on each virtual server. We recommend you select SOURCEIP as the per‑
sistence type. For more information, see Persistence settings.
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7. Create a host record for the Citrix ADC VIP address on the domain controller.
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8. To access the web player over HTTPS, ensure that a SAN certificate is available both on Citrix
ADC and on each Session Recording server. A SAN certificate contains the FQDNs of the Citrix
ADC and of each Session Recording server.

Configure load balancing through SSL offloading

The following topologies show how to configure load balancing through SSL offloading.

• If you are using the Python‑based WebSocket server (Version 1.0):
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• If you are using the WebSocket server hosted in IIS (Version 2.0):

1. Log on to your Citrix ADC VPX instance.
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2. Navigate to Configuration > System > Settings > Configure Basic Features.

3. Select SSL Offloading and Load Balancing and clickOK.

4. Add load balancing servers.

Navigate to Traffic Management > Load Balancing > Servers and click Add.
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Type the nameand IP address of a SessionRecording server and then clickCreate. For example:

Click the save icon in the upper right corner to save your changes.
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5. Add load balancing services for each Session Recording server that you added in the previous
step.

Add the following load balancing services for each Session Recording server:

• (Required only when you are using theWebSocket server Version 1.0) SSL load balancing
service of port 22334 that binds to the TCPmonitor

• SSL load balancing service of port 443 that binds to the HTTPSmonitor
• TCP load balancing service of port 1801 that binds to the TCPmonitor

For example:

Navigate to Traffic Management > Load Balancing > Services and click Add.
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(Required only when you are using the WebSocket server Version 1.0) Add an SSL load
balancing service of port 22334 for each Session Recording server. Type a name for the
load balancing service, choose Existing Server, select the IP address of a Session Recording
server, select SSL as the server protocol, type port number 22334, and clickOK.

For example, see the following screen capture.

Bind the TCPmonitor to the SSL load balancing service you just added.
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Add an SSL load balancing service of port 443 for each Session Recording server. Type a
name for the load balancing service, choose Existing Server, select the IP address of a Session
Recording server, select SSL as the server protocol, type port number 443, and clickOK.
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Bind the HTTPSmonitor to the SSL load balancing service you just added.
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Add a TCP load balancing service of port 1801 for each Session Recording Server. Type a
name for the load balancing service, choose Existing Server, select the IP address of a Session
Recording server, select TCP as the server protocol, type port number 1801, and clickOK.
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Bind the TCPmonitor to the TCP load balancing service you just added.
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6. (Required only when you are using the WebSocket server Version 1.0) Add an HTTP profile for
each SSL load balancing service of port 22334.

Navigate to System > Profiles > HTTP Profiles and click Add.
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Select the Enable WebSocket connections check box and accept the other default settings.
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Type a name for the HTTP profile, for example, websocket_SSL.

Go back to each SSL load balancing service of port 22334, for example, srv-1-22334. Click
+ Profiles.
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Select the HTTP profile, for example, websocket_SSL, and clickOK and then Done.

7. (Required only when you are using the WebSocket server Version 2.0) Add an HTTP profile for
each SSL load balancing service of port 443.

8. Create a host record for the Citrix ADC VIP address on the domain controller.
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9. Add load balancing virtual servers.

Add the following load balancing virtual serverswith the Citrix ADC VIP address.

• (Required only when you are using theWebSocket server Version 1.0) load balancing vir‑
tual server of port 22334 based on SSL

• load balancing virtual server of port 443 based on SSL
• load balancing virtual server of port 1801 based on TCP

For example, see the following screen capture.

Navigate to Traffic Management > Load Balancing > Virtual Servers and click Add.
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Add each virtual server with the Citrix ADC VIP address. Type a server name, select TCP or SSL,
and select the relevant port number as described earlier.

Bind each virtual server to the load balancing service of the same port. For example:
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Tip:

The load balancing service of port 22334 is required only when you are using the Web‑
Socket server Version 1.0.

Choose a load balancing method.
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Configure persistence on each virtual server. We recommend you select SOURCEIP as the per‑
sistence type. For more information, see Persistence settings.
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(Required only when you are using the WebSocket server Version 1.0) Add an HTTP profile for
the load balancing virtual server of port 22334.
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10. Install a Subject Alternative Name (SAN) certificate in Citrix ADC.

Obtain a SAN certificate in PEM format from a trusted Certificate Authority (CA). Extract and up‑
load the certificate and private key files in Citrix ADC by navigating to Traffic Management >
SSL > Server Certificate Wizard.

For more information, see SSL certificates.

11. Bind a SAN certificate to each SSL load balancing virtual server.

Navigate to Traffic Management > Load Balancing > Virtual Servers, select an SSL load bal‑
ancing virtual server, and click Server Certificate.
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Add the previously mentioned SAN certificate and click Bind.

Step 4: Configure an existing Session Recording agent to support load balancing

1. Log on to the Session Recording agent by using a domain administrator account.

2. Open Session Recording Agent Properties.

3. Complete this step if you use Microsoft Message Queuing (MSMQ) over TCP.
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Type your Citrix ADC VIP address or FQDN in the Session Recording Server box.

On each Session Recording server, add and set the IgnoreOSNameValidation
DWORD value to 1 under HKEY_LOCAL_MACHINE\ SOFTWARE\Microsoft\MSMQ\
Parameters.

4. Complete this step if you use MSMQ over HTTP or HTTPS.

(Skip if this step is done) Create a host record for the Citrix ADC VIP address on the domain con‑
troller.
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OneachSessionRecordingserver, run thepowershell.exe -file SrServerConfigurationSync
.ps1 –Action AddRedirection – ADCHost <ADCHost> command to add redirec‑
tions fromCitrix ADC to the local host. <ADCHost> is the FQDN of the Citrix ADC VIP address. A
redirection file, for example,sr_lb_map.xml is generated underC:\Windows\System32
\msmq\Mapping.

Note: Change to the folder where SrServerConfigurationSync.ps1 resides when you
run PowerShell.exe.

Type the FQDN of your Citrix ADC VIP address in the Session Recording Server box. For exam‑
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ple:

Step 5: Configure an existing Session Recording player to support load balancing

On each machine where you installed the Session Recording player component, add the Citrix ADC
VIP address or its FQDN as the connected Session Recording server.

Step 6: Check whether load balancing works for the configured, existing Session
Recording server

1. Launch a Citrix virtual session.
2. Check whether the session can be recorded.
3. Check whether the web player and the Session Recording player can play back the recording

file.

Step 7: Addmore Session Recording servers

1. Prepare amachine in the same domain and install the Session Recording server, database, and
administrator logging modules on the machine.

Note:

The Session Recording administrator logging is an optional subfeature of the Session
Recording server. Select the Session Recording server before you can select the Session
Recording administrator logging. The Session Recording database is a mandatory subfea‑
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ture of the Session Recording server. When the Session Recording server is selected for
installation, the Session Recording database is also selected automatically and cannot be
unselected.

2. Use the same database names as the existing Session Recording server. For example:
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3. Disable the network firewall on the machine.

4. On the SQL Server where you installed the Session Recording database, add all the Session
Recording servermachine accounts to the shared Session Recording database and assign them
with the db_owner permission. For example:
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5. Share the Read/Write permission of the recording storage and restore folders, for example,
SessionRecording and SessionRecordingsRestored, with the machine account
of the new Session Recording server, for example, LB\SRServer2$. The dollar sign $ is
required.

6. Repeat Step 3 to add load balancing services for the new Session Recording server and edit
existing virtual servers to add bindings to the load balancing services. There is no need to add
more virtual servers. For example:
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7. Copy theSessionRecordingAuthorizationConsoleconfiguration file,SessionRecordingAzManStore
.xml, from the existing Session Recording server to the new Session Recording server. The file
lives in <Session Recording server installation path>\App_Data.

8. To useMSMQoverHTTPorHTTPS for the newSession Recording server, complete the following
steps to import the registry settings of the currently functioning Session Recording server.

On the existing Session Recording server, for example, SRServer1, run the powershell
.exe -file SrServerConfigurationSync.ps1 –Action Export – ADCHost
<ADCHost > command, where <ADCHost> is the FQDN of the Citrix ADC VIP address. An

exported registry file, SrServerConfig.reg, is generated.

Copy the SrServerConfig.reg file to the new Session Recording server and run the
powershell.exe -file SrServerConfigurationSync.ps1 –Action Import
,AddRedirection – ADCHost <ADCHost> command. The EnableLB value is added
to the registry key of the new Session Recording server at HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server and a sr_lb_map.xml file is added
under C:\Windows\System32\msmq\Mapping.

9. Repeat the procedure to add another Session Recording server.
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Troubleshoot

• Sessions are not recording when you use a CNAME record or an ALIAS record for a Session
Recording server. To address this issue, see the Microsoft documentation.

• Recording files can be stored locally but cannot be stored in a Universal Naming Convention
(UNC) path. To address this issue, change the startmodeof theCitrix SessionRecording Storage
Manager service to Automatic (Delayed Start).

Deploy and load balance Session Recording in Azure

December 26, 2025

Prerequisites

• You already have Citrix Virtual Apps and Desktops™ or Citrix DaaS (formerly Citrix Virtual Apps
and Desktops service) installed in Azure.

• You have an Azure account.

Step 1: Upload the Citrix Virtual Apps™ and Desktops installer to Azure

Note:

Skip Step 1 if you use your Citrix account credentials to access the Citrix Virtual Apps and Desk‑
tops download page and download the product ISO file to a VM in Azure.

1. In the Azure portal, create a general‑purpose v2 storage account and accept the default perfor‑
mance tier, Standard.

All access to Azure Storage goes through a storage account.
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2. Navigate to your new storage account and select Containers in the Blob service section to cre‑
ate a container.
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3. Upload the Citrix Virtual Apps and Desktops installer to the container.

Step 2: Create a SQLmanaged instance in the Azure portal

For more information, see Create an Azure SQL Managed Instance.

Step 3: Create Azure virtual machines (VMs)

ChooseWindows Server 2019 Datacenter –Gen1 for the image and Standard_D4as_v4 –4 vcpus,
16GiBmemory for the size. Formore information, see Create aWindows virtualmachine in the Azure
portal.
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Step 4: Remote desktop and download the Citrix Virtual Apps and Desktops installer to
the Azure VMs

Step 5: Run the installer to install Session Recording components on the Azure VMs

For more information, see Install the Session Recording Administration components.

Step 6: Configure an Azure file share to store recordings

To create an Azure file share to store recordings, complete the following steps:

1. In the Azure portal, create a storage account and then create an Azure file share.

For a quick start guide, see Create and manage Azure file shares with the Azure portal. The
following table recommends configurations for your consideration.

Recording File
Size MB/hour

Number of
Recorded
Sessions Per
Day

File Share
Type

File Share
Quota (TB)

Session
Recording
Server
Quantity

Session
Recording
Server Size

< 6.37 < 1,000 HDD Standard
(StorageV2)

2 1 Standard
D4as_v4

< 6.37 1,000–2,000 SSD Premium 3 1 Standard
D4as_v4
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Recording File
Size MB/hour

Number of
Recorded
Sessions Per
Day

File Share
Type

File Share
Quota (TB)

Session
Recording
Server
Quantity

Session
Recording
Server Size

< 6.37 2,000–3,000 SSD Premium 5 1 Standard
D4as_v4

< 6.37 3,000–4,000 SSD Premium 6 1 Standard
D4as_v4

Approx.10 < 1,000 HDD Standard
(StorageV2)

3 1 Standard
D4as_v4

Approx.10 1,000–2,500 SSD Premium 6 1 Standard
D4as_v4

Approx.10 2,500–4,000 SSD Premium 10 2 Standard
D4as_v4

The file share quota is calculated based on eight hours per day, 23working days permonth, and
a one‑month retention period for each recording file.

2. Add theAzure file share credentials to thehostwhere you installed theSessionRecording server.

a) Start a command prompt as an administrator and change the drive to the <Session
Recording server installation path>\Bin folder.

By default, the Session Recording server is installed in C:\Program Files\Citrix\
SessionRecording\Server.

b) Run the SsRecUtils.exe ‑AddAzureFiles <storageAccountName> <fileShareName>
<accesskey> command.

Where,

• <storageaccountname> is the name of your storage account in Azure.
• <filessharename> is the name of the file share contained within your storage
account.

• <accesskey> is your storage account key that can be used to access the file share.

There are two ways to obtain your storage account key:

• You can obtain your storage account key from the connection string that appears
when you click the Connect icon in your file share page.
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• You can also obtain your storage account key by clicking Access keys in the left navi‑
gation of your storage account page.
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c) Mount the Azure file share to the host where you installed the Session Recording server.

i. Open Session Recording Server Properties.

ii. Click Add on the Storage tab.

iii. Enter theUNCpath in the formatof \\<storageaccountname>.file.core.windows.net\<filessharename>\<subfolder>.

Specify a subfolder under the file share to store your recording files. The Session
Recording server then automatically creates the subfolder for you.
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iv. ClickOK in the File Storage Directory dialog box.

v. Click Apply in the Session Recording Server Propertieswindow.

vi. ClickOK after Apply becomes grayed out.

vii. Click Yes when you are prompted to restart the Session Recording Storage Manager
service.

Step 7: Add a load balancer

If there is more than one Session Recording server, we recommend you add a load balancer in front
of them. Azure offers many options to load‑balance traffic requests. This section walks you through
the process of creating Citrix ADC, Azure Load Balancer, and Azure Application Gateway in Azure.
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Option 1: Create a Citrix ADC VPX instance in Azure

1. In the Azure portal, type Citrix ADC in the search box.

2. Choose the Citrix ADC VPX Bring Your Own License plan and then click Create.

3. Select or create a resource group and set the other settings on the Basics tab.

4. Set VM configurations.
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5. Check and modify network settings if necessary. Choose ssh (22), http (80), https (443) for
public inbound ports.

A virtual network is automatically created. If youalreadyhaveaSessionRecording environment
installed, you can use its virtual network and server subnet settings.

© 1997–2026 Citrix Systems, Inc. All rights reserved. 421



Session Recording 2603

© 1997–2026 Citrix Systems, Inc. All rights reserved. 422



Session Recording 2603

6. Click Next: Review + create to create the Citrix ADC VPX instance and wait for the deployment
to complete.
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7. Set the subnet IP (SNIP) address and the Citrix ADC VIP address to be on the same subnet.

The SNIP address and the VIP address must be on the same subnet. In this example, we set the
VIP address to be on the subnet of the SNIP address.

a) Stop the citrix‑adc‑vpx virtual machine.

b) Change the subnet of the VIP address.
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c) Start the citrix‑adc‑vpx virtual machine

Option 2: Create an Azure load balancer

Azure Load Balancer is a TCP passthrough service. The following diagram shows load balancing
through TCP passthrough.
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1. Create an Azure load balancer.

a) Search in the Azure portal and select Load Balancers from theMarketplace.

On theBasics tab of theCreate loadbalancerpage, configure settings as described in the
following table:

Setting Value

Subscription Select your subscription.

Resource group For example, select srlbtest created earlier.

Name Enter SRLoadBalance.

Region Select (US) East US.

Type Select Internal.

SKU Select Standard
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Setting Value

Virtual network For example, select srazureautovnet created
earlier.

Subnet For example, select srazureautosubnet created
earlier.

IP address assignment Select Dynamic.

Availability zone Select Zone‑redundant.

b) Add loadbalancer resources, includingaback‑endpool, healthprobes, and loadbalancing
rules.

• Add a back‑end pool.
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Select the load balancer you created from the resources list and click Backend pools
in the left navigation. Click Add to add a back‑end pool.

Enter a name for the new back‑end pool and then click Add.
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• Add health probes.
Select the load balancer you created from the resources list and then click Health
probes in the left navigation.

Click Add to add health probes on ports 80, 22334, 1801, and 443.

For example, use the following settings to create a health probe on port 80.

Setting Value

Name Enter SRHealthProbe80.
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Setting Value

Protocol Select TCP.

Port Enter 80.

Interval 5

Unhealthy threshold Select 2 for the number of unhealthy threshold
or consecutive probe failures that must occur
before a VM is considered unhealthy.

• Add a load balancing rule.
Select the load balancer you created from the resources list and then click Load bal‑
ancing rules in the left navigation. Click Add to add a load balancing rule.
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Click Add to add load balancing rules for ports 80, 22334, 1801, and 443.

For example, use the following settings to create a load balancing rule for port 80.
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Setting Value

Name Enter a name, for example, SRTCPRule80.

IP Version Select IPv4.

Frontend IP address Select LoadBalancerFrontEnd.

Protocol Select TCP.

Port Enter 80.

Backend port Enter 80.

Backend pool Select SRBackendPool.

Health probe Select SRHealthProbe80.

Session persistence Select Client IP.

Idle timeout (minutes) Accept the default setting.

TCP reset Select Enabled.

Outbound source network address translation
(SNAT)

Select (Recommended) Use outbound rules to
provide backend pool members access to the
internet.
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• Add the Azure VMs where the Session Recording server is installed to the back‑end
pool.
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c) Test the Azure load balancer.
If you cannot add a server to the back‑end pool and the following error message appears
NetworkInterfaceAndLoadBalancerAreInDifferentAvailabilitySets, disassociate the
public IP address of the server network interface.
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Option 3: Create an Azure application gateway

Tip:

Application Gateway V2 does not support routing requests through an NTLM‑enabled proxy.

1. Create an Azure application gateway.

Configure the following settings when you create an application gateway.

• On the Basics tab, set Tier to Standard.
• On the Frontends tab, set Frontend IP address type to Private. The new application
gateway is used as an internal load balancer.

2. Add a back‑end pool.
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3. Create HTTP settings.

Azure Application Gateway supports both HTTP and HTTPS for routing requests to back‑end
servers. Create HTTP settings for ports 80, 443, and 22334.

• HTTP over port 80
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• HTTP over port 443

An authentication certificate is required to allow back‑end servers in Application Gateway
V1. The authentication certificate is the public key of back‑end server certificates in Base‑
64 encodedX.509(.CER) format. For informationonhow to export thepublic key fromyour
TLS/SSL certificate, see Export authentication certificate (for v1 SKU).
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• HTTP or HTTPS over port 22334

If WebSocket uses HTTP, use the same setting as port 80.
If WebSocket uses HTTPS, use the same setting as port 443.

4. Add a front‑end IP address.

5. Add listeners.

Add listeners on ports 80, 443, and 22334, for example:
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• Listener on port 80

• Listener on port 443

Create a self‑signed certificate and upload the certificate to the Azure portal when you cre‑
ate the HTTPS listener. For more information, see Certificates supported for TLS termina‑
tion and Create a self‑signed certificate.
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• Listener on port 22334

IfWebSocket usesHTTP, use the samesettingasport 80. IfWebSocket usesHTTPS, use the
same setting as port 443. The following example shows the setting of an HTTPS listener
on port 22334.
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6. Create request routing rules.

Create rules for ports 80, 443, and 22334, for example:
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• Routing rule for port 80
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• Routing rule for port 443

• Routing rule for port 22334
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7. Add the Azure VMs where the Session Recording server is installed to the back‑end pool.

8. Configure Session Recording servers.

• Step 1: Create shared folders on the file server
• Step 2: Configure an existing Session Recording server to support load balancing

Configure GroupManaged Service Account (gMSA) support for Session
Recording

September 7, 2025

Session Recording supports Group Managed Service Accounts (gMSAs) to simplify service principal
name (SPN) management for services running on multiple servers. This feature enhances security
and simplifies the management of service accounts.

Step 1: Create a gMSA on the domain controller

Note:

This section describes how to create a gMSA using Server Manager on the domain controller. Al‑
ternatively, you can run the following script to achieve the same purpose:

1 Add-KdsRootKey -EffectiveImmediately
2 Install-WindowsFeature -Name RSAT-AD-PowerShell
3 NEW-ADGroup – name "gMSA" – path "DC=ajj,DC=test" -GroupCategory

Security -groupscope Global
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4 Add-ADGroupMember "gMSA" -Members "Server-3$"(The dollar sign $ is
must)

5 New-ADServiceAccount IIS1SvC -DNSHostName IIS1Svc.ajj.test -
PrincipalsAllowedToRetrieveManagedPassword gMSA

The Effective time parameter allows time for keys to propagate to all domain controllers (DCs)
before use. Using Add‑KdsRootKey ‑EffectiveImmediately adds a root key to the target DC for
immediate use by the Key Distribution Service (KDS) service. However, other domain controllers
will not be able to use the root key until replication is complete.

1. On the domain controller, open the Active Directory Administrative Center.

2. Select the domain and create a group.

3. Name the group (using gMSA as an example). Set Group type to Security and Group scope to
Global. Add member servers to it. The member servers include machines where the Session
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Recording servers and Session Recording database are installed.

For example, a groupmember is added as follows:

4. After successfully adding a security group, you can search for it using the global search in the
Active Directory Administrative Center. You can view the member servers, and remember to
restart all of them.
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5. Create a gMSA account using theNew‑ADServiceAccount PowerShell cmdlet.

On the domain controller, OpenWindows PowerShell and run the following command to create
a gMSA:

1 New-ADServiceAccount $serviceAccountName -DNSHostName $DNSHostName
-PrincipalsAllowedToRetrieveManagedPassword $groupName

Where,

• $serviceAccountName specifies the name of the gMSA. This article uses IIS1SvC as an
example.

• $DNSHostName specifies the DNS host name, in the format of $serviceAccountName
followed by the domain name of the domain controller.

• $groupName specifies the group allowed to retrieve the managed password. This article
uses gMSA as an example.

Step 2: Install the gMSA on eachmember server

Youmust install the gMSA on each server that will use it.

1. Install the Active Directorymodule forWindows PowerShell, using either the Server Manager or
PowerShell with administrative privileges.

• For an example of using the Server Manager:
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• If you use PowerShell with administrative privileges, run the following command:

1 Install-WindowsFeature -Name RSAT-AD-PowerShell

2. Open Windows PowerShell and run a command similar to the following to install the gMSA.

1 Install-ADServiceAccount IIS1SvC

If you encounter an “Access Denied”error similar to the following, make sure that the current
member server has been added to the allow list of the gMSA and the server has been restarted
afterwards.

3. Verify that you have installed the gMSA successfully by running a command similar to the fol‑
lowing in PowerShell. If the command returns True, the gMSA has been installed successfully.

1 Test-ADServiceAccount IIS1SvC
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Step 3: Enable the gMSA to access the Session Recording database and Session
Recording logging database

1. Create a login for the gMSA. Use the SQL Server Management Studio (SSMS) to connect to the
SQL instance of the Session Recording database.

Name the new login in the format of <domain name of the domain controller>\<name of the
gMSA>. For example:
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2. Enable the gMSA to access the Session Recording database and Session Recording logging data‑
base.

a) Find the names of the Session Recording database and Session Recording logging data‑
base through the Registry. For example, double‑click the following registry keys to get the
value data.
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b) Grant thedb_ownerpermissionof theSessionRecordingdatabaseandSessionRecording
logging database to the gMSA.
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Note:

If you grantdb_datareader anddb_datawriterpermissions insteadof db_ownerpermis‑
sion, you must also grant the execution permission on the databases to the gMSA. For ex‑
ample:

1 use SR2311 grant execute to [name of the login created earlier
]

2 use SR2311log grant execute to [name of the login created
earlier]

Step 3: Enable the gMSA to access the Session Recording servers

Complete the following steps on each Session Recording server:

1. Open Internet Information Services (IIS) Manager on themachine where the Session Recording
server is installed, set the application pool identity to the gMSA, and the restart IIS.
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For example, the following application pool identities have been set to the gMSA

Note:

Alternatively, you can set the application pool identity by running a command similar to
the following using Windows PowerShell:

1 Import-Module WebAdministration -ErrorAction Stop
2 $webapps = Get-ChildItem -Path IIS:\AppPools
3 foreach ($webapp in $webapps) {
4
5 if ($webapp.Name.Contains("SessionRecording")){
6
7 $Pool = "IIS:\AppPools\" + $webapp.Name
8 Write-Host $Pool
9 Set-ItemProperty -Path $Pool -Name processModel -Value

@{
10 userName="AJJ \IIS1SvC$";identitytype=3 }
11
12 }
13
14 }

2. Open the Registry Editor on the machine where the Session Recording server is installed, and
then grant Read permission on the Session Recording server to the gMSA.
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a) Locate the service account object type.

b) Enter the name of the gMSA.

c) Grant Read permission to the gMSA.
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Note:

Alternatively, you can use a script similar to the following to grant Read permission on the
Session Recording server to a gMSA:

1 $RegistryKey = "HKLM:\SOFTWARE\Citrix\SmartAuditor"
2 $NewAcl = Get-Acl -Path $RegistryKey
3 $identity = "pahl6\IIS1SvC$"
4 $RegistryKeyRights = "ReadPermissions"
5 $type = "Allow"
6 $RegistryKeyAccessRuleArgumentList = $identity,
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$RegistryKeyRights, $type
7 $RegistryKeyAccessRule = New-Object System.Security.

AccessControl.RegistryAccessRule -ArgumentList
$RegistryKeyAccessRuleArgumentList

8 $NewAcl.SetAccessRule($RegistryKeyAccessRule)
9 Set-Acl -Path $RegistryKey -AclObject $NewAcl

3. Add the gMSA to the Session recording storage folder and grant it Read and Write permissions
on the folder. After that, enable inheritance and select Replace all child object permission
entries with inheritable permission entries from this object.
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Note:

Alternatively, you can use a script similar to the following to grant Read and Write permis‑
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sions on the Session recording storage folder to a gMSA and to enable inheritance:

1 $path = "C:\SessionRecordings"
2 $NewAcl = Get-Acl $path
3 # Set properties
4 $identity = "pahl6\IIS1SvC$"
5 $fileSystemRights = "Modify"
6 $type = "Allow"
7 # Create new rule
8 $fileSystemAccessRuleArgumentList = $identity,

$fileSystemRights, $type
9 $fileSystemAccessRule = New-Object -TypeName System.Security.

AccessControl.FileSystemAccessRule
$fileSystemAccessRuleArgumentList

10 # Apply new rule
11 $NewAcl.SetAccessRule($fileSystemAccessRule)
12 # enable inherit
13 $isProtected = $false
14 $preserveInheritance = $false
15 $NewAcl.SetAccessRuleProtection($isProtected,

$preserveInheritance)
16 Set-Acl -Path $path -AclObject $NewAcl

4. Add the gMSA to the Session Recording Authorization Console.

a) Find the Security Identifier (SID) for the gMSA.

b) Write theSID to theSessionRecordingAzManStore file under<SessionRecording server
installation path>\App_Data.
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c) Grant full control permission on the App‑Data folder to the gMSA.

d) Verify that the gMSA is successfully added to the Session Recording Authorization Console.
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Note:

Alternatively, you can use a script similar to the following to add a gMSA to the Session
Recording Authorization Console:

1 $account = "IIS1SvC"
2 $AccountDetail = Get-ADServiceAccount -Identity $account
3 $accountSid = $AccountDetail.SID.Value
4 write-host $accountSid
5 $path = "C:\Program Files\Citrix\SessionRecording\Server\

App_Data\SessionRecordingAzManStore.xml"
6 $doc = [xml](Get-Content $path)
7 $node = $doc.AzAdminManager.AzApplication.AzRole | Where-

Object {
8 $_.Name -eq "LoggingWriter" }
9

10 $element = $doc.CreateElement("Member")
11 $element.InnerText = $accountSid
12 $node.AppendChild($element)
13 $doc.Save($path)

Troubleshoot

September 7, 2025

The troubleshooting information contains solutions to some issues that you might encounter during
or after installing the Session Recording components.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix® cannot guarantee that problems resulting from the incorrect use
of the Registry Editor can be solved. Use the Registry Editor at your own risk. Be sure to back up
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the registry before you edit it.

Event ID table

August 15, 2024

The following table provides a quick reference for specific event IDs and their meanings. Each event
ID includes a description and a severity level to help understand the nature of the event and the ap‑
propriate response. If any of these events occur, you can check them in the Windows Event Viewer.
Event logs related to the Session Recording administration components can be viewed on the Ses‑
sion Recording server. Event logs generated by the Session Recording agent can be viewed on the
VDA. Event logs generated by the Session Recording player can be viewed on the machine where the
player is installed.

Event ID Description Level

2001 Database Connection
Established

Information

2002 Service Start Success Information

2003 Service Stop Success Information

2004 Error: Service Start Failure Error

2005 Error: Data Lost For File Error

2006 Warning: Certificate
Approaching Expiry (Days)

Warning

2007 Warning: Certificate
Approaching Expiry (Hours)

Warning

2008 Warning: Certificate
Approaching Expiry (Minutes)

Warning

2009 Error: No Active Policy
Document

Error

2010 Error: Unknown Active Policy
Document

Error

2011 Error: Unsupported Active
Policy Document Version

Error

2012 Error: Method Loading Active
Policy Document

Error
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Event ID Description Level

2013 Error: Failed Verify Generated
Signature

Error

2014 Error: Failed Verify CAS
Configuration

Error

2015 Audit: Successful File
Download

Audit

2016 Audit: Successful File Query Audit

2017 Audit: Successful New Policy
Document

Audit

2018 Audit: Successful Load Policy
Document

Audit

2019 Audit: Successful Save Policy
Document

Audit

2020 Audit: Successful Copy Policy
Document

Audit

2021 Audit: Successful Rename
Policy Document

Audit

2022 Audit: Successful Set Policy
Document Description

Audit

2023 Audit: Successful Set Policy
Document Read Only

Audit

2024 Audit: Successful Delete Policy
Document

Audit

2025 Audit: Successful Set Active
Policy Document

Audit

2026 Message Rejected User On Role
Based Security

Information

2027 Error: Method Principal Access
Check

Error

2028 Error: Method Setting Database
Connection String

Error

2029 Error: Method Get Time
Adjustment

Error

2030 Error: Method Searching Files Error

2031 Error: Method Retrieving Live
File Updates

Error
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Event ID Description Level

2032 Error: Method Opening For
Encryption

Error

2033 Error: Method Opening For
Reading

Error

2034 Error: Method Retrieving
Encryption Percent Complete

Error

2035 Error: Method Reading File Error

2036 Error: Method Querying File Error

2037 Error: Method Closing File Error

2038 Error: Method Enumerating
Account Authorities

Error

2039 Error: Method Enumerating
User Names

Error

2040 Error: Method Enumerating
Group Names

Error

2041 Error: Method Enumerating
Client Names

Error

2042 Error: Method Enumerating
Client Addresses

Error

2043 Error: Method Enumerating
Farm Names

Error

2044 Error: Method Enumerating
Zone Names

Error

2045 Error: Method Enumerating
Server Names For Farm

Error

2046 Error: Method Enumerating
Server Names For Farm And
Zone

Error

2047 Error: Method Enumerating
Server Names For Farm And
Delivery Group

Error

2048 Error: Method Enumerating
Application Names

Error

2049 Error: Method Enumerating
EventType Names

Error

2050 Error: Method Loading Policy
Console Config File

Error
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Event ID Description Level

2051 Error: Method Saving Policy
Console Config File

Error

2052 Error: Method Enumerating
Policy Documents

Error

2053 Error: Method Getting Policy
Document

Error

2054 Error: Method Creating New
Policy Document

Error

2055 Error: Method Loading Policy
Document

Error

2056 Error: Method Saving Policy
Document

Error

2057 Error: Method Copying Policy
Document

Error

2058 Error: Method Renaming Policy
Document

Error

2059 Error: Method Setting Policy
Document Description

Error

2060 Error: Method Deleting Policy
Document

Error

2061 Error: Method Getting Active
Policy Document

Error

2062 Error: Method Setting Active
Policy Document

Error

2063 Error: Method Running Policy
Document Test Query

Error

2064 Error: Method Processing Log
Service Notification

Error

2065 Error: Method Encrypting Error

2066 Error: Method Create Directory Error

2067 Error: Method Receiving
Message

Error

2068 Error: Method Create Recorded
Session File Writer

Error

2069 Error: Method Reopen
Recorded Session File Writer

Error

2070 Error: Method Creating File Error
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Event ID Description Level

2071 Error: Method Open File For
Append

Error

2072 Error: Method Removing LRU Error

2073 Error: Method Getting File
Details

Error

2074 Error: Method Removing
Expired Readers

Error

2075 Error: Method Deleting File Error

2076 Error: Method Writing File Error

2077 Error: Method Writing
Signature

Error

2078 Error: Method Opening Queue Error

2079 Error: Method Receiving From
Queue

Error

2080 Error: Method Establishing
Database Connection

Error

2081 Error: Method Removing
Message From Queue

Error

2082 Error: Method Load Active
Cached Policy Document

Error

2083 Error: Method Init Policy
Engine

Error

2084 Error: Method Enum Player
User Policy Groups

Error

2085 Error: Method New Player User
Policy Group

Error

2086 Error: Method Update Player
User Policy Group

Error

2087 Error: Method Delete Player
User Policy Group

Error

2088 Error: Method Enum Player
User Role Policies

Error

2089 Error: Method New Player User
Account Role Policy

Error

2090 Error: Method Delete Player
User Account Role Policy

Error
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Event ID Description Level

2091 Error: Method Set File Hidden
Attribute

Error

2092 MSMQ storage quota on VDA
was exceeded

Error

Installation of server components fails

September 7, 2025

The installation of the Session Recording server components fails with error codes 2503 and 2502.
Resolution: Check the access control list (ACL) of folder C:\windows\Temp to ensure that the Local
Users and Groups have write permission for this folder. If not, manually add write permission.

Test connection to the database fails during install

September 7, 2025

When you install the Session Recording database or the Session Recording server, the test connection
fails with the error message Database connection test failed. Please correct database instance
name even if the database instance name is correct.

In this case, ensure that the current user has the public SQL Server role permission to correct the
permission limitation failure.

Agent cannot connect to the server

June 21, 2024

When the Session Recording agent cannot connect to the Session Recording server, the Exception
caughtwhile sending pollmessages to SessionRecordingBroker eventmessage is loggedwith an
exception text. The exception text provides reasonswhy the connection failed. The reasons include:

• The underlying connection was closed. Could not establish a trust relationship for the
SSL/TLS secure channel. This exception means that the Session Recording server is using a
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certificate signed by a CA that the server hosting the Session Recording agent does not trust or
the server hosting the Session Recording agent does not have a CA certificate. Alternatively, the
certificate might have expired or been revoked.

Solution: Install a correct CA certificate on the server hosting the Session Recording agent. Use
a CA that is trusted.

• The remote server returned an error: (403) forbidden. This standard HTTPS error occurs
when you attempt to connect using HTTP that is unsecure. The machine hosting the Session
Recording server rejects the connection because it accepts only secure connections.

Solution: Use Session Recording Agent Properties to change the Session Recording Broker
protocol toHTTPS.

• The Session Recording Broker returned an unknown error while evaluating a record pol‑
icy query. Error code 5 (Access Denied). For more information, see the Event log on the
Session Recording server. This error occurs when sessions are started and a request for a
record policy evaluation is made. The error is a result of the Authenticated Users group (the de‑
faultmember) being removed fromthePolicyQuery roleof theSessionRecordingAuthorization
Console.

Solution: Add the Authenticated Users group back to this role, or add each server hosting each
Session Recording agent to the PolicyQuery role.

• The underlying connection was closed. A connection that was expected to be kept alive
was closed by the server. This error means that the Session Recording server is down or un‑
available to accept requests. The IIS might be offline or restarted, or the entire server might be
offline.

Solution: Verify that the Session Recording server is started and connected to the network.
Make sure that IIS is running on the server.

• The remote server returned an error: 401 (Unauthorized). This error manifests itself in the
following ways:

• On startup of the Session Recording agent service, an error describing the 401 error is
recorded in the event log.

• Policy query fails on the Session Recording agent.
• Session recordings are not captured on the Session Recording agent.

Solution: Ensure that theNT AUTHORITY\AuthenticatedUsers group is amember of the local
Users group on the Session Recording agent.
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Server cannot connect to the database

September 7, 2025

When the Session Recording server can’t connect to the Session Recording database, you might see
a message similar to one of the following:

Event Source:

A network‑related or instance‑specific error occurred while establishing a connection to SQL
Server. This error appears in the applications event logwith ID 2047. You can find the event log in the
Event Viewer on the Session Recording server.

Citrix Session Recording Storage Manager Description: Exception caught while establishing
database connection. This error appears in the applications event log in the Event Viewer of the
Session Recording server.
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Unable to connect to the Session Recording server. Ensure that the Session Recording server is
running. This error message appears when you launch the Session Recording policy console.

Resolution:

• You installed Microsoft SQL Server on a stand‑alone server and failed to configure the correct
services or settings for Session Recording. The server must have the TCP/IP protocol enabled
and the SQL Server Browser service running. See the Microsoft documentation for information
about enabling these settings.

• During the Session Recording installation (administration portion), incorrect server/database
information was given. Uninstall the Session Recording database and reinstall it, supplying the
correct information.

• The Session Recording database server is down. Verify that the server has connectivity.
• The machine hosting the Session Recording server or the machine hosting the Session Record‑
ing database server cannot resolve the FQDN or NetBIOS name of the other. Use the ping com‑
mand to verify that the names can be resolved.

• Check the firewall configuration on the Session Recording Database to ensure that the SQL
Server connections are allowed. Formore information, see the Microsoft article at https://docs
.microsoft.com/en‑us/sql/sql‑server/install/configure‑the‑windows‑firewall‑to‑allow‑sql‑
server‑access?redirectedfrom=MSDN&view=sql‑server‑ver15.

Logon failed for user ‘NT_AUTHORITY\ANONYMOUS LOGON’. This error message means that the
services are logged on incorrectly as .\administrator.

Resolution: Restart the services as local system user and restart the SQL services.

Check the recording success rate

September 7, 2025

You can check the recording success rate to learnwhether all sessions thatmatch the active recording
policy are recorded. The recording success rate is calculated as follows:

Recording success rate = the number of successfully recorded sessions / the total number of sessions
matching the active recording policy

Prerequisites

• This feature requires the Session Recording server minimum version 2203.

• To obtain site configuration and session data for accurate calculation, you must install the Bro‑
ker PowerShell Snap‑in (Broker_PowerShellSnapIn_x64.msi). You can locate the snap‑in on the
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Citrix Virtual Apps and Desktops ISO (\x64\Citrix Desktop Delivery Controller) and follow the in‑
structions to install it.

• For an on‑premises Delivery Controller, install and use the Citrix Virtual Apps and Desktops™
PowerShell SDK. For a Delivery Controller in Citrix Cloud, install and use the Citrix DaaS Remote
PowerShell SDK. To determinewhich SDK to install and use, be aware of the Delivery Controller
that you specified when you configured your recording policy.

Steps

To check the recording success rate across your deployment, complete the following steps:

1. Use a domain user account with proper permission to log on to the machine where you have
installed the Session Recording server.

2. Start PowerShell and change the current drive to the <Session Recording server installation
path>\Bin folder.

3. Run a command based on the type of your deployment:

• For anon‑premisesDelivery Controller™, run either of the following commands as needed:

• If theFQDNof theSessionRecordingserver is the samewith theFQDN in thecertificate
bound to the Session Recording server, run SsRecUtils.exe ‑CalcRecSuccessRate
<Delivery Controller address>.

• If youhave specified a customdomain namewith the certificate binding, runSsRecU‑
tils.exe ‑CalcRecSuccessRate<DeliveryController address> ‑ SRBrokerURL<cus‑
tom domain name>.

• For a Delivery Controller in Citrix Cloud™, run the following commands in sequence:

• Add‑PSSnapin Citrix.Broker.Admin.V2

• Set‑XDCredentials ‑CustomerId “<Citrix Cloud customer ID>”‑SecureClientFile
“<path to secure client file>”‑ProfileType CloudApi ‑StoreAs default

• get‑xdauthentication

• SsRecUtils.exe ‑CalcRecSuccessRate CloudDDC

4. Check the recording success rate. If all sessions thatmatch the currently active recording policy
are recorded, the recording success rate is 100%. Otherwise, the recording success rate is lower
than 100% and you are prompted to check failed recordings in a file where session details are
provided. For example:
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100% recording success rate

50% recording success rate

Sessions are not recording

June 21, 2024

If application sessions are not recording successfully, check the application event log in the Event
Viewer on the Session Recording agent and Session Recording server. Doing so can provide valuable
diagnostic information.
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If sessions are not recording, the possible cause might be:

• Component connectivity and certificates. If the Session Recording components cannot com‑
municate with each other, session recording can fail. To troubleshoot recording issues, verify
that all components are configured correctly to point to the correct machines and that all cer‑
tificates are valid and correctly installed.

• Non‑domain‑joinedmachines. SessionRecording is designed to run in adomain environment.
If you are not running in an Active Directory or Azure Active Directory environment, you might
experience recording issues. Ensure that all Session Recording components are running onma‑
chines that are members of an Active Directory domain or Azure Active Directory domain.

• Session sharing conflictswith the active policy. Session Recordingmatches the active policy
with the first published application that a user opens. Subsequent applications opened during
the samesession continue to follow thepolicy that is in force for the first application. Toprevent
session sharing from conflicting with the active policy, publish the conflicting applications on
separate multi‑session OS VDAs.

• Recording isnotenabled. Bydefault, installing theSessionRecordingAgentonamulti‑session
OS VDA enables recording for the VDA. Recording does not occur until an active recording policy
is configured to allow it.

• The active recording policy does not permit recording. A session can be recorded onlywhen
the session meets the rules of the active recording policy.

• Session Recording services are not running. For sessions to be recorded, the Session Record‑
ing Agent servicemust be runningonamulti‑sessionOSVDAand theSessionRecordingStorage
Manager service must be running on the machine hosting the Session Recording Server.

• MSMQ is not configured. If MSMQ is not correctly configured on the server running the Session
Recording Agent and the machine hosting the Session Recording Server, recording problems
might occur.

Unable to view live session playback

September 7, 2025

If you experience difficulties when viewing recordings using the Session Recording player, the follow‑
ing error message might appear:

Download of recorded session file failed. Live session playback is not permitted. The server
has been configured to disallow this feature. This error indicates that the server is configured to
disallow the action.

Resolution: In Session Recording Server Properties, choose the Playback tab and select the Allow
live session playback check box.
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Recordings are corrupted or incomplete

September 7, 2025

• When you view corrupted or incomplete recordings in the player, you might also see warnings
in the Event logs on the Session Recording server.

Event Source: Citrix Session Recording Storage Manager

Description: Data lost while recording file <icl file name>

The issue occurs when MCS or PVS is used to create VDAs with a master image configured and
Microsoft Message Queuing (MSMQ) installed. In this condition, the VDAs have the same QMId
for MSMQ.

Asaworkaround, createauniqueQMId for eachVDA. Formore information, see Install, upgrade,
and uninstall.

• The Session Recording playermight report an internal error with themessage ‑ “The file being
playedhas reported that an internal systemerror (error code: 9) occurredduring its origi‑
nal recording. The file can still beplayedup to thepoint that the recordingerroroccurred”
when playing back a certain recording file.

The issue occurs due to insufficient buffer size on the Session Recording Agent when graphic
intensive sessions are recorded.

As a workaround, change HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor
\SmAudBufferSizeMB to higher valuedataon theSessionRecording agent, and then restart
the machine.

Verify component connections

September 7, 2025

During the setup of Session Recording, the components might not connect to other components. All
the components communicate with the Session Recording server (Broker). By default, the Broker (an
IIS component) is secured using the IIS default website certificate. If one component can’t connect to
the Session Recording server, the other components might also fail when attempting to connect.

The Session Recording agent and the Session Recording server (StorageManager and Broker) log con‑
nection errors in the applications event log. You can view the log in the Event Viewer of the machine
hosting the Session Recording server. The Session Recording policy console and the Session Record‑
ing player display connection error messages on screen when they fail to connect.
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Verify that the Session Recording agent is connected

1. Log on to the server where the Session Recording agent is installed.
2. From the Startmenu, choose Session Recording Agent Properties.
3. In Session Recording Agent Properties, click Connection.
4. Verify that the correct FQDN is entered in the Session Recording Server field.
5. Verify that the server given as the value for the Session Recording server is accessible to your

VDA for multi‑session OS.

For more information, see Agent cannot connect to the server.

Note:

Check the application event log for errors and warnings.

Verify that the Session Recording server is connected

Caution:

Using the Registry Editor can cause serious problems thatmight require you to reinstall the oper‑
ating system. Citrix® cannot guarantee that problems resulting from incorrect use of the Registry
Editor can be solved. Use the Registry Editor at your own risk.

1. Log on to the machine hosting the Session Recording server.
2. Open the Registry Editor.
3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
4. Verify that theSmAudDatabaseInstance value correctly references the SessionRecording data‑

base you installed on your SQL Server instance.

For more information, see Server cannot connect to the database.

Verify that the Session Recording database is connected

1. Using a SQL Management tool, open your SQL instance that contains the Session Recording
database you installed.

2. Open the Security permissions of the Session Recording database.
3. Verify that the Session Recording Computer Account has access to the database. For example,

if themachine hosting the Session Recording server is named SsRecSrv in the MIS domain, the
computer account in your databasemust be configured asMIS\SsRecSrv$. This value is config‑
ured during the Session Recording database installation.
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Test IIS connectivity

You can test connections to the Session Recording server IIS site by using a Web browser to access
the Session Recording Broker webpage. It can help you determine whether problems with commu‑
nication between Session Recording components stem from misconfigured protocol configuration,
certification issues, or problems starting Session Recording Broker.

To verify IIS connectivity for the Session Recording agent:

1. Log on to the server where the Session Recording Agent is installed.
2. Open a Web browser and type the following address:

• ForHTTPS:https://servername/SessionRecordingBroker/RecordPolicy
.rem?wsdl, where servername is the name of the machine hosting the Session
Recording server.

• For HTTP: http://servername/SessionRecordingBroker/RecordPolicy.
rem?wsdl, where servername is the name of themachine hosting the Session Record‑
ing server.

3. If you are prompted for NT LANManager (NTLM) authentication, log on with a domain adminis‑
trator account.

To verify IIS connectivity for the Session Recording player:

1. Log on to the workstation where the Session Recording player is installed.
2. Open a Web browser and type the following address:

• For HTTPS: https://servername/SessionRecordingBroker/Player.rem?
wsdl, where servername is the name of the machine hosting the Session Recording
server.

• For HTTP: http://servername/SessionRecordingBroker/Player.rem?
wsdl, where servername is the name of the machine hosting the Session Recording
server.

3. If you are prompted for NT LANManager (NTLM) authentication, log on with a domain adminis‑
trator account.

To verify IIS connectivity for the Session Recording policy console:

1. Log on to the server where the Session Recording policy console is installed.
2. Open a Web browser and type the following address:

• ForHTTPS:https://servername/SessionRecordingBroker/PolicyAdministration
.rem?wsdl, where servername is the name of the machine hosting the Session
Recording server.
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• ForHTTP:http://servername/SessionRecordingBroker/PolicyAdministration
.rem?wsdl, where servername is the name of the machine hosting the Session
Recording server.

3. If you are prompted for NT LANManager (NTLM) authentication, log on with a domain adminis‑
trator account.

If you see an XML document within your browser, it verifies that the Session Recording policy console
is connected to the Session Recording server using the configured protocol.

Troubleshoot certificate issues

If you are using HTTPS as your communication protocol, the machine hosting the Session Recording
servermust be configuredwith a server certificate. All component connections to the Session Record‑
ing server must have root certificate authority (CA). Otherwise, attempted connections between the
components fail.

You can test your certificates by accessing the Session Recording Broker webpage as youwould when
testing IIS connectivity. If you are able to access the XML page for each component, the certificates
are configured correctly.

Here are some common ways certificate issues cause connections to fail:

• Invalid or missing certificates. If the server running the Session Recording agent does not
have a root certificate to trust the server certificate and cannot trust and connect to the Session
Recording server over HTTPS, causing connectivity to fail, verify that all components trust the
server certificate on the Session Recording server.

• Inconsistent naming. If the server certificate assigned to the machine hosting the Session
Recordingserver is createdusinganFQDN,all connectingcomponentsmustuse theFQDNwhen
connecting to the Session Recording server. If a NetBIOS name is used, configure the compo‑
nents with a NetBIOS name for the Session Recording server.

• Expiredcertificates. If a server certificate expired, connectivity to theSessionRecording server
through HTTPS fails. Verify the server certificate assigned to the machine hosting the Session
Recording server is valid andhasnotexpired. If the samecertificate is used for thedigital signing
of session recordings, the event log of the Session Recording server provides error messages
that the certificate expired or warning messages when it is about to expire.

Search for recordings using the player fails

June 21, 2024
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If you experience difficulties when searching for recordings using the Session Recording player, the
following error messages might appear:

• Search for recorded session files failed. The remote server name could not be resolved:
servername. The servername is the name of the server towhich the Session Recording player
is attempting to connect. The Session Recording player cannot contact the Session Recording
server. Two possible reasons are an incorrectly typed server name or that the DNS cannot re‑
solve the server name.

Resolution: From the player menu bar, choose Tools > Options > Connections and verify that
the servername in theSessionRecordingServers list is correct. If it is correct, fromacommand
prompt, run the ping command to see if the name canbe resolved. When the SessionRecording
server is down or offline, the search for recorded session files failed error message isUnable to
contact the remote server.

• Unable to contact the remote server. This error occurs when the Session Recording server is
down or offline.

Resolution: Verify that the Session Recording server is connected.

• Access denied. An access denied error can occur if the user was not given permission to search
for and download recorded session files.

Resolution: Assign the user to the Player role using the Session Recording Authorization Con‑
sole.

• Access denied when the Player role is assigned. This error occurs when you install the Ses‑
sion Recording player on the same machine with the Session Recording server, and you have
enabled UAC. When you assign the Domain Admins or Administrators user group as the Player
role, a non‑built‑in administrator user in that groupmight fail to pass the role‑based check.

Resolutions:

• Run the Session Recording player as an administrator.

• Assign specific users as the Player role rather than the entire group.

• Install the Session Recording player in a separatemachine rather than the Session Record‑
ing server.

• Search for recorded session files failed. The underlying connectionwas closed. Could not
establish a trust relationship for the SSL/TLS secure channel. The error occurs when the
Session Recording server uses a certificate that is signed by a CA that the client device does not
trust or have a CA certificate for.

Resolution: Install the correct or trustedCA certificateworkstationwhere theSessionRecording
player is installed.
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• The remote server returned an error: (403) forbidden. This error is a standard HTTPS error
that occurs when you attempt to connect using HTTP (nonsecure protocol). The server rejects
the connection because, by default, it is configured to accept only secure connections.

Resolution: From the Session Recording Playermenu bar, choose Tools >Options > Connec‑
tions. Select the server from the SessionRecording Servers list, and clickModify. Change the
protocol fromHTTP toHTTPS.

Troubleshoot MSMQ

If anotificationmessage is givenbut theviewer cannot findany recordingsaftera search in theSession
Recording player, there is a problem with MSMQ. Verify that the queue is connected to the Session
Recording server (Storage Manager). Use aWeb browser to test for connection errors (if you are using
HTTP or HTTPS as your MSMQ communication protocol).

To verify that the queue is connected:

1. Log on to the server hosting the Session Recording Agent and view the outgoing queues.

2. Verify that the queue to the machine hosting the Session Recording server has a connected
state.

• If the state is waiting to connect, there are messages in the queue, and the protocol is
HTTP or HTTPS (corresponding to the protocol selected on the Connections tab in Ses‑
sion Recording Agent Properties), perform Step 3.

• If the state is connectedand therearenomessages in thequeue, theremightbeaproblem
with the server hosting the Session Recording server. Skip Step 3 and perform Step 4.

3. If there are messages in the queue, open a Web browser and type the following address:

• For HTTPS: https://servername/msmq/private$/CitrixSmAudData, where
servername is the name of the machine hosting the Session Recording server.

• For HTTP: http://servername/msmq/private$/CitrixSmAudData, where
servername is the name of the machine hosting the Session Recording server.

If the page returns an error such as The server only accepts secure connections, change the
MSMQ protocol listed in Session Recording Agent Properties to HTTPS. If the page reports a
problemwith thewebsite security certificate, theremight be aproblemwith a trust relationship
for the TLS secure channel. In that case, install the correct CA certificate or use a CA that is
trusted.

4. If there are no messages in the queue, log on to the machine hosting the Session Recording
server and view private queues. Select citrixsmauddata. If there are messages in the queue
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(Number of Messages Column), verify that the Session Recording StorageManager service is
started. If it is not, restart the service.

Session Recording Data Loss

December 26, 2025

Event Description

Session Recording –Event 2005 in Event Viewer

Administrators may notice Event 2005 from Citrix Session Recording Storage Manager in the Event
Viewer on the Session Recording server. The event message typically appears as:

“Data lost while recording file: VDA = XXX, CtxSessionId = YYY, path = ZZZ, NNN bytes missing.”

If the administrator attempts to play the recording file located at the path specified in the event, the
playback will indicate that the recording is incomplete.

Why did this occur?

There are several possible causes for this issue:

1. Two or more VDAs are configured with the same QMID for MSMQ, which can occur on both per‑
sistent and non‑persistent VDAs.

2. TheQMIDonnon‑persistent VDAs remainedunchangedafter reboot, which can lead to conflicts.
3. The SessionRecording Server is under heavy load and cannot efficiently process a large number

of concurrent sessions.

How to identify the issue?

1. Verify the QMID configuration on the VDAs.

a) For persistent VDAs

i. check the registry on eachmachine to verify the QMID configuration.
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSMQ\Parameters\
MachineCache\QMId

ii. Each VDA should have a unique QMID value to avoid conflicts.

b) For Non‑persistent VDAs
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i. Check the registry on the VDA to verify the QMID.
ii. After rebooting the same VDA, check the registry again.
iii. The QMID should be different after the reboot.

2. Verify whether the server is under heavy load.

a) Check the storage limits configured in the MSMQ properties on the Session Recording
Server.

b) Monitor MSMQ resource usage using Performance Monitor.

i. Add the MSMQ counters in the Performance Monitor to track resource usage.
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ii. Verify the current data usage within MSMQ.

iii. Check whether the MSMQ data size is approaching the configured quota limit. If it is,
the server may be overloaded.

How to solve it?

The following items outline how to resolve the issue.

1. All VDAs using the Session Recording Agent must be assigned distinct QMIDs for MSMQ.

a) For persistent VDAs, the QMID for MSMQ only needs to be set once.
b) For non‑persistent VDAs, the QMID for MSMQ needs to be set during Windows startup
c) How tomodify the QMID on a VDA
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i. Manually modify the QMID: Install, upgrade, and uninstall
ii. The latest Citrix Provisioning Services automatically update the QMID for MSMQ on

each VDA startup since CVAD 2511. Create machine catalogs
iii. Image optimization tools or custom‑defined scripts can be used to generate a new

QMID for MSMQ during Windows startup.

d) Additionally, for non‑persistent VDAs, set the startup type of both the Session Recording
Agent Service and the Citrix Session Recording Monitor Service to Automatic (De‑
layed Start) in the Windows Services configuration.

2. The Session Recording Server is overloaded.
The supported session capacity of the Session Recording Server can vary significantly depend‑
ing on the hardware configuration. By default, it can handle up to 2,000 concurrent sessions.
However, if the server is equipped with more than 16 GB of RAM and SSD storage, the capacity
can be higher.
To help resolve overload issues:

a) Increase the main memory quota on the machine, then raise the MSMQ storage limit.

Ensure that the total available main memory is at least 1.5 times the configured MSMQ
storage limit.

Note:

The total MSMQ storage limit should always remain less than the total physical mem‑
ory.

Aftermaking changes, MSMQon the SessionRecording Servermust be restarted. The
Session Recording Service will restart automatically as a result.

This process will not result in any loss of session data.

b) Adjust themessage lifetime in the Session Recording Agent properties. Consider doubling
the current value to allowmore time for message processing and reduce data loss risks.
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You can configure this setting via the following registry key on the VDA:

HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent\MsmqMessageLifeInSeconds

Set the value (in seconds) based on your environment’s needs.

Note:

After making changes, the Session Recording Agent must be restarted.

This action will result in loss of session data for any live session.

Please ensure that this operation is scheduled during a maintenance window.

c) Change theMessage folder to a different drivewith a disk(SSD) IOPS capacity ofmore than
3000 for MSMQ on all Session Recording Server machines.

This will help speed up processing and can improve performance by up to 50%.
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https://learn.microsoft.com/en‑us/previous‑versions/troubleshoot/msmq/optimize‑
message‑queuing‑performance

d) If the above steps do not resolve the issue, the recommended solution is to add an addi‑
tional Session Recording Server to distribute the load.

For guidance, refer to the official documentation on configuring load balancing in an ex‑
isting deployment:
Citrix Documentation –Configure Load Balancing

Configuring Always On Tracing (AOT) for Session Recording

January 6, 2026

TheAOTLogServer acts as a centralizeddestination for collecting and storingAlwaysOnTracing (AOT)
logs from various Citrix components. For more information, see Citrix Always on Tracing.

To integrate and utilize AOT within Session Recording, you must configure the Session Recording
Server. For more information, see Uploading the AOT logs from CVAD Core Components.
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Record Linux sessions (preview)

September 7, 2025

As an experimental feature starting with the Linux VDA 2212, you can record and replay sessions
hosted on a Linux VDA. For more information, see Session recording (preview) in the Linux VDA
documentation.

Note:

All thepolicies you set for recordingWindows sessionsdon’t apply to the Linux session recording.

https://docs.citrix.com/en-us/linux-virtual-delivery-agent/current-release/configure/session-recording.html
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